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Glossary
A

Administrator
A user with permissions to manage Check Point security products and the
network environment.

API
In computer programming, an application programming interface (API) is a set of
subroutine definitions, protocols, and tools for building application software. In
general terms, it is a set of clearly defined methods of communication between
various software components.

Appliance
A physical computer manufactured and distributed by Check Point.

B

Bond
A virtual interface that contains (enslaves) two or more physical interfaces for
redundancy and load sharing. The physical interfaces share one IP address and
one MAC address. See "Link Aggregation".

Bonding
See "Link Aggregation".

Bridge Mode
A Security Gateway or Virtual System that works as a Layer 2 bridge device for
easy deployment in an existing topology.
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C

CA
Certificate Authority. Issues certificates to gateways, users, or computers, to
identify itself to connecting entities with Distinguished Name, public key, and
sometimes IP address. After certificate validation, entities can send encrypted
data using the public keys in the certificates.

Cert ificate
An electronic document that uses a digital signature to bind a cryptographic
public key to a specific identity. The identity can be an individual, organization, or
software entity. The certificate is used to authenticate one identity to another.

Cluster
Two or more Security Gateways that work together in a redundant configuration -
High Availability, or Load Sharing.

Cluster Member
A Security Gateway that is part of a cluster.

CoreXL
A performance-enhancing technology for Security Gateways on multi-core
processing platforms. Multiple Check Point Firewall instances are running in
parallel on multiple CPU cores.

CoreXL Firewall Instance
Also CoreXL FW Instance. On a Security Gateway with CoreXL enabled, the Firewall
kernel is copied multiple times. Each replicated copy, or firewall instance, runs on
one processing CPU core. These firewall instances handle traffic at the same time,
and each firewall instance is a complete and independent firewall inspection
kernel.
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CoreXL SND
Secure Network Distributer. Part of CoreXL that is responsible for: Processing
incoming traffic from the network interfaces; Securely accelerating authorized
packets (if SecureXL is enabled); Distributing non-accelerated packets between
Firewall kernel instances (SND maintains global dispatching table, which maps
connections that were assigned to CoreXL Firewall instances). Traffic distribution
between CoreXL Firewall instances is statically based on Source IP addresses,
Destination IP addresses, and the IP 'Protocol' type. The CoreXL SND does not
really "touch" packets. The decision to stick to a particular FWK daemon is done at
the first packet of connection on a very high level, before anything else.
Depending on the SecureXL settings, and in most of the cases, the SecureXL can
be offloading decryption calculations. However, in some other cases, such as with
Route-Based VPN, it is done by FWK daemon.

CPUSE
Check Point Upgrade Service Engine for Gaia Operating System. With CPUSE, you
can automatically update Check Point products for the Gaia OS, and the Gaia OS
itself. For details, see sk92449.

D

DAIP Gateway
A Dynamically Assigned IP (DAIP) Security Gateway is a Security Gateway where
the IP address of the external interface is assigned dynamically by the ISP.

Data Type
A classification of data. The Firewall classifies incoming and outgoing traffic
according to Data Types, and enforces the Policy accordingly.

Database
The Check Point database includes all objects, including network objects, users,
services, servers, and protection profiles.

Distributed Deployment
The Check Point Security Gateway and Security Management Server products are
deployed on different computers.
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Domain
A network or a collection of networks related to an entity, such as a company,
business unit or geographical location.

Domain Log Server
A Log Server for a specified Domain. It stores and processes logs from Security
Gateways that are managed by the corresponding Domain Management Server.
Acronym: DLS.

Domain Management Server
A virtual Security Management Server that manages Security Gateways for one
Domain, as part of a Multi-Domain Security Management environment. Acronym:
DMS.

E

Expert Mode
The name of the full command line shell that gives full system root permissions in
the Check Point Gaia operating system.

External Network
Computers and networks that are outside of the protected network.

External Users
Users defined on external servers. External users are not defined in the Security
Management Server database or on an LDAP server. External user profiles tell the
system how to identify and authenticate externally defined users.

F

Firewall
The software and hardware that protects a computer network by analyzing the
incoming and outgoing network traffic (packets).
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G

Gaia
Check Point security operating system that combines the strengths of both
SecurePlatform and IPSO operating systems.

Gaia Clish
The name of the default command line shell in Check Point Gaia operating system.
This is a restrictive shell (role-based administration controls the number of
commands available in the shell).

Gaia Portal
Web interface for Check Point Gaia operating system.

H

Hotfix
A piece of software installed on top of the current software in order to fix some
wrong or undesired behavior.

I

ICA
Internal Certificate Authority. A component on Check Point Management Server
that issues certificates for authentication.

IKE
Internet Key Exchange. An Encryption key management protocol for IPSec that
creates a shared key to encrypt and decrypt IP packets and establishes a VPN
tunnel and Security Association.

Internal Network
Computers and resources protected by the Firewall and accessed by
authenticated users.
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IPv4
Internet Protocol Version 4 (see RFC 791). A 32-bit number - 4 sets of numbers,
each set can be from 0 - 255. For example, 192.168.2.1.

IPv6
Internet Protocol Version 6 (see RFC 2460 and RFC 3513). 128-bit number - 8 sets
of hexadecimal numbers, each set can be from 0 - ffff. For example,
FEDC:BA98:7654:3210:FEDC:BA98:7654:3210.

J

Jumbo Hotfix Accumulator
Collection of hotfixes combined into a single package. Acronyms: JHA, JHF.

L

Link Aggregat ion
Various methods of combining (aggregating) multiple network connections in
parallel to increase throughput beyond what a single connection could sustain,
and to provide redundancy in case one of the links should fail.

Log
A record of an action that is done by a Software Blade.

Log Server
A dedicated Check Point computer that runs Check Point software to store and
process logs in Security Management Server or Multi-Domain Security
Management environment.
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M

Management High Availability
Deployment and configuration mode of two Check Point Management Servers, in
which they automatically synchronize the management databases with each
other. In this mode, one Management Server is Active, and the other is Standby.
Acronyms: Management HA, MGMT HA.

Management Interface
Interface on Gaia computer, through which users connect to Portal or CLI.
Interface on a Gaia Security Gateway or Cluster member, through which
Management Server connects to the Security Gateway or Cluster member.

Management Server
A Check Point Security Management Server or a Multi-Domain Server.

Mult i-Domain Log Server
A computer that runs Check Point software to store and process logs in Multi-
Domain Security Management environment. The Multi-Domain Log Server
consists of Domain Log Servers that store and process logs from Security
Gateways that are managed by the corresponding Domain Management Servers.
Acronym: MDLS.

Mult i-Domain Security Management
A centralized management solution for large-scale, distributed environments with
many different Domain networks.

Mult i-Domain Server
A computer that runs Check Point software to host virtual Security Management
Servers called Domain Management Servers. Acronym: MDS.
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N

Network Object
Logical representation of every part of corporate topology (physical machine,
software component, IP Address range, service, and so on).

O

Open Server
A physical computer manufactured and distributed by a company, other than
Check Point.

P

Primary Mult i-Domain Server
The Multi-Domain Server in Management High Availability that you install as
Primary.

R

Remote Access VPN
An encryption tunnel between a Security Gateway and Remote Access clients.
Provides secure, seamless access to corporate networks remotely, over IPsec
VPN.

Remote Access VPN Community
A group of computers, appliances, and devices that access, with authentication
and encryption, the internal protected network from physically remote sites.

Rule
A set of traffic parameters and other conditions in a Rule Base that cause
specified actions to be taken for a communication session.
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Rule Base
Also Rulebase. All rules configured in a given Security Policy.

S

Secondary Mult i-Domain Server
The Multi-Domain Server in Management High Availability that you install as
Secondary.

SecureXL
Check Point product that accelerates IPv4 and IPv6 traffic. Installed on Security
Gateways for significant performance improvements.

Security Gateway
A computer that runs Check Point software to inspect traffic and enforces
Security Policies for connected network resources.

Security Management Server
A computer that runs Check Point software to manage the objects and policies in
Check Point environment.

Security Policy
A collection of rules that control network traffic and enforce organization
guidelines for data protection and access to resources with packet inspection.

SIC
Secure Internal Communication. The Check Point proprietary mechanism with
which Check Point computers that run Check Point software authenticate each
other over SSL, for secure communication. This authentication is based on the
certificates issued by the ICA on a Check Point Management Server.
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Single Sign-On
A property of access control of multiple related, yet independent, software
systems. With this property, a user logs in with a single ID and password to gain
access to a connected system or systems without using different usernames or
passwords, or in some configurations seamlessly sign on at each system. This is
typically accomplished using the Lightweight Directory Access Protocol (LDAP)
and stored LDAP databases on (directory) servers. Acronym: SSO.

Site to Site VPN
An encryption tunnel between two Security Gateways.

SmartConsole
A Check Point GUI application used to manage Security Policies, monitor products
and events, install updates, provision new devices and appliances, and manage a
multi-domain environment and each domain.

SmartDashboard
A legacy Check Point GUI client used to create and manage the security settings in
R77.30 and lower versions.

Software Blade
A software blade is a security solution based on specific business needs. Each
blade is independent, modular and centrally managed. To extend security,
additional blades can be quickly added.

SSO
See "Single Sign-On".

Standalone
A Check Point computer, on which both the Security Gateway and Security
Management Server products are installed and configured.
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T

Traffic
Flow of data between network devices.

U

Users
Personnel authorized to use network resources and applications.

V

VLAN
Virtual Local Area Network. Open servers or appliances connected to a virtual
network, which are not physically connected to the same network.

VLAN Trunk
A connection between two switches that contains multiple VLANs.

VPN
Virtual Private Network. A secure, encrypted connection between networks and
remote clients on a public infrastructure, to give authenticated remote users and
sites secured access to an organization's network and resources.

VPN Community
A named collection of VPN domains, each protected by a VPN gateway.

VPN Tunnel
An encrypted connection between two hosts using standard protocols (such as
L2TP) to encrypt traffic going in and decrypt it coming out, creating an
encapsulated network through which data can be safely shared as though on a
physical private line.
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VSX
Virtual System Extension. Check Point virtual networking solution, hosted on a
computer or cluster with virtual abstractions of Check Point Security Gateways
and other network devices. These Virtual Devices provide the same functionality
as their physical counterparts.

VSX Gateway
Physical server that hosts VSX virtual networks, including all Virtual Devices that
provide the functionality of physical network devices. It holds at least one Virtual
System, which is called VS0.
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Check Point VPN
IPsec VPN
The IPsec VPN solution lets the Security Gateway encrypt and decrypt traffic to and from other
gateways and clients. Use SmartConsole to easily configure VPN connections between Security
Gateways and remote devices.

For Site-to-Site Communities, you can configure Star and Mesh topologies for VPN networks, and
include third-party gateways.

The VPN tunnel guarantees:

n Authenticity - Uses standard authentication methods

n Privacy - All VPN data is encrypted

n Integrity - Uses industry-standard integrity assurance methods

IKE and IPsec

The Check Point VPN solution uses these secure VPN protocols to manage encryption keys, and
send encrypted packets. IKE (Internet Key Exchange) is a standard key management protocol that
is used to create the VPN tunnels. IPsec is protocol that supports secure IP communications that
are authenticated and encrypted on private or public networks.

VPN Components
VPN is composed of:

n VPN endpoints, such as Security Gateways, Security Gateway clusters, or remote clients
(such as laptop computers or mobile phones) that communicate over a VPN.

n VPN trust entities, such as a Check Point Internal Certificate Authority (ICA). The ICA is part
of the Check Point suite used for creating SIC trusted connection between Security
Gateways, authenticating administrators and third party servers. The ICA provides
certificates for internal Security Gateways and remote access clients which negotiate the
VPN link.

n VPN Management tools, such as Security Management Server and SmartConsole. The
SmartConsole lets organizations define and deploy Intranet, and remote Access VPNs.

Understanding the Terminology
n VPN - Virtual Private Network. A secure, encrypted connection between networks and

remote clients on a public infrastructure, to give authenticated remote users and sites
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secured access to an organization's network and resources.

n Virtual Tunnel Interface -Virtual Tunnel Interface. A virtual interface that is a member of
an existing, Route Based, VPN tunnel.

n VPN Peer - A gateway that connects to a different gateway using a Virtual Tunnel Interface.

n VPN Domain - A group of computers and networks connected to a VPN tunnel by one VPN
gateway that handles encryption and protects the VPN Domain members.

n VPN Community - A named collection of VPN domains, each protected by a VPN gateway.

n VPN Security Gateway - The gateway that manages encryption and decryption of traffic
between members of a VPN Domain, typically located at one (Remote Access VPN) or both
(Site to Site VPN) ends of a VPN tunnel.

n Site to Site VPN - An encrypted tunnel between two gateways, typically of different
geographical sites.

n Remote Access VPN - An encryption tunnel between a Security Gateway and remote
access clients, such as Endpoint Security VPN, and communities.

n Remote Access Community - A group of computers, appliances, and devices that access,
with authentication and encryption, the internal protected network from physically remote
sites.

n Star Topology - A "hub and spoke" virtual private network community, with gateways
defined as Satellites (spokes) that create tunnels only with the central gateway ("hub").

n Meshed topology - A VPN community with a VPN Domain that creates a tunnel to other VPN
Domains.

n Domain-based VPN - A method to route encrypted traffic with parameters defined by
Security Gateways.

n Route-Based VPN - A routing method for participants in a VPN community, defined by the
Virtual Tunnel Interfaces (VTI).

n IKE (Internet Key Exchange) - An Encryption key management protocol that enhances
IPSec by providing additional features, flexibility, and ease of configuration.

n IPSec - A set of secure VPN protocols that manage encryption keys and encrypted packet
traffic, to create a standard for authentication and encryption services.

Site-to-Site VPN
The basis of Site-to-Site VPN is the encrypted VPN tunnel. Two Security Gateways negotiate a link
and create a VPN tunnel and each tunnel can contain more than one VPN connection. One
Security Gateway can maintain more than one VPN tunnel at the same time.
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Sample Site-to-Site VPN Deployment

Item Description

A, B Security Gateways

2 VPN tunnel

3 Internal network in VPN domain

4 Host 4

5 Host 5

In this sample VPN deployment, Host 4 and Host 5 securely send data to each other. The Security
Gateways perform IKE negotiation and create a VPN tunnel. They use the IPsec protocol to encrypt
and decrypt data that is sent between Host 4 and Host 5.

VPN Workflow

Host 4 sends packet
to Host 5

Firewalls A & B create VPN
tunnel

Firewall A encrypts data

Host 5 receives
unencrypted data

Firewall B decrypts data
Encrypted data is sent through

VPN tunnel

VPN Communities

A VPN Domain is a collection of internal networks that use Security Gateways to send and receive
VPN traffic. Define the resources that are included in the VPN Domain for each Security Gateway.
Then join the Security Gateways into a VPN community - collection of VPN tunnels and their
attributes. Network resources of different VPN Domains can securely communicate with each
other through VPN tunnels that terminate at the Security Gateways in the VPN communities.

VPN communities are based on Star and Mesh topologies. In a Mesh community, there are VPN
tunnels between each pair of Security Gateway. In a Star community, each satellite Security
Gateway has a VPN tunnel to the central Security Gateway, but not to other Security Gateways in
the community.

Mesh Topology Star Topology
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Item Description

1 Security Gateway

2 Satellite Security Gateways

3 Central Security Gateway

Sample Combination VPN Community

Item Description

1 London Security Gateway

2 New York Security Gateway

3 London - New York Mesh community

4 London company partner (external network)

5 London Star community

6 New York company partner (external network)
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Item Description

7 New York Star community

This deployment is composed of a Mesh community for London and New York Security Gateways
that share internal networks. The Security Gateways for external networks of company partners
do not have access to the London and New York internal networks. However, the Star VPN
communities let the company partners access the internal networks of the sites that they work
with.

Routing VPN Traffic

Configure the Security Gateway to route VPN traffic based on VPN Domains or based on the
routing settings of the operating system.

Note - For each VPN gateway, you must configure an existing gateway as a default gateway.

Domain Based VPN

The VPN traffic is routed according to the VPN Domains that are defined in SmartConsole. Use
domain based routing to let satellite Security Gateways in a star-based topology send VPN traffic
to each other. The central Security Gateway creates a VPN tunnel to each satellite gateway and
the traffic is routed to the correct VPN domain.

Route Based VPN

VPN traffic is routed according to the routing settings (static or dynamic) of the Security Gateway
operating system. The Security Gateway uses a VTI (VPN Tunnel Interface) to send the VPN traffic
as if it were a physical interface. The VTIs of Security Gateways in a VPN community connect and
can support dynamic routing protocols.

Granular Routing Control

The Link Selection feature gives you granular control of the VPN traffic in the network. Use this
feature to enable the Security Gateway to:

n Find the best possible route for VPN traffic

n Select the interfaces that are used for VPN traffic to internal and external networks

n Configure the IP addresses that are used for VPN traffic

n Use route probing to select available VPN tunnels

n Use Load Sharing for Link Selection to equally distribute VPN traffic to VPN tunnels

IPv6 Support and Limitations
This release includes limited IPv6 support for IPsec VPN communities:
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n IPv6 is supported for Site to Site VPN only (Main IP to Main IP). The Main IP address for both
Security Gateways must be defined as an IPv6 Address. You can define other IP addresses
that are IPv4 or IPv6.

n IPv6 supports IKEv2 encryption only. IKEv2 is automatically always used for IPv6 traffic. The
encryption method configuration applies to IPv4 traffic only.

n VPN tunneling only supports IPv4 inside an IPv4 tunnel, and IPv6 inside an IPv6 tunnel. IPv4
traffic inside an IPv6 tunnel is not supported.

These VPN features are not supported for IPv6:

n Remote Access VPN

n CRL fetch for the internal Certificate Authority

n Multiple Entry Points (MEP)

n Route-based VPN (VTI)

n Wire Mode VPN

n Gateways with a dynamic IP address.

n Route Injection Mechanism (RIM)

n Traditional mode Firewall Policies

n IKE Denial of Service protection

n IKE Aggressive Mode

n Gateways with Dynamic IP addresses

n Traditional Mode VPN

n Migration from Traditional mode to Simplified mode

n Tunnel Management (permanent tunnels)

n Directional VPN Enforcement

n Link Selection

n GRE Tunnels

n Tunnel View in SmartView Monitor

n VPN Overview page

n $FWDIR/conf/vpn_route.conf configuration file
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Getting Started with Site-to-Site
VPN
Setting up Site-to-Site VPN between
Gateways
Scenario: Two Check Point gateways are managed by the same Security Management Server.
How do you create a site-to-site VPN between the two gateways so that they can communicate
securely?

Overview of the Workflow:

1. Create the gateway objects in SmartConsole and make sure that IPsec VPN is enabled on
each one.

2. Generate internal CA certificates for each gateway (done automatically).

3. Create the VPN Community.

4. Define the VPN Domain. See "Defining the VPN Domain for a Gateway" on page 34.

5. Make sure that the VPN will work with your configured routing, or change the routing or link
selection settings as necessary. See "Link Selection Overview" on page 62.

6. Create rules for the traffic. See "Configuring Site to Site VPN Rules in the Access Policy" on
page 38

7. Install the Access Control Policy.

Enabling IPsec VPN on a Gateway
Site to Site VPN requires two or more gateways with the IPsec VPN Software Blade enabled. Other
Software Blades can be enabled on the same gateway.

Make sure that Trusted Communication is established between all gateways and the Security
Management Server.

To enable the IPsec VPN Software Blade on a gateway

1. In SmartConsole, open a gateway object.

2. On the General Properties page, in the Network Security tab, select IPsec VPN.

3. Click OK.

An internal CA certificate for the gateway is created automatically.
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Creating a VPN Community
You can create a Meshed or Star VPN Community. The procedure below shows an example of a
Star Community.

To create a new VPN community

1. In SmartConsole > Security Policies tab, in the Access Tools area, click VPN
Communities.

2. Click the New icon and select Star Community.

A New Star Community window opens.

3. Enter a name for the VPN Community.

4. In the Center Gateways area, click the plus icon to add one or more gateways to be in
the center of the community.

5. In the Satellite Gateways area, click the plus icon to add one or more gateways to be
around the center gateway.

6. Click OK.

The Community uses the default encryption and VPN Routing settings.

7. Optional: Edit more settings for the VPN Community in the community object.

More VPN Community Settings

In addition to the gateway members, you can edit these settings for the VPN Community in the
community object:

n Encrypted Traffic - Select Accept all encrypted traffic to encrypt and decrypt all
traffic between the Security Gateways. If this is not selected, create rules in the Security
Policy Rule Base to allow encrypted traffic between community members

n Encryption - Select encryption settings that include the Encryption Method and
Encryption Suite. See "VPN Community Object - Encryption Settings" on page 58.

n Tunnel Management - Select settings VPN tunnels that include Permanent Tunnels
and Tunnel Sharing. See "Configuring Tunnel Features" on page 135.

n VPN Routing -For Star Communities, select how VPN traffic is routed between the center
and satellite gateways. By default this is always set to To center only. See "Configuring
VPN Routing in Domain Based VPN" on page 103.

n MEP (Multiple Entry Points) - For Star Communities, select how the entry gateway for
VPN traffic is chosen. This only applies when you have multiple center gateways in the
community. See "Overview of MEP" on page 158.

n Excluded Services - Add services that are not to be encrypted, for example Firewall
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control connections. VPN tunnels are not created for the Services included here.

n Shared Secret - Configure shared secret authentication to use for communication with
external gateways that are part of a VPN community. See "Configuring a VPN with External
Security Gateways Using Pre-Shared Secret" on page 45.

n Wire Mode - Select to define internal interfaces and communities as trusted and bypass
the firewall for some communication. See "Configuring Wire Mode" on page 151.

n Advanced - Configure advanced settings related to IKE, IPsec, and NAT. You can also
Reset All VPN Properties to revert all VPN Community settings to their default values.
See "Configuring Advanced IKE Properties" on page 58.

Defining the VPN Domain for a Gateway
The VPN Domain defines the networks and IP addresses that are included in the VPN community.
It is also called the Encryption Domain. When you create a Check Point gateway object, the VPN
Domain is automatically defined as all IP Addresses behind the gateway, based on the topology
information.

You can manually define the VPN domain to include one or more networks. You must have a
Network object or Network Group object that represents the domain.

To manually define the VPN Domain

1. In SmartConsole, open a gateway object.

2. Open the Network Management > VPN Domain page.

3. Select Manually defined and:

n Browse to the object list and select an object that represents the domain.

n Browse to the object list and click New > Group or Network to define a new
group of machines or network.

4. Click OK.

Encryption Domain per Community
By default a gateway's Encryption Domain is shared with all the communities it is a part of.

Access to different resources within the Encryption Domain is implemented using the Access
Control Rule Base.

In some cases you may need to configure the Encryption Domain in a granular way.

You can configure the VPN domain of a Security Gateway per community which makes it safer and
easier to control, the VPN communities are logically separated.
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Example 1:

n Security Gateway A (Partner A) is part of Community-1.

n Security Gateway B (Partner B) is part of Community-2.

n Security Gateway C (Corporate Branch) is part of both Communities 1 and 2.

n The network behind Security Gateway C - 10.2.2.0 is split into 2 networks using the
255.255.255.128 subnet mask.

In this scenario, the administrator limits the access from Security Gateway A in community 1 to
some of the resources behind Security Gateway C which is also part of community 1.

To allow access to the required resources from Gateway A to resources protected by Gateway
C, the administrator configures an Encryption Domain per the specific community so although
Gateway C is a part of another community (Community 2) which is configured differently.

The access is limited to the specific Encryption Domain: network 10.2.2.0/25.
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To configure Encryption Domain Per Community

1. Open the VPN community

2. Double click the center Gateway that participates in more than one VPN community
(Gateway C in this scenario) .

The VPN domain configuration window opens.

3. Select the User defined option.

Configure the Encryption Domain. In our example the encryption domain includes the
network we allow partner B to access.
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4. Install policy.

Example 2

Using the same setup, you can use the Encryption Domain per Community configuration to
allow access from host 1 to host 2 and vice versa.

The configuration changes are applied to the Encryption Domain of Gateway-C per each
relevant community, in this example Communities 1 and 2.

Note - In previous versions to get this functionality the vpn_route.conf file was used.

Configuration:

Community Encryption Domain Install On

Community-1 Network behind Gateway-C + Host-2 Gateway-C, Gateway-A

Community-2 Network behind Gateway-C + Host-1 Gateway-C, Gateway-B
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1. Create a new host (Host-2 behind Gateway-B) to represent the Encryption Domain of
Gateway-C to publish for Gateway-A.

2. Create a new host (Host-1 behind Gateway-A) to represent the Encryption Domain of
Gateway-C to publish for Gateway-B.

3. Create a new Network group to include the current Encryption Domain of Gateway-C and
the additional host (Host-2) for Community-1.

4. Create a new Network group to include the current Encryption Domain of Gateway-C and
the additional host (Host-1) for Community-2.

5. For Community-1 change the Encryption Domain for Gateway-C, use the new group
created in step 3.

6. For Community-2 change the Encryption Domain for Gateway-C, use the new group
created in step 4.

In practice this type of configuration "tricks" the satellite gateways to think that the destination
host is part of Gateway-C 's Encryption Domain and therefore encrypt the packets from the
satellite gateways towards the center gateway. When the encrypted packet gets to the center
gateway, it is decrypted and re-routed to its original destination thus it is encrypted again and
sent to the other satellite gateway.

Confirming VPN Routing
By default, IPsec VPN uses the main IPv4 Address, defined in the General Properties page of the
Gateway, for the VPN tunnel connection.

If you want to use this IP address for the VPN communication, and it is an external interface, you
do not need additional routing.

If the main IP address is an internal interface, or if you want VPN communication on a different
interface, make sure that:

n The Link Selection settings for the gateway are configured. Choose which gateway links are
used by VPN to route traffic correctly. See "Link Selection Overview" on page 62

n VPN Routing is configured to allow the connections. For information how to configure
routing in Gaia OS, see the R80.40 Gaia Administration Guide - Chapter Network Management.

Configuring Site to Site VPN Rules in the Access Policy
You must configure rules to allow traffic to and from VPN Communities. Configure rules in
SmartConsole > Security Policies > Access Control. All layers of the Access Control Policy can
contain VPN rules.

To make a rule apply to a VPN Community, the VPN column of the Rule Base must contain one of
these:

https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_Gaia_AdminGuide/Default.htm


Glossary

Site to Site VPN R80.40 Administration Guide      |      39

n Any - The rules applies to all VPN Communities and to non-VPN related traffic. If you
configure a new VPN Community after the rule was created, the rule also applies to the new
VPN Community.

n One or more specified VPN communities - For example, MyIntranet.Right-click in the
VPN column of a rule and select Specific VPN Communities. The rule applies to the
communities shown in the VPN column.

Examples:

n This rule allows encrypted traffic between domains of member gateways of "community_X."

Name Source Destination VPN
Services &
Applications

Allow traffic within
community

* Any *Any
MyCommunity

* Any

n This rule allows traffic from all VPN Communities to the internal network on all services.

Name Source Destination VPN Services & Applications

Allow all VPN * Any Internal_Network * Any * Any

n This rule allows traffic between two VPN domains with all services.

Name Source Destination VPN
Services &
Applications

Site to Site
VPN

Local_VPN_
Domain
Peer_VPN_
Domain

Local_VPN_
Domain
Peer_VPN_
Domain

Site2Site
* Any

Confirming that a VPN Tunnel Opens
Successfully
To make sure that a VPN tunnel has successfully opened

1. Edit the VPN rule and select Log as the Track option.

2. Click Logs & Monitor > New Tab.

3. From the bottom of the window, click Tunnel and User Monitoring.
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Check Point SmartView Monitor opens

4. Click the gateway to see IPsec VPN traffic and tunnels opened. A successful connection
shows encrypt, decrypt and key install logs.

Alternatively:

a. In SmartConsole click Logs & Monitor.

b. On the Logs tab, search for VPN to see the applicable logs.

Example:

5. Open SmartView Monitor and see that VPN tunnels are up.
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Basic Site to Site VPN
Configuration
Configuring a Meshed Community Between
Internally Managed Gateways
To configure an internally managed VPN meshed community

1. Install and configure the Security Gateways as described in the R80.40 Installation and
Upgrade Guide.

2. In SmartConsole, double click on the Security Gateway object.

3. In the General Properties page:

a. Enter the gateway Name.

b. Enter the IPv4 Address and IPv6 Address.

c. In the Network Security tab, Select IPsec VPN.

d. Click Communication and establish trusted communication with the Gateway.

4. In the Network Management page, click Get Interfaces.

a. After the interfaces show in the table, click Edit to open the Interface window.

b. In the Interface window, define the general properties of the interface and the
topology of the network behind it.

5. In the Network Management > VPN Domain page, define the VPN domain one of:

n All IP Addresses behind the Gateway based on Topology information

n Manually defined as an address range, a network, or a group that can be a
combination of address ranges, networks, and even other groups.

(There are instances where the VPN domain is a group which contains only the
Security Gateway itself, for example where the Security Gateway is acting as a
backup to a primary Security Gateway in an MEP environment.)

The network Security Gateway objects are now configured, and need to be added to a
VPN community.

Note - There is nothing to configure on the IPsec VPN page, regarding
certificates, because internally managed Security Gateways
automatically receive a certificate from the internal CA.

6. Open the Object Explorer, and select VPN Communities.

https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_Installation_and_Upgrade_Guide/Default.htm
https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_Installation_and_Upgrade_Guide/Default.htm
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a. Click New > VPN Communities > Meshed Community.

The New Meshed Community window opens.

b. In the Encrypted Traffic page, select Accept all encrypted traffic if you need all
traffic between the Security Gateways to be encrypted.

If not, then create applicable rules in the Security Policy Rule Base that allows
encrypted traffic between community members (step 7).

c. On the Gateways page, add the Security Gateways created in Step 1.

A VPN tunnel is now configured.

For information on other options, such as Encryption, Shared Secret, and Advanced, see
"IPsec and IKE" on page 48.

7. If you did not select Accept all encrypted traffic in the Encrypted Traffic page of the
Community, build an access control policy.

For example:

Source Destination VPN Service Action

* Any * Any Meshed VPN Community * Any Accept

Where "Meshed VPN Community" is the VPN community you just defined.

Configuring a Star Community Between
Internally Managed Gateways
A star VPN community is configured in much the same way as a meshed community, the
difference being the options on the Star Community window:

n On the VPN Routing page - Select To center only.

n On the Gateways page:

l Central Gateways - Add the central Security Gateways.

l Central Gateways - Select Mesh central Security Gateways if you want the central
Security Gateways to communicate.

l Satellite Gateways - Add the satellite Security Gateways.
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Configuring a VPN with External Security
Gateways Using Certificates
Configuring a VPN with external Security Gateways (those managed by a different Security
Management Server) is more involved than configuring a VPN with internal Security Gateways
(managed by the same Security Management Server). This is because:

n Configuration is performed separately in two distinct systems.

n All details must be agreed and coordinated between the administrators. Details such as the
IP address or the VPN domain topology cannot be detected automatically but have to be
supplied manually by the administrator of the peer VPN Security Gateways.

n The gateways are likely to use different Certificate Authorities (CAs). Even if the peer VPN
Security Gateways use the Internal CA (ICA), it is still a different CA.

There are various scenarios when dealing with externally managed Security Gateways. The
following description tries to address typical cases and assumes that the peers work with
certificates. If this is not the case, see the section "Configuring a VPN with External Security
Gateways Using Pre-Shared Secret".

Note - Configuring a VPN with PKI and certificates is more secure than with pre-shared secrets.

To configure VPN using certificates, with the external Security Gateways as satellites in a star
VPN Community:

1. Obtain the certificate of the CA that issued the certificate for the peer VPN Security
Gateways, from the peer administrator.

If the peer Security Gateway uses the ICA, then to obtain the CA certificate file, connect web
browser to this portal:

http://<IP address of peer Security Gateway or Management Server>:18264

2. In SmartConsole, define the CA object for the CA that issued the certificate for the peer. See
"Enrolling with a Certificate Authority" on page 90

3. Define the CA that will issue certificates for your side if the Certificate issued by ICA is not
applicable for the required VPN tunnel.

You may have to export the CA certificate and supply it on the peer administrator.

4. Define the Network Object(s) of the Security Gateway(s) that are internally managed. In
particular, be sure to do the following:

n In the General Properties page of the Security Gateway object, select IPsec VPN.

n In the Network Management page, define the Topology.
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n In the VPN Domain page, define the VPN Domain.

If it does not contain all the IP addresses behind the Security Gateway, define the VPN
domain manually by defining a group or network of machines and setting them as the
VPN Domain.

5. If the ICA certificate is not applicable for this VPN tunnel, then in the IPsec VPN page,
generate a certificate from the applicable CA.

6. Define the Network Object(s) of the externally managed Security Gateway(s).

n If it is not a Check Point Security Gateway, define an Interoperable Device:

In Object Explorer, click New > Network Object > More > Interoperable Device.

n If it is a Check Point Security Gateway, define an Externally Managed VPN Gateway:

In Object Explorer, click New > Network Object > Gateways and Servers > More >
Externally Managed VPN Gateway.

7. Set the various attributes of the peer Security Gateway.

In particular, be sure to do the following:

n For an Externally Managed Check Point Security Gateway:

In the General Properties page of the Security Gateway object, select IPsec VPN.

n Define the Topology.

n Define the VPN Domain with the VPN Domain information obtained from the peer
administrator. If the VPN Domain does not contain all the IP addresses behind the
Security Gateway, define the VPN domain manually by defining a group or network of
machines and setting them as the VPN Domain.

n For an Externally Managed Check Point Security Gateway:

In the IPsec VPN page, define the Matching Criteria. Specify that the peer must
present a certificate signed by its own CA. If feasible, enforce details that appear in
the certificate as well.

8. Define the Community.

These details assume that a Star Community is used, but you can also use a Meshed
Community. If you are working with a Meshed community, ignore the difference between
the Central Security Gateways and the Satellite Security Gateways.

n Agree with the peer administrator about the various IKE properties and set them in
the Encryption page and the Advanced page of the community object.
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n Define the Central Security Gateways. These are usually the internally managed ones.
If no other Community is defined for them, decide whether or not to mesh the central
Security Gateways. If they are already in a Community, do not mesh the central
Security Gateways.

n Define the Satellite Security Gateways. These are usually the external ones.

9. Click OK

10. Publish the SmartConsole session.

11. Define the applicable Access Control rules.

12. Add the Community in the VPN column, the services in the Service & Applications column,
the Action, and the applicable Track option.

13. Install the Access Control Policy.

Configuring a VPN with External Security
Gateways Using Pre-Shared Secret
Configuring VPN with external Security Gateways (those managed by a different Security
Management Server is more involved than configuring VPN with internal Security Gateways
(managed by the same Security Management Server) because:

n Configuration is done separately in two distinct systems.

n All details must be agreed and coordinated between the administrators. Details such as the
IP address or the VPN domain topology cannot be detected automatically but have to be
supplied manually by the administrator of the peer VPN Security Gateways.

There are various scenarios when dealing with externally managed Security Gateways. The
following description tries to address typical cases but assumes that the peers work with pre-
shared secrets. If this is not the case, see the section "Configuring a VPN with External
Security Gateways Using Certificates".

Note - Configuring a VPN with PKI and certificates is considered more secure
than with pre-shared secrets.
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Firewall Control Connections in VPN
Communities
Check Point Nodes communicate with other Check Point Nodes by means of control connections.
For example, a control connection is used when the Security Policy is installed from the Security
Management Server to a Security Gateway. Also, logs are sent from Security Gateways to the
Security Management Server across control connections. Control connections use Secure Internal
Communication (SIC).

Implied Rules in the Access Control Rule Base allow the Control connections. The management
Server adds and removed the Implied Rules in the Access Control Rule Base when you select or
clearing options in the Firewall page of the SmartConsole Global Properties.

Some administrators prefer not to rely on implied rules, and instead prefer to define explicit rules
in the Access Control Rule Base. Check Point does not support replacing implied rules with
explicit rules. See sk43401.

Why Turning off Firewall Implied Rules Blocks Control
Connections
If you turn off implicit rules, you may not be able to install an Access Control Policy on a remote
Security Gateway. Even if you define explicit rules in place of the implied rules, you may still not
be able to install the policy:

The administrator wishes to configure a VPN between Security Gateways A and B by configuring
SmartConsole. To do this, the administrator must install a Policy from the Security Management
Server to the Security Gateways.

1. The Security Management Server successfully installs the Policy on Security Gateway A. As
far as gateway A is concerned, Security Gateways A and B now belong to the same VPN
Community. However, B does not yet have this Policy.

2. The Security Management Server tries to open a connection to Security Gateway B in order
to install the Policy.

3. Security Gateway A allows the connection because of the explicit rules allowing the control

http://supportcontent.checkpoint.com/solutions?id=sk43401
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connections, and starts IKE negotiation with Security Gateway B to build a VPN tunnel for
the control connection.

4. Security Gateway B does not know how to negotiate with A because it does not yet have the
Policy. Therefore Policy installation on Security Gateway B fails.

The solution for this is to make sure that control connections do not have to pass through a VPN
tunnel.

Allowing Firewall Control Connections Inside a VPN
If you turn off implied rules, you must make sure that control connections are not changed by the
Security Gateways. To do this, add the services that are used for control connections to the
Excluded Services page of the Community object. See sk42815 for details.

Note - Although control connections between the Security Management Server and the Security
Gateway are not encrypted by the community, they are nevertheless encrypted and authenticated
with Secure Internal Communication (SIC).

Discovering Which Services are Used for Control
Connections

1. In SmartConsole, click Menu > Global properties.

2. On the Firewall page, make sure to select Control Connections.

3. Click OK.

4. In SmartConsole, from the left navigation panel, click Security Policies.

5. Select the applicable Access Control Policy.

6. From the toolbar above the policy, select Actions > Implied Rules.

The Implied Policy window opens.

7. Examine the Access Control Rule Base to see what Implied Rules are visible. Note the
services used in the Implied Rules.

Simplified and Traditional Modes
By default, VPN configuration works with Simplified mode. Simplified mode uses VPN
Communities for Site to Site VPN configuration, as described throughout this guide.

Traditional mode is a different, legacy way to configure Site to Site VPN where one of the actions
available in the Security Policy Rule Base is Encrypt. When encrypt is selected, all traffic between
the Security Gateways is encrypted. For details about Traditional Mode, see the R77 versions VPN
Administration Guide.

In a policy package, all layers must use the same VPN mode.

http://supportcontent.checkpoint.com/solutions?id=sk42815
https://sc1.checkpoint.com/documents/R77/CP_R77_VPN_AdminGuide/html_frameset.htm
https://sc1.checkpoint.com/documents/R77/CP_R77_VPN_AdminGuide/html_frameset.htm
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IPsec and IKE
Overview
In symmetric cryptographic systems, both communicating parties use the same key for encryption
and decryption. The material used to build these keys must be exchanged in a secure fashion.
Information can be securely exchanged only if the key belongs exclusively to the communicating
parties.

The goal of the Internet Key Exchange (IKE) is for both sides to independently produce the same
symmetrical key. This key then encrypts and decrypts the regular IP packets used in the bulk
transfer of data between VPN peers. IKE builds the VPN tunnel by authenticating both sides and
reaching an agreement on methods of encryption and integrity. The outcome of an IKE
negotiation is a Security Association (SA).

This agreement upon keys and methods of encryption must also be performed securely. For this
reason, IKE is composed of two phases. The first phase lays the foundations for the second. Both
IKEv1 and IKEv2 are supported in Security Gateways of version R71 and higher.

Diffie-Hellman (DH) is that part of the IKE protocol used for exchanging the material from which
the symmetrical keys are built. The Diffie-Hellman algorithm builds an encryption key known as a
"shared secret" from the private key of one party and the public key of the other. Since the IPsec
symmetrical keys are derived from this DH key shared between the peers, at no point are
symmetric keys actually exchanged.

IKE Phase I
During IKE Phase I:

n The peers authenticate, either by certificates or via a pre-shared secret. (More
authentication methods are available when one of the peers is a remote access client.)

n A Diffie-Hellman key is created. The nature of the Diffie-Hellman protocol means that both
sides can independently create the shared secret, a key which is known only to the peers.

n Key material (random bits and other mathematical data) as well as an agreement on
methods for IKE phase II are exchanged between the peers.

In terms of performance, the generation of the Diffie-Hellman Key is slow and heavy. The outcome
of this phase is the IKE SA, an agreement on keys and methods for IKE phase II. Figure below
illustrates the process that takes place during IKE phase I.

Note - The exact negotiation stages differ between IKEv1 and IKEv2.
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IKE Phase II (Quick mode or IPSec Phase)
IKE phase II is encrypted according to the keys and methods agreed upon in IKE phase I. The key
material exchanged during IKE phase II is used for building the IPsec keys. The outcome of phase
II is the IPsec Security Association. The IPsec SA is an agreement on keys and methods for IPsec,
thus IPsec takes place according to the keys and methods agreed upon in IKE phase II.

After the IPsec keys are created, bulk data transfer takes place:

IKEv1 and IKEv2
IKEv2 is supported inside VPN communities working in Simplified mode.

IKEv2 is configured in the VPN Community Properties window > Encryption. The default
setting is IKEv1 only. IKEv2 is automatically always used for IPv6 traffic. The encryption method
configuration applies to IPv4 traffic only.

To configure IKE settings for Remote Access VPN users in SmartConsole, click Menu > Global
properties > Remote Access > VPN - Authentication and Encryption.

Notes:

n IKEv2 is not supported for Remote Access.

n IKEv2 is not supported on UTM-1 Edge devices, or VSX objects lower than R75.40VS. If UTM-1
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Edge devices or such VSX objects are included in a VPN Community, the Encryption setting
should be Support IKEv1.

Methods of Encryption and Integrity
Two parameters are decided during the negotiation:

n Encryption algorithm

n Hash algorithm

Parameter IKE Phase 1 (IKE SA) IKE PHASE 2 (IPSec SA)

Encryption l AES-128
l AES-256

(default)
l 3DES
l DES
l CAST (IKEv1

only)

l AES-128 (default)
l AES-256
l 3DES
l DES
l DES-40CP (IKEv1

only)
l CAST (IKEv1 only)
l CAST-40 (IKEv1

only)
l NULL
l AES-GCM-128
l AES-GCM-256

Integrity l MD5
l SHA1 (default)
l SHA -256
l AES-XCBC
l SHA -384

l MD5
l SHA1 (default)
l SHA -256
l AES-XCBC
l SHA -384

NULL means perform an integrity check only; packets are not encrypted.

Diffie Hellman Groups

The Diffie-Hellman key computation (also known as exponential key agreement) is based on the
Diffie Hellman (DH) mathematical groups. A Security Gateway supports these DH groups during
the two phases of IKE.
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Parameter IKE Phase 1 (IKE SA) IKE Phase 2 (IPSec SA)

Diffie Hellman Groups n Group2 (1024 bits)
(default)

n Group1 (768 bits)
n Group5 (1536 bits)
n Group14 (2048 bits)
n Group19 (256-bit

ECP)
n Group20 (384-bit

ECP)

n Group2 (1024 bits)
(default)

n Group1 (768 bits)
n Group5 (1536 bits)
n Group14 (2048 bits)
n Group19 (256-bit

ECP)
n Group20 (384-bit

ECP)

A group with more bits ensures a key that is harder to break, but carries a heavy cost in terms of
performance, since the computation requires more CPU cycles.

Phase I modes
Between Security Gateways, there are two modes for IKE phase I. These modes only apply to
IKEv1:

n Main Mode

n Aggressive Mode

If aggressive mode is not selected, the Security Gateway defaults to main mode, performing the
IKE negotiation with six packets; aggressive mode performs the IKE negotiation with three
packets.

Main Mode is preferred because:

n Main mode is partially encrypted, from the point at which the shared DH key is known to
both peers.

n Main mode is less susceptible to Denial of Service (DoS) attacks. In main mode, the DH
computation is performed after authentication. In aggressive mode, the DH computation is
performed parallel to authentication. A peer that is not yet authenticated can force
processor intensive Diffie-Hellman computations on the other peer.

n Note - Use aggressive mode when a Check Point Security Gateway needs to negotiate with
third party VPN solutions that do not support main mode.

When dealing with remote access, IKE has additional modes:

n Hybrid Mode that provides an alternative to IKE phase I, where the Security Gateway is
allowed to authenticate with certificates and the client via some other means, such as
SecurID. For more information on Hybrid mode, see the R80.40 Remote Access VPN
Administration Guide.

n Office Mode that is an extension to the IKE protocol. Office Mode is used to resolve routing

https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_RemoteAccessVPN_AdminGuide/Default.htm
https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_RemoteAccessVPN_AdminGuide/Default.htm
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issues between remote access clients and the VPN domain. During the IKE negotiation, a
special mode called config mode is inserted between phases I and II. During config mode,
the remote access client requests an IP address from the Security Gateway. After the
Security Gateway assigns the IP address, the client creates a virtual adapter in the
Operating System. The virtual adapter uses the assigned IP address. For more information,
see the R80.40 Remote Access VPN Administration Guide.

Renegotiating IKE & IPsec Lifetimes
IKE phase I is more processor intensive than IKE phase II, because the Diffie-Hellman keys have to
be produced, and the peers authenticated, each time. For this reason, IKE phase I is performed
less frequently. However, the IKE SA is only valid for a certain period, after which the IKE SA must
be renegotiated. The IPsec SA is valid for an even shorter period, meaning many IKE phase II
negotiations take place.

The period between each renegotiation is known as the lifetime. Generally, the shorter the
lifetime, the more secure the IPsec tunnel (at the cost of more processor intensive IKE
negotiations). With longer lifetimes, future VPN connections can be set up more quickly. By
default, IKE phase I occurs once a day; IKE phase II occurs every hour but the time-out for each
phase is configurable.

Configure the frequency of IKE and IPsec Security Associations in SmartConsole > Objects menu >
Object Explorer > VPN Communities > VPN Community object > Advanced.

Perfect Forward Secrecy
The keys created by peers during IKE phase II and used for IPsec are based on a sequence of
random binary digits exchanged between peers, and on the DH key computed during IKE phase I.

The DH key is computed once, then used a number of times during IKE phase II. Since the keys
used during IKE phase II are based on the DH key computed during IKE phase I, there exists a
mathematical relationship between them. For this reason, the use of a single DH key may weaken
the strength of subsequent keys. If one key is compromised, subsequent keys can be
compromised with less effort.

In cryptography, Perfect Forward Secrecy (PFS) refers to the condition in which the compromise
of a current session key or long-term private key does not cause the compromise of earlier or
subsequent keys. Security Gateways meet this requirement with a PFS mode. When PFS is
enabled, a fresh DH key is generated during IKE phase II, and renewed for each key exchange.

However, because a new DH key is generated during each IKE phase I, no dependency exists
between these keys and those produced in subsequent IKE Phase I negotiations. Enable PFS in IKE
phase II only in situations where extreme security is required.

The supported DH groups for PFS are: 1, 2, 5, 14, 19, and 20. The default is group 2 (1042 bits).

Configure this in VPN Community Properties > Encryption > IKE Security Association (Phase
2) > Use Perfect Forward Secrecy.

https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_RemoteAccessVPN_AdminGuide/Default.htm
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Note - PFS mode is supported only between gateways, not between Security Gateways and
remote access clients.

IP Compression
IP compression is a process that reduces the size of the data portion of the TCP/IP packet. Such a
reduction can cause significant improvement in performance. IPsec supports the Flate/Deflate IP
compression algorithm. Deflate is a smart algorithm that adapts the way it compresses data to
the actual data itself. Whether to use IP compression is decided during IKE phase II. IP
compression is not enabled by default.

IP compression is important for Remote Access client users with slow links.

Security Gateway encryption makes TCP/IP packets appear "mixed up". This kind of data cannot
be compressed and bandwidth is lost as a result. If IP compression is enabled, packets are
compressed before encryption. This has the effect of recovering the lost bandwidth.

Subnets and Security Associations
By default, a VPN tunnel is created for the complete subnets that host computers reside on, and
not just for the host computers involved in the communication.

Unique SA Per Pair of Peers

If you disable the Support Key exchange for subnets option on each Security Gateway, you can
create a unique Security Association for a pair of peers.

If the Security Gateway is configured to Support key exchange for subnets, but the option is
unsupported on the remote peer, when Host A communicates with Host C, a Security Association
(SA 1) will be negotiated between Host A's subnet and Host C's IP address. The same SA is then
used between any host on the 10.10.11.x subnet and Host C.

When Host A communicates with Host B, a separate Security Association (SA 2) is negotiated
between Host A's subnet and Host B. As before, the same SA is then used between any host in
10.10.11.x subnet and Host B.
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When Support Key exchange for subnets is not enabled on communicating Security Gateways,
then a security association is negotiated between individual IP addresses; in effect, a unique SA
per host.

IKE DoS Protection

Understanding DoS Attacks
Denial of Service (DoS) attacks are intended to reduce performance, block legitimate users from
using a service, or even bring down a service. They are not direct security threats in the sense
that no confidential data is exposed, and no user gains unauthorized privileges. However, they
consume computer resources such as memory or CPU.

Generally, there are two kinds of DoS attack. One kind consists of sending malformed (garbage)
packets in the hope of exploiting a bug and causing the service to fail. In the other kind of DoS
attack, an attacker attempts to exploit a vulnerability of the service or protocol by sending well-
formed packets. IKE DoS attack protection deals with the second kind of attack.

IKE DoS Attacks
The IKE protocol requires that the receiving Security Gateway allocates memory for the first IKE
Phase 1 request packet that it receives. The Security Gateway replies, and receives another
packet, which it then processes using the information gathered from the first packet.

An attacker can send many IKE first packets, while forging a different source IP address for each.
The receiving Security Gateway is obliged to reply to each, and assign memory for each. This can
consume all CPU resources, thereby preventing connections from legitimate users.

The attacker sending IKE packets can pretend to be a machine that is allowed to initiate IKE
negotiations, such as a Check Point Security Gateway. This is known as an identified source. The
attacker can also pretend to have an IP address that the receiving Security Gateway does not
know about, such as a Remote Access client, or a Check Point Security Gateway with a dynamic IP
address. This is known as an unidentified source.
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Defense Against IKE DoS Attacks
When the number of simultaneous IKE negotiations handled exceeds the accepted threshold, it
concludes that it is either under load or experiencing a Denial of Service attack. In such a case,
the Security Gateway can filter out peers that are the probable source of a potential Denial of
Service attack. The following sections describe different types of defenses against IKE DoS attacks.

IKE DoS protection is not supported for IPv6 addresses.

SmartConsole IKE DoS Attack Protection Settings
To protect against IKE DoS attacks:

1. In SmartConsole, click Menu > Global properties > VPN > Advanced.

2. In the IKE Denial of Service protection section, configure these settings:

n Support IKE DoS protection from identified source - The default setting for
identified sources is Stateless. If the Security Gateway is under load, this setting
requires the peer to respond to an IKE notification in a way that proves that the IP
address of the peer is not spoofed. If the peer cannot prove this, the Security Gateway
does not begin the IKE negotiation.

If the source is identified, protecting using Puzzles is over cautious, and may affect
performance. A third possible setting is None, which means no DoS protection.

n Support IKE DoS protection from unidentified source - The default setting for
unidentified sources is Puzzles. If the Security Gateway is under load, this setting
requires the peer to solve a mathematical puzzle. Solving this puzzle consumes peer
CPU resources in a way that makes it difficult to initiate multiple IKE negotiations
simultaneously.

For unidentified sources, Stateless protection may not be sufficient because an
attacker may well control all the IP addresses from which the IKE requests appear to
be sent. A third possible setting is None, which means no DoS protection.

3. Click OK.

4. Install the Access Control Policy.

Note - IKE DoS protection is not supported for IPv6 addresses.

Advanced IKE DoS Attack Protection Settings
You can configure the advanced IKE DoS attack protection on the Management Server with the
GuiDBedit Tool (see sk13009).

Note - IKE DoS protection is not supported for IPv6.

http://supportcontent.checkpoint.com/solutions?id=sk13009
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Parameter Description
Accepted
Values

Default
Value

ike_dos_
threshold

Determines the percentage of maximum
concurrent ongoing negotiations, above which
the Security Gateway will request DoS
protection.
If the threshold is set to 0, the Security
Gateway always requests DoS protection.

0 - 100 70

ike_dos_
puzzle_level_
identified_
initiator

Determines the level of the puzzles sent to
known peer Security Gateways.
This parameter also determines the maximum
puzzle level a Security Gateway is willing to
solve.

0 - 32 19

ike_dos_
puzzle_level_
unidentified_
initiator

Determines the level of the puzzles sent to
unknown peers (such as Remote Access clients
and DAIP Security Gateways).
This parameter also determines the maximum
puzzle level that DAIP Security Gateways and
Remote Access clients are willing to solve.

0 - 32 19

ike_dos_max_
puzzle_time_
gw

Determines the maximum time in milliseconds
a Security Gateway is willing to spend solving
a DoS protection puzzle.

0 - 30000 500

ike_dos_max_
puzzle_time_
daip

Determines the maximum time in milliseconds
a DAIP Security Gateway is willing to spend
solving a DoS protection puzzle.

0 - 30000 500

ike_dos_max_
puzzle_time_
sr

Determines the maximum time in milliseconds
a client is willing to spend solving a DoS
protection puzzle.

0 - 30000 5000
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Parameter Description
Accepted
Values

Default
Value

ike_dos_
supported_
protection_sr

When downloaded to a client, it controls the
level of protection the client is willing to
support.
Security Gateways use the ike_dos_
protection_unidentified_initiator
parameter (equivalent to the Global Property
Support IKE DoS Protection from
unidentified Source) to decide what
protection to require from remote clients, but /
SecureClient clients use the ike_dos_

protection.
This same client property is called ike_dos_

supported_protection_sr on the Security
Gateway.

None,
Stateless,
Puzzles

Puzzles

Protection After Successful Authentication

You can configure fields in GuiDBedit Tool (see sk13009) or dbedit (see skI3301) to protect
against IKE DoS attacks from peers who may authenticate successfully and then attack a Security
Gateway. These settings are configured in the Global Properties table and not per Security
Gateway. By default these protections are off. Once you enter a value, they will be activated.

To limit the amount of IKE Security Associations (SAs) that a user can open, configure the following
fields:

Type of VPN Field Recommended Value

Site to site number_of_ISAKMP_SAs_kept_per_peer 5

Remote user number_of_ISAKMP_SAs_kept_per_user 5

To limit the amount of tunnels that a user can open per IKE, configure the following fields:

Type of VPN Field Recommended Value

Site to site number_of_ipsec_SAs_per_IKE_SA 30

Remote user number_of_ipsec_SAs_per_user_IKE_SA 5

http://supportcontent.checkpoint.com/solutions?id=sk13009
http://supportcontent.checkpoint.com/solutions?id=skI3301
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Client Properties

Some Security Gateway properties change name when they are downloaded to Remote Access
VPN Clients.

The modified name appears in the userc.C file, as follows:

Property Name on Gateway
Property name on Client in
user.C file

ike_dos_protection_unidentified_initiator

(Equivalent to the Global Property Support IKE DoS Protection
from unidentified Source)

ike_dos_protection

or
ike_support_dos_
protection

ike_dos_supported_protection_sr ike_dos_protection

ike_dos_puzzle_level_unidentified_initiator ike_dos_acceptable_
puzzle_level

ike_dos_max_puzzle_time_sr ike_dos_max_puzzle_
time

Configuring Advanced IKE Properties
IKE is configured in two places:

n On the VPN community network object (for IKE properties).

n On the Security Gateway network object (for subnet key exchange).

VPN Community Object - Encryption Settings
IPv6 automatically works with IKEv2 encryption only. The option that you select here, applies to
IPv4 traffic.

To configure a VPN Community object

1. In SmartConsole, click Objects menu >Object Explorer (or press Ctrl+E).

2. From the left navigation tree, click VPN Communities.

3. Double-click the VPN Community object.

The Community object window opens and shows the Gateways page.

4. From the navigation tree, click Encryption.

5. Configure the settings.
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6. Click OK.

7. Install the Access Control Policy.

Encryption Method

n Encryption Method - For IKE phase I and II.

l IKEv2 only - Only support encryption with IKEv2. Security Gateways in this community
cannot access peer gateways that support IKEv1 only.

l Prefer IKEv2, support IKEv1 - If a peer supports IKEv2, the Security Gateway will use
IKEv2. If not, it will use IKEv1 encryption. This is recommended if you have a
community of older and new Check Point Security Gateways.

l IKEv1 only - IKEv2 is not supported.

Encryption Suite

n Use this encryption suite - Select the methods negotiated in IKE phase 2 and used in
IPSec connections. Select and choose the option for best interoperability with other vendors
in your environment.

l VPN-A or VPN B - See RFC 4308 for more information.

l Suite-B GCM-128 or 256 - See RFC 6379 for more information.

n Custom encryption suite -If you require algorithms other than those specified in the other
options, select the properties for IKE Phase 1, including which Diffie-Hellman group to use.
Also, select properties for IKE Phase 2.

Note - Suite-B GCM-128 and 256 encryption suites are supported on R71.50 gateways and
from R75.40 gateways.

If there is a Security Gateway with Dynamically Assigned IP address inside the VPN community,
then R77.30 (or lower) community member gateways that respond to its IKE negotiation, use the
configuration defined in SmartConsole > Menu > Global properties > Remote Access > VPN -
Authentication and Encryption.

More

n Use aggressive mode (Main mode is the default) - Select only if the peer only supports
aggressive mode. This is only supported with IKEv1.

n Use Perfect Forward Secrecy, and the Diffie-Hellman group - Select if you need
extremely high security.

n Support IP compression - Select to decrease bandwidth consumption and for
interoperability with third party peers configured to use IP Compression.
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VPN Community Object - Advanced Settings
Configure these options in the VPN Community object Advanced page:

IKE (Phase 1)

When to renegotiate the IKE Security Associations.

IKE (Phase 2)

When to renegotiate the IPsec security associations. This sets the expiration time of the IPsec
encryption keys.

NAT

Disable NAT inside the VPN community - Select to not apply NAT for the traffic while it passes
through IPsec tunnels in the community.

Reset

Reset all VPN properties to the default.

On the Gateway Network Object

1. On the IPsec VPN > VPN Advanced page, select one of the options in the VPN Tunnel
Sharing section. There are several settings that control the number of VPN tunnels
between peer gateways:

Note - Wire Mode is not supported for IPv6 connections.

n Use the community settings - Create the number of VPN tunnels as defined on
the community Tunnel Management page.

n Custom settings:

l One VPN tunnel per each pair of hosts - A VPN tunnel is created for every
session initiated between every pair of hosts.

l One VPN tunnel per subnet pair - After a VPN tunnel has been opened
between two subnets, subsequent sessions between the same subnets will
share the same VPN tunnel. This is the default setting and is compliant with
the IPsec industry standard.

l One VPN tunnel per Gateway pair - One VPN tunnel is created between
peer gateways and shared by all hosts behind each peer gateway.

2. On the Capacity Optimization page, select limit Maximum concurrent IKE
negotiations, so you can maximize VPN throughput.
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If you have many employees working remotely, you may want to raise the default values.
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Link Selection
Link Selection Overview
Link Selection is a method to define which interface is used for incoming and outgoing VPN traffic
as well as the best possible path for the traffic. With the Link Selection mechanisms, the
administrator can choose which IP addresses are used for VPN traffic on each Security Gateway.

Link Selection has many configuration options to enable you to control VPN traffic. These options
include:

n Use probing to choose links according to their availability.

n Use Load Sharing for Link Selection to distribute VPN traffic over available links.

n Use Service Based Link Selection to control bandwidth use.

Configuration settings for remote access clients can be configured together or separately from
the Site-to-Site configuration.

Configuring IP Selection by Remote Peer
There are several ways to configure how a Remote Peer resolves the IP address of the local
Security Gateway.

You configure the settings in SmartConsole

1. From the left navigation panel, click Gateways & Servers.

2. Double-click the Security Gateway object.

3. Click IPsec VPN > Link Selection.

Remote peers can connect to the local Security Gateway with one of these settings:

n Always use this IP Address

n Calculate IP based on network topology

n Using DNS resolving

n Using probing - Link redundancy mode
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Last Known Available Peer IP Address
The IP address used by a Security Gateway during a successful IKE negotiation with a peer
Security Gateway, is used by the peer Security Gateway as the destination IP address for the next
IPsec traffic and IKE negotiations that it initiates. This is only the case when the Link Selection
configuration does not use probing.

Configuring Outgoing Route Selection
For outbound traffic, there are different methods that can be used to determine which path to
use when connecting with a remote peer. These settings are configured in Security Gateway
Properties > IPsec VPN > Link Selection.

When Initiating a Tunnel:

n Operating system routing table (default setting) - With this method, the routing table is
consulted for the available route with the lowest metric and best match for the VPN tunnel
traffic.

n Route based probing - This method also consults the routing table for an available route
with the lowest metric and best match. However, before a route is chosen, it is tested for
availability with RDP probing. The Security Gateway then selects the best match (highest
prefix length) active route with the lowest metric. This method is recommended when there
is more than one external interface.

If you selected the IP Selection by Remote Peer setting of Use probing with Load
Sharing, it also affects Route based probing link selection. In this case, Route based
probing distributes the outgoing encrypted traffic among all available links. All possible
links to the peer Security Gateway are derived from the routing table and the link's
availability is tested with RDP probing. Every new connection ready for encryption uses the
next available link in a round robin manner.

Route based probing enables the use of On Demand Links (ODL), which are triggered
upon failure of all primary links. You can run a script to activate an On Demand Link when
all other links with higher priorities become unavailable. For more information, see the
section "On Demand Links".

For IKE and RDP sessions, Route based probing uses the same IP address and interface for
responding traffic.

Notes:
The High Availability mechanism is based on:

l resolver_session_interval (30) - Defines for how many
seconds the remote peer status (up or down) stays valid

l resolver_ttl (10) - Defines how many seconds the Security
Gateway waits before it decides that a remote peer is down
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Some network protocols (for example, TCP) might timeout in the time between link failure
and the next attempt to resolve. Administrators can decrease these default values. Note
that high resolution frequency can overload the gateway. This configuration also changes
the default resolution timeouts for the MEP mechanism.

For Layer 2 links, there must be routes to the peer's encryption domains through the local
Layer 2 interface device.

When Responding to a Remotely Initiated Tunnel
When responding to a remotely initiated tunnel, there are two options for selecting the interface
and next hop that are used. These settings are only applicable for IKE and RDP sessions.

These settings are configured in Link Selection > Outgoing Route Selection > Setup > Link
Selection - Responding Traffic window.

n Use outgoing traffic configuration - Select this option to choose an interface with the
same method selected in the Outgoing Route Selection section of the Link Selection
page.

n Reply from the same interface - This option sends the returning traffic through the same
interface and next hop IP address through which it arrived.

Note - When Route Based Probing is enabled, Reply from the same interface is the selected
method and cannot be changed.

Using Route Based Probing
The local Security Gateway, with RDP probing, considers all possible routes between itself and the
remote peer Security Gateway. The Security Gateway then decides on the most effective route
between the two Security Gateways:

In this scenario, Security Gateway A has two external interfaces, 192.168.10.10 and 192.168.20.10.
Peer Security Gateway B also has two external interfaces: 192.168.30.10 and 192.168.40.10.
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For Security Gateway A, the routing table reads:

Destination Netmask Next hop Metric

192.168.40.10 255.255.255.0 192.168.10.20 1

192.168.40.10 255.255.255.0 192.168.20.20 2

192.168.30.10 255.255.255.0 192.168.10.20 3

192.168.30.10 255.255.255.0 192.168.20.20 4

For Security Gateway B, the routing table reads:

Destination Netmask Next hop Metric

192.168.20.10 255.255.255.0 192.168.40.20 1

192.168.20.10 255.255.255.0 192.168.30.20 2

192.168.10.10 255.255.255.0 192.168.40.20 3

192.168.10.10 255.255.255.0 192.168.30.20 4

If all routes for outgoing traffic from Security Gateway A are available, the route from
192.168.10.10 to 192.168.40.10 has the lowest metric (highest priority) and is therefore the
preferred route.

Source IP Address Settings
Configuration

The source IP address used for outgoing packets can be configured for sessions initiated by
the Security Gateway. You configure these settings in Security Gateway Properties > IPsec
VPN > Link Selection > Outgoing Route Selection > Source IP address settings.

When initiating a VPN tunnel, set the source IP address with one of the following:

n Automatic (derived from the method of IP selection by remote peer) - The source
IP address of outgoing traffic is derived from the method selected in the IP Selection by
Remote Peer section.

l If Main address or Selected address from topology table are chosen in the IP
Selection by Remote Peer section, then the source IP when initiating a VPN
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tunnel is the IP specified for that method.

l If Calculate IP based on network topology, Statically NATed IP, Use DNS
resolving, or Use probing is chosen in the IP Selection by Remote Peer section,
then the source IP when initiating a VPN tunnel is the IP address of the chosen
outgoing interface.

n Manual:

l Main IP address - The source IP is derived from the General Properties page of
the Security Gateway.

l Selected address from topology table - The selected IP from the drop down
menu becomes the source IP.

l IP address of chosen interface - The source IP is the same IP of the interface
where the traffic is being routed through.

These settings are applicable for RDP and IKE sessions. When responding to an IKE session,
use the reply_from_same_IP (default: true) attribute to follow the settings in the Source
IP address settings window or to respond from the same IP address.

Note - When Route Based Probing is enabled, reply_from_same_IP will
be seen as true.

Outgoing Link Tracking
When Outgoing link tracking is activated on the local Security Gateway, the Security Gateway
sends a log for every new resolving decision performed with one of its remote VPN peers.

If Use Probing is configured on the local Security Gateway for Remote Peer resolving, or if Route
Based Probing is activated on the local Security Gateway, log entries are also created for all
resolving changes. For example, if a link in use becomes unavailable and a new available link is
chosen, a log entry is issued.

Link Selection Scenarios
Link Selection can be used in many environments. This section describes various scenarios and
how Link Selection should be configured in each scenario.

Gateway with a Single External Interface
This is the simplest scenario, where the local Security Gateway has a single external interface for
VPN:
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How do peer Security Gateways select an IP address on the local Security Gateway for VPN traffic?

Since there is only one interface available for VPN, to determine how remote peers determine the
IP address of the local Security Gateway, select the following from the IP Selection by Remote
Peer section of the Link Selection page:

n Select Main address or choose an IP address from the Selected address from topology
table drop down menu.

n If the IP address is located behind a static NAT device, select Statically NATed IP.

Gateway with Several IP Addresses Used by Different
Parties
In this scenario, the local Security Gateway has a point-to-point connection from two different
interfaces. Each interface is used by a different remote party:
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The local Security Gateway has two IP addresses used for VPN. One interface is used for VPN with
a peer Security Gateway A and one interface for peer Security Gateway B.

To determine how peer Security Gateways discover the IP address of the local Security Gateway,
enable one-time probing with High Availability redundancy mode. Since only one IP is available
for each peer Security Gateway, probing only has to take place one time.

Gateway with an Interface Behind a Static NAT Device
In this scenario, the local Security Gateway has two external interfaces available for VPN.

The IP address of interface eth0 is translated using a NAT device:

To determine how peer Security Gateways discover the IP address of the local Security Gateway,
use ongoing probing with High Availability redundancy mode.

In order for the Static NAT IP address to be probed, it must be added to the Probe the following
addresses list in the Probing Settings window.

Utilizing Load Sharing
Depending on your configuration, there are many ways to use Load Sharing to distribute VPN
traffic among available links between the local and peer Security Gateways.

Load Sharing with Multiple External Interfaces on Each End

In the following scenario, the local and peer Security Gateways each have two external interfaces
available for VPN traffic.
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To utilize both external interfaces by distributing VPN traffic among all available links, use the
Probing redundancy mode of Load Sharing on both Security Gateways. You can also specify that
only certain external interfaces should be probed by putting only those interfaces in the Probe
the following addresses list in the Probing Settings window. If one link goes down, traffic will
automatically be rerouted through the other link.

To enable this configuration, make sure that your routing table allows packet flow back and forth
between both eth0 interfaces and packet flow back and forth between both eth1 interfaces.
Then Link Selection can reroute the VPN traffic between these available links.

Load Sharing with Multiple External Interfaces on One End

In the following scenario, the local Security Gateway has two external interfaces available for VPN
traffic. The peer Security Gateway has one external interface for VPN traffic.
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To utilize both external interfaces and distribute VPN traffic between the available links, use the
Probing redundancy mode of Load Sharing on the local Security Gateway. Then the peer
Security Gateway will distribute its outgoing VPN traffic between interfaces eth0 and eth1 of the
local Security Gateway.

If the default, Operating system routing table, setting in the Outgoing Route Selection section
is selected, the local Security Gateway will only use one of its local interfaces for outgoing VPN
traffic; the route with the lowest metric and best match to reach the single IP address of the peer
Security Gateway, according to the routing table.

If you want to distribute the outgoing VPN traffic on both outbound links from the local Security
Gateway as well, select Route Based Probing in the Outgoing Route Selection on the Link
Selection page of the local Security Gateway.
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Service Based Link Selection
Service Based Link Selection enables administrators to control outgoing VPN traffic and
bandwidth use by assigning a service or a group of services to a specific interface for outgoing
VPN routing decisions. The encrypted traffic of an outgoing connection is routed through the
configured interface according to the traffic's service. The links to the peer Security Gateway are
derived from the routing table and the link's availability is tested with RDP probing.

If all links through the interface assigned to a specific service stop responding to RDP probing, a
link failover will occur by default, as in any other probing mode. When a link through the assigned
interface is restored, new outgoing connections are assigned to it, while existing connections are
maintained over the backup link until they are completed.

It is possible to configure the traffic of a specific service not to fail over. In this case, traffic of the
configured service will only be routed through interfaces assigned to this service, even if these
interfaces stop responding to RDP.

If the same service is assigned to more than one interface, this service's traffic is distributed
between the configured interfaces. Every new outgoing encrypted connection uses the next
available link in a round robin manner.

All traffic from services that are not assigned to a specific interface is distributed among the
remaining interfaces. If all links through these interfaces are down, the traffic is distributed
among the interfaces that are configured for specific services.

Service Based Link Selection configuration requires enabling the following features:

n IP Selection by Remote Peer - Load Sharing probing mode

n Outgoing Route Selection - Route based probing

n Service Based Link Selection - Configuration file on the management server

Service Based Link Selection is supported on Security Gateways of version R71 and higher. Service
Based Link Selection is not supported on UTM-1 Edge devices.

Configuring Service Based Link Selection
To configure Service Based Link Selection:

1. In the Link Selection page, in the IP Selection by Remote Peer section, select:

n Use probing. Redundancy mode

n Load Sharing

2. In the Outgoing Route Selection section, select Route based probing.

Edit the Service Based Link Selection configuration in the $FWDIR/conf/vpn_service_based_

routing.conf configuration file on the management server.
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Fill in each line in the configuration file to specify the target Security Gateway, the interface for
outgoing routing, and the service (or services group) to route through this interface. Use the
names defined in the SmartConsole. Fill in all of the details for each Security Gateway on which
you want to configure Service Based Link Selection.

The fields are:

n Gateway - Security Gateway name (the name of the VPN Security Gateway or the cluster).

n Interface - Interface name.

n Service - Service or services group name.

n dont_failover - (Optional) If this string is present, traffic of the configured service will only
be routed through interfaces configured for this service and will not fail over to another
interface.

Service Based Link Selection Scenarios
The following scenarios provide examples of how Service Based Link Selection can be utilized.

Service Based Link Selection with Two Interfaces on Each End

In the scenario below, the local and peer Security Gateways each have two external interfaces for
VPN traffic.
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In this example, interface eth1 of both Security Gateways is dedicated to HTTP and FTP traffic. All
other traffic is routed to interface eth0.

If the available link through eth1 stops responding to RDP probing, HTTP and FTP traffic will fail
over to eth0. It is possible to specify that HTTP and FTP traffic should only be routed through
eth1 even if the link through eth1 stops responding. Specify this by including the dont_failover
flag when editing the Service Based Link Selection configuration file.

All other traffic that is not HTTP or FTP will be routed through eth0. If the link through eth0 stops
responding to RDP probing, all traffic will be routed through eth1.

The Service Based Link Selection configuration file for this environment should appear as follows:

Gateway Interface Service [dont_failover]

London_GW eth1 http

London_GW eth1 ftp

Paris_GW eth1 http

Paris_GW eth1 ftp
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Alternatively, in SmartConsole, you can create a Services Group that includes HTTP and FTP
services. In the example below, this group is called http_ftp_grp. With this group, the Service
Based Link Selection configuration file for this environment should appear as follows:

Gateway Interface Service [dont_failover]

London_GW eth1 http_ftp_grp

Paris_GW eth1 http_ftp_grp

Service Based Link Selection with Multiple Interfaces on Each End

In the following scenario, the local and peer Security Gateways each have three external
interfaces available for VPN.
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To utilize all three external interfaces and distribute the VPN traffic among the available links,
Link Selection Load Sharing and Route based probing should be enabled. To control your
bandwidth use, dedicate one or more links to a specific service or services using Service Based
Link Selection. In this scenario, interfaces eth0 and eth1 of both Security Gateways are
dedicated to SIP traffic. SIP traffic is distributed between eth0 and eth1. All other traffic is
routed through eth2.

If either the link through eth0 or the link through eth1 stops responding to RDP probing, SIP
traffic will fail over to the other SIP interface. If the link through eth2 stops responding to RDP
probing, all traffic will be routed though eth0 or eth1.

Service Based Link Selection with Two Interfaces on One End

In the following scenario, the local Security Gateway has two external interfaces available for VPN
traffic. The peer Security Gateway has a single external interface for VPN traffic.
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To utilize all external interfaces and distribute the VPN traffic among the available links, Link
Selection Load Sharing and Route based probing should be enabled on the local Security
Gateway, London_GW. To control your bandwidth use, dedicate interface eth1 of the local
Security Gateway to HTTP and FTP traffic using Service Based Link Selection. The local Security
Gateway will route outgoing HTTP and FTP connections through interface eth1. All other traffic,
not HTTP or FTP, will be routed through eth0.

In this scenario, HTTP and FTP traffic should not fail over. HTTP and FTP traffic should only be
routed through interface eth1, even if the link through interface eth1 stops responding to RDP
probing. This is configured by specifying the dont_failover flag.

The Service Based Link Selection configuration file for this environment should appear as follows:

Gateway Interface Service [dont_failover]

London_GW eth1 http dont_failover

London_GW eth1 ftp dont_failover

Since the Service Based Link Selection configuration is only applicable for outgoing traffic of the
local Security Gateway, the peer Security Gateway can send HTTP and FTP traffic to either
interface of the local Security Gateway. The outgoing VPN traffic of the peer Security Gateway is
distributed between interfaces eth0 and eth1 of the local Security Gateway.

Trusted Links
Trusted Links allows you to set an interface as "trusted" for VPN traffic so that traffic sent on that
link will not be encrypted. You may want to set up a trusted link if you are confident that the link
is already encrypted and secure and you do not need a second encryption.

If you configure an interface as trusted, traffic routed through that interface will be sent
unencrypted, while traffic sent through other interfaces will still be encrypted.

Trusted interfaces should be configured symmetrically on the local and peer Security Gateways. If
only one side of the link is configured as trusted for VPN traffic, clear traffic received by a non-
trusted interface will be dropped by the peer Security Gateway.

If you have configured a specific link as trusted for VPN traffic and you use probing, the probing
method considers all links, including the trusted link, when choosing a link for a connection.

The probing method chooses the link according to these criteria:

n The configured redundancy mode, High Availability or Load Sharing

n If Service Based Link Selection is configured.

If the trusted link is chosen for a connection, the traffic is not encrypted. If another, non-trusted,
link is chosen, the traffic is encrypted.
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In an MEP configuration, trusted links are only supported for connections initiated by a peer
Security Gateway to a MEP Security Gateway. Unencrypted VPN connections routed through a
trusted interface and initiated by a MEP Security Gateway may be dropped by the peer Security
Gateway.

Trusted links are not supported in Traditional mode. In Traditional mode, trusted link settings are
ignored and VPN traffic is always encrypted.

Trusted links are supported on Security Gateways of version R71 and higher.

Configuring Trusted Links
Use the GuiDBedit Tool (see sk13009) to configure Trusted Links.

To configure a trusted link :

1. In the top left pane, go to Network objects > network_objects.

2. In the top right pane, click the Security Gateway / Cluster object that you want to edit.

3. In the bottom pane, search for the interface that you want to configure as trusted from
within the interfaces set. The interface name appears in the officialname attribute.

4. Within the trusted interface set, change the value of the vpn_trusted attribute to true

(default value: false).

5. Configure trusted interfaces symmetrically on the peer Security Gateways. If only one side
of the link is configured as trusted for VPN traffic, clear traffic received by a non-trusted
interface will be dropped by the peer Security Gateway.

6. Save changes (File menu > Save All).

7. In SmartConsole, install the Access Control Policy on the Security Gateway / Cluster object.

Trusted Links Scenarios
In the following scenario, both the local and peer Security Gateways have two external interfaces
available for VPN traffic. Interface eth1 on both Security Gateways has been configured as a
trusted interface. Therefore traffic sent from eth1 of the local Security Gateway will be sent
unencrypted and will be accepted by interface eth1 of the peer Security Gateway, and vice versa.

http://supportcontent.checkpoint.com/solutions?id=sk13009
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If the probing redundancy mode is High Availability and the trusted link is configured as the
Primary IP address, the trusted link will be used for VPN traffic. If the trusted link stops
responding to RDP probing, the link through Interface eth0 will be used for VPN traffic and traffic
will be encrypted.

If the probing redundancy mode is Load Sharing, the VPN traffic will be distributed between the
available links. Connections routed through interface eth0 will be encrypted while connections
routed through the trusted link will not be encrypted.

Using Trusted Links with Service Based Link Selection

In the following scenario, the local and peer Security Gateways have two external interfaces
available for VPN traffic. Interface eth1 on both Security Gateways is configured as a trusted
interface for VPN traffic since encryption is not needed on that link. In addition, interface eth1 of
both Security Gateways is dedicated to SIP traffic using Service Based Link Selection.
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SIP traffic is routed through the trusted link between the two eth1 interfaces and will not be
encrypted. If the trusted link stops responding to RDP probing, SIP traffic will be routed through
the eth0 interfaces and will be encrypted.

All other traffic that is not SIP is encrypted and routed through the interface eth0 link. However,
if interface eth0 stops responding to RDP probing, all the traffic will be routed through the
trusted link and will not be encrypted.

On Demand Links (ODL)
Route based probing enables use of an On Demand Link (ODL), which is triggered upon failure of
all primary links. When a failure is detected, a custom script is used to activate the ODL and
change the applicable routing information. The ODL's metric must be set to be larger than a
configured minimum in order for it to be considered an ODL.
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The Security Gateway has two external links for Internet connectivity: one to an ISP, the other to
an ISDN dialup. The ISDN dialup connection is configured as an On Demand Link.

On the Security Gateway, the Route Based Probing mechanism probes all of the non-On Demand
Links and selects the active link with the lowest metric. In this case, it probed the ISP link. A script
is run to activate the On Demand Link when all other links with higher priorities become
unavailable. When the link becomes available again, a shutdown script is run automatically and
the connection continues through the link with the ISP.

Note - On Demand Links are probed only once with a single RDP session. Fail over between On
Demand Links is not supported.

Configuring On Demand Links
You can enable On Demand Links only if you enabled Route Based Probing. Configure On
Demand Links commands in GuiDBedit Tool (see sk13009).

Property Description

use_on_demand_
links

Enables on-demand links.
The default is false. Change to true.

on_demand_metric_
min

Defines the minimum metric level for an on-demand link.
This value must be equal to or higher than the configured minimum
metric.

http://supportcontent.checkpoint.com/solutions?id=sk13009
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Property Description

on_demand_
initial_script

The name of the on-demand script, which runs when all not-on-
demand routes stop responding.
Put the script in the $FWDIR/conf/ directory.

on_demand_
shutdown_script

This script is run when the failed links become available.
Put the script in the $FWDIR/conf/ directory .

If you do not want to use GuiDBedit, you can configure the use_on_demand_links and on_

demand_metric_min settings in SmartConsole:

1. Click Menu > Global properties > Advanced > Configure.

2. Click VPN Advanced Properties > Link Selection.

3. Select use_on_demand_links to enable On Demand Links.

4. In the on_demand_metric_min field, set the minimum metric level for an On Demand Link.

5. Click OK.

6. Click OK.

7. Install the Access Control Policy.

Link Selection and ISP Redundancy
ISP Redundancy enables reliable Internet connectivity by allowing a single or clustered Security
Gateway to connect to the Internet via redundant ISP connections. As part of standard VPN
installation, it offers two modes of operation:

n Load Sharing mode

n Primary/Backup mode

Configuring Link Selection and ISP Redundancy
Configure Link Selection and ISP Redundancy in the Other > ISP Redundancy page of the
Gateway object:

n Load Sharing mode connects to both ISPs while sharing the load of outgoing connections
between the ISPs according to a designated weight assignment. New connections are
randomly assigned to a link. If a link fails, all new outgoing connections are directed to the
active link. This configuration effectively increases the WAN bandwidth while providing
connectivity protection. The assigned ISP Links weight is only supported for firewall traffic.

n Primary/Backup mode connects to an ISP through the primary link, and switches to a
backup ISP if the primary ISP link fails. When the primary link is restored, new outgoing
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connections are assigned to it, while existing connections are maintained over the backup
link until they are complete.

The settings configured in the ISP Redundancy window are by default, applied to the Link
Selection page and will overwrite any pre-existing configuration. The following settings carry
over:

n When ISP Redundancy is configured, the default setting in the Link Selection page is Use
ongoing probing. However, Link Selection only probes the ISPs configured in the ISP
Redundancy window. This enables connection failover of the VPN tunnel if connectivity to
one of the Security Gateway interfaces fails.

n If the ISP Redundancy mode is Load Sharing, the Probing redundancy mode in the Link
Selection page is also Load Sharing.

n If the ISP Redundancy mode is Primary/Backup, the Probing redundancy mode in the Link
Selection page is High Availability.

l The Primary ISP link of the ISP redundancy is set as the Primary Address of the Link
Selection probing. The Primary Address is set under: IP Selection by Remote Peer >
Use Probing > Configure (or View , if the settings are derived from the ISP
Redundancy settings).

If you do not want the ISP Redundancy settings to affect the Link Selection settings, on the ISP
Redundancy page, clear the check box that says Apply settings to VPN traffic and configure the
required VPN settings on the Link Selection page. This may apply when you want to route VPN
traffic differently than the firewall traffic. For example, if you want to use Load Sharing for firewall
traffic and High Availability for VPN traffic, or if you want to use different primary ISPs for firewall
and VPN traffic.

Link Selection and ISP Redundancy
In the following scenario, the local Security Gateway maintains links to ISPs A and B, both of which
provide connectivity to the Internet with ISP Redundancy.
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In the Topology > ISP Redundancy window, configure the ISP Redundancy settings, such as ISP
Links and Redundancy mode. The ISP Redundancy settings are applied by default to VPN traffic.
The derived Link Selection settings are visible in the IPsec VPN > Link Selection window.

In the following scenario, the Apply settings to VPN traffic on the ISP Redundancy page was
cleared, and there are different setting configured for Link Selection and ISP Redundancy.

In this scenario:

n Security Gateways A, B, and C each have two interfaces configured as ISP links.

n ISP Redundancy is configured on Security Gateway A.

n Security Gateway A should use ISP 1 in order to connect to Security Gateway B and ISP 2 in
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order to connect to Security Gateway C. If one of the ISP links becomes unavailable, the
other ISP should be used.

In this scenario, the administrator of Security Gateway A needs to:

n Clear the box Apply settings to VPN traffic in the ISP Redundancy window.

n Reconfigure the Outgoing Route Selection to Route Based Probing in the Link Selection
window.

n Configure the routing table so that ISP 1 is the highest priority for peer Security Gateway B
and ISP 2 has the highest priority for peer Security Gateway C.

Link Selection with non-Check Point
Devices
RDP probing, the probing method used for certain Link Selection features, is proprietary to Check
Point and only works between Check Point entities. It is not supported with non-Check Point
devices.

Since RDP probing is not active on non-Check Point gateways, the following results apply if a
Check Point Security Gateway sends VPN traffic to a non-Check Point gateway:

n Use probing cannot be used by locally managed Check Point Security Gateways to
determine the IP address of non-Check Point devices. Any of the other methods available
from the IP Selection by Remote Peer section can be used.

n Load Sharing and Service Based Link Selection do not work with non-Check Point
gateways. If Load Sharing or Service Based Link Selection is enabled on the local Security
Gateway, but the peer is a non-Check Point device, the local Security Gateway will only use
one link to the non-Check Point device: the best match (highest prefix length) link with the
lowest metric.

n If Route based probing is selected as the Outgoing Route Selection method, for VPN
traffic to a non-Check Point device, the local Security Gateways will always use the best
match (highest prefix length) link with the lowest metric.



Glossary

Site to Site VPN R80.40 Administration Guide      |      85

Public Key Infrastructure
Need for Integration with Different PKI
Solutions
X.509-based PKI solutions provide the infrastructure that enables entities to establish trust
relationships between each other based on their mutual trust of the Certificate Authority (CA).
The trusted CA issues a certificate for an entity, which includes the entity's public key. Peer
entities that trust the CA can trust the certificate - because they can verify the CA's signature -
and rely on the information in the certificate, the most important of which is the association of the
entity with the public key.

IKE standards recommend the use of PKI in VPN environments, where strong authentication is
required.

A Security Gateway taking part in VPN tunnel establishment must have an RSA key pair and a
certificate issued by a trusted CA. The certificate contains details about the module's identity, its
public key, CRL retrieval details, and is signed by the CA.

When two entities try to establish a VPN tunnel, each side supplies its peer with random
information signed by its private key and with the certificate that contains the public key. The
certificate enables the establishment of a trust relationship between the Security Gateways; each
gateway uses the peer Security Gateway public key to verify the source of the signed information
and the CA's public key to validate the certificate's authenticity. In other words, the validated
certificate is used to authenticate the peer.

Every deployment of Check Point Security Management Server includes an Internal Certificate
Authority (ICA) that issues VPN certificates for the VPN modules it manages. These VPN certificates
simplify the definition of VPNs between these modules.

Situations can arise when integration with other PKI solutions is required, for example:

n A VPN must be established with a Security Gateway managed by an external Security
Management Server. For example, the peer Security Gateway belongs to another
organization which utilizes Check Point products, and its certificate is signed by its own
Security Management Server ICA.

n A VPN must be established with a non-Check Point VPN entity. In this case, the peer's
certificate is signed by a third-party CA.

n An organization may decide, for whatever reason, to use a third party CA to generate
certificates for its Security Gateways.
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Supporting a Wide Variety of PKI Solutions
Check Point Security Gateways support many different scenarios for integrating PKI in VPN
environments:

n Multiple CA Support for Single VPN Tunnel - Two Security Gateways present a certificate
signed by different ICAs.

n Support for non-ICA CAs - In addition to ICA, Security Gateways support the following
Certificate Authorities:

n External ICA - The ICA of another Security Management Server

n Other OPSEC certified PKI solutions

n CA Hierarchy - CAs are typically arranged in a hierarchical structure where multiple CAs
are subordinate to a root authority CA. A subordinate CA is a Certificate Authority certified
by another Certificate Authority. Subordinate CAs can issue certificates to other, more
subordinate CAs, forming a certification chain or hierarchy.

PKI and Remote Access Users
The Check Point Suite supports certificates not only for Security Gateways but for users as well.
For more information, see Introduction to Remote Access VPN for information about user
certificates.

PKI Deployments and VPN
Following are some sample CA deployments:

n Simple Deployment - internal CA

n CA of an external Security Management Server

n CA services provided over the Internet

n CA on the LAN

Simple Deployment ? Internal CA

When the VPN tunnel is established between Security Gateways managed by the same Security
Management Server, each peer has a certificate issued by the Security Management Server's ICA.

CA of An External Security Management Server

If a Check Point Security Gateway is managed by an external Security Management Server (for
example, when establishing a VPN tunnel with another organization's VPN modules), each peer
has a certificate signed by its own Security Management Server's ICA.
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Security Management Server A issues certificates for Security Management Server B that issues
certificates for Security Gateway B.

CA Services Over the Internet

If the certificate of a Security Gateway is issued by a third party CA accessible over the Internet,
CA operations such as registration or revocation are usually performed through HTTP forms. CRLs
are retrieved from an HTTP server functioning as a CRL repository.

Security Gateways A and B receive their certificates from a PKI service provider accessible via the
web. Certificates issued by external CAs may be used by Security Gateways managed by the same
Security Management Server to verification.

CA Located on the LAN

If the peer VPN Security Gateway certificate is issued by a third party CA on the LAN, the CRL is
usually retrieved from an internal LDAP server, as shown:
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Trusting An External CA
A trust relationship is a crucial prerequisite for establishing a VPN tunnel. However, a trust
relationship is possible only if the CA that signs the peer's certificate is "trusted." Trusting a CA
means obtaining and validating the CA's own certificate. Once the CA's Certificate has been
validated, the details on the CA's certificate and its public key can be used to both obtain and
validate other certificates issued by the CA.

The Internal CA (ICA) is automatically trusted by all modules managed by the Security
Management Server that employs it. External CAs (even the ICA of another Check Point Security
Management Server) are not automatically trusted, so a module must first obtain and validate an
external CA's certificate. The external CA must provide a way for its certificate to be imported into
the Security Management Server.

If the external CA is:

n The ICA of an external Security Management Server, see the R80.40 Security Management
Administration Guide for further information

n An OPSEC Certified CA, use the CA options on the Servers and OSPEC Applications tab to
define the CA and obtain its certificate

Subordinate Certificate Authorit ies

A subordinate CA is a Certificate Authority certified by another Certificate Authority. Subordinate
CAs can issue certificates to other, more subordinate CAs, in this way forming a certification chain
or hierarchy. The CA at the top of the hierarchy is the root authority or root CA. Child Certificate
Authorities of the root CA are referred to as Subordinate Certificate Authorities.

With the CA options on the Servers and OSPEC Applications tab, you can define either a
Certificate Authority as either Trusted or Subordinate. Subordinate CAs are of the type OPSEC,
and not trusted.

https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_SecurityManagement_AdminGuide/Default.htm
https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_SecurityManagement_AdminGuide/Default.htm
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Enrolling a Managed Entity
Enrollment means requesting and obtaining a certificate from a CA, for an entity.

The process of enrollment begins with the generation of a key pair. A certificate request is then
created out of the public key and additional information about the module. The type of the
certificate request and the rest of the enrollment process depends on the CA type.

The case of an internally managed Security Gateway is the simplest, because the ICA is located on
the Security Management Server machine. The enrollment process is completed automatically.

To obtain a certificate from an OPSEC Certified CA, Security Management Server takes the module
details and the public key and encodes a PKCS#10 request. The request (which can include
SubjectAltName for OPSEC certificates and Extended Key Usage extensions) is delivered to the CA
manually by the administrator. Once the CA issues the certificate the administrator can complete
the process by importing the certificate to the Security Management Server.

A certificate can also be obtained for the Security Gateway with Automatic Enrollment. With
Automatic Enrollment, you can automatically issue a request for a certificate from a trusted CA for
any Security Gateway in the community. Automatic Enrollment supports the following protocols:

n SCEP

n CMPV1

n CMPV2

Note - During SCEP enrollment, some HTTP requests may be larger than 2000 bytes, and may be
dropped by the HTTP protocol inspection mechanism if enabled. A change of the default value
will be required to enable these HTTP requests. If enrollment still fails, enrollment must be done
manually. For more information, see the R80.40 Threat Prevention Administration Guide.

Validation of a Certificate
When an entity receives a certificate from another entity, it must:

1. Verify the certificate signature, i.e. verify that the certificate was signed by a trusted CA. If
the certificate is not signed directly by a trusted CA, but rather by a subsidiary of a trusted
CA, the path of CA certificates is verified up to the trusted CA.

2. Verify that the certificate chain has not expired.

3. Verify that the certificate chain is not revoked. A CRL is retrieved to confirm that the serial
number of the validated certificate is not included among the revoked certificates.

In addition, VPN verifies the validity of the certificate's use in the given situation, confirming that:

n The certificate is authorized to perform the required action. For example, if the private key
is needed to sign data (e.g., for authentication) the KeyUsage extension on the certificate -
if present - is checked to see if this action is permitted.

https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_ThreatPrevention_AdminGuide/Default.htm
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n The peer used the correct certificate in the negotiation. When creating a VPN tunnel with an
externally managed module, the administrator may decide that only a certificate signed by
a specific CA from among the trusted CAs can be accepted. (Acceptance of certificates with
specific details such as a Distinguished Name is possible as well).

Revocation Checking

There are two available methods useful in determining the status of a certificate:

1. CRL

2. Online Certificate Status Protocol (OCSP)

Enrolling with a Certificate Authority

A certificate is automatically issued by the ICA for all internally managed entities that are VPN
capable. That is, after the administrator has checked selected IPsec VPN in the Network
Security tab of the General Properties page for network objects.

The process for obtaining a certificate from an OPSEC PKI or External Check Point CA is identical.

Manual Enrollment with OPSEC Certified PKI

To create a PKCS#10 Certificate Request

1. If a CA object is not yet configured, create the CA object.

2. Open the IPsec VPN tab of the applicable Network Object.

3. In the Certificate List field click Add.

The Certificate Properties window opens.

4. Enter the Certificate Nickname.

The nickname is only an identifier and has no bearing on the content of the certificate.

5. From the CA to enroll from drop-down box, select the direct OPSEC CA/External Check
Point CA that will issue the certificate.

Note - The list shows only those subordinate CAs that lead directly to a trusted CA and
the trusted CAs themselves. If the CA that issues the certificate is a subordinate CA that
does not lead directly to a trusted CA, the subordinate CA will not appear in the list.

6. Choose the applicable method for Key Pair creation and storage.

7. Click Generate.

The Generate Certificate Properties window opens.

8. Enter the applicable DN.

The final DN that appears in the certificate is decided by the CA administrator.
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If a Subject Alternate Name extension is required in the certificate, select Define
Alternate Name.

Adding the object IP address as Alternate name extension can be configured as a default
setting:

a. In SmartConsole, click Menu > Global properties > Advanced > Configure.

b. Click Certificates and PKI properties.

c. Select these two options:

add_ip_alt_name_for_ICA_certs

add_ip_alt_name_for_opsec_certs

d. Click OK.

Note - The configuration in this step is also applicable for Internal CAs.

9. Click OK.

The public key and the DN are then used to DER-encode a PKCS#10 Certificate Request.

10. After the Certificate Request is ready, click View .

The Certificate Request View window appears with the encoding.

11. Copy the whole text in the window and deliver it to the CA.

The CA administrator must now complete the task of issuing the certificate. Different CAs
provide different ways of doing this, such as an advanced enrollment form (as opposed
to the regular form for users). The issued certificate may be delivered in various ways, for
example email. After the certificate has arrived, it needs to be stored:

a. In Object Explorer (Ctrl+E), go to the Servers category and select the CA object.

b. Open the OPEC PKI tab.

c. Click Get.

d. Browse to the location, in which you saved the certificate file.

e. Select the applicable file.

f. Make sure the certificate details are correct.

g. Close the object.

h. Save.

Automatic Enrollment with the Certificate Authority

Configuration

On the OPSEC PKI tab of the CA object, make sure Automatically enroll certificate is selected
and SCEP or CMP are chosen as the connecting protocol. Then:
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1. In the applicable network object, open the VPN tab.

2. In the Certificates List section, click Add.

The Certificate Properties window opens.

3. Enter a Certificate Nickname (any string used as an identifier)

4. From the drop-down menu, select the CA that issues the certificate.

Note - The menu shows only trusted CAs and subordinate CAs that lead directly to a
trusted CA. If the CA that issues the certificate is a subordinate CA that does not lead
directly to a trusted CA, it is not in the menu.

5. Select a method for key pair generation and storage.

6. Click Generate, and select Automatic enrollment.

The Generate Keys and Get Automatic Enrollment Certificate window opens.

n Supply the Key Identifier and your secret authorization code.

n Click OK.

7. When the certificate appears in the Certificates List on the network objects VPN page,
click View and either Copy to Clipboard or Save to File the text in the Certificate
Request View window.

8. Send the request to CA administrator.

Different Certificate Authorities provide different means for doing this, for example an
advanced enrollment form on their website. The issued certificate can be delivered in
various ways, such as email. Once you have received the certificate, save it to disk.

9. On the VPN tab of the network object, select the applicable certificate in the Certificates
List, and click Complete.

10. Browse to the folder where you stored the issued certificate, select the certificate and
verify the certificate details.

11. Close the network object and Save.

Enrolling through a Subordinate CA

When enrolling through a subordinate CA:

n Supply the password of the subordinate CA which issues the certificate, not the CA at the
top of the hierarchy

n The subordinate CA must lead directly to a trusted CA
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CRL

VPN can retrieve the CRL from either an HTTP server or an LDAP server. If the CRL repository is an
HTTP server, the module uses the URL published in the CRL Distribution Point extension on the
certificate and opens an HTTP connection to the CRL repository to retrieve the CRL.

If the CRL repository is an LDAP server, VPN attempts to locate the CRL in one of the defined LDAP
account units. In this scenario, an LDAP account unit must be defined. If the CRL Distribution
Point extension exists, it publishes the DN of the CRL, namely, the entry in the Directory under
which the CRL is published or the LDAP URI. If the extension does not exist, VPN attempts to locate
the CRL in the entry of the CA itself in the LDAP server.

OCSP

Online Certificate Status Protocol (OCSP) enables applications to identify the state of a certificate.
OCSP may be used for more timely revocation information than is possible with CRLs and may
also be used to obtain additional status information. When OCSP client issues a status request to
an OCSP server, acceptance of the certificate in question is suspended until the server provides a
response.

In order to use OCSP, the root CA must be configured to use this method instead of CRL. This
setting is inherited by the subordinate CAs.

CRL Prefetch-Cache

Since the retrieval of CRL can take a long time (in comparison to the entire IKE negotiation
process), VPN stores the CRLs in a CRL cache so that later IKE negotiations do not require
repeated CRL retrievals.

The cache is pre-fetched:

n every two hours

n on policy installation

n when the cache expires

If the pre-fetch fails, the previous cache is not erased.

Note - The ICA requires the use of a CRL cache.

An administrator can shorten the lifetime of a CRL in the cache or even to cancel the use of the
cache. If the CRL Cache operation is canceled, the CRL must be retrieved for each subsequent IKE
negotiation, thus considerably slowing the establishment of the VPN tunnel. Because of these
performance implications, we recommend that you only disable CRL caching when the level of
security demands continuous CRL retrieval.
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Special Considerations for the CRL Pre-fetch Mechanism

The CRL pre-fetch mechanism makes a "best effort" to obtain the most up to date list of revoked
certificates. However, after the cpstop and cpstart commands have been executed, the cache
is no longer updated. The Security Gateway continues to use the old CRL for as long as the old
CRL remains valid (even if there is an updated CRL available on the CA). The pre-fetch cache
mechanism returns to normal functioning only after the old CRL expires and a new CRL is
retrieved from the CA.

In case there is a requirement that after the cpstop and cpstart commands, the CRLs will be
updated immediately, proceed as follows:

n After executing the "cprestart" command, run the "vpn crl_zap" on page 188 command to
empty the cache, or:

n In SmartConsole

1. Click Menu > Global properties > Advanced > Configure.

2. Click Certificates and PKI properties.

3. Select flush_crl_cache_file_on_install.

4. Click OK.

5. Install the Access Control Policy.

When a new policy is installed, the cache is flushed, and a new CRL will be retrieved on demand.

CRL Grace Period

Temporary loss of connection with the CRL repository or slight differences between clocks on the
different machines may cause valid of CRLs to be considered invalid - and thus the certificates to
be invalid as well. VPN overcomes this problem by supplying a CRL Grace Period. During this
period, a CRL is considered valid even if it is not valid according to the CLR validity time.

Special Considerations for PKI

Using the Internal CA vs. Deploying a Third Party CA
The Internal CA makes it easy to use PKI for Check Point applications such as site-to-site and
remote access VPNs. However, an administrator may prefer to continue using a CA that is already
functioning within the organization, for example a CA used to provide secure email, and disk
encryption.
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Distributed Key Management and Storage
Distributed Key Management (DKM) provides an additional layer of security during the key
generation phase. Instead of the Security Management Server generating both public and private
keys and downloading them to the module during a policy installation, the management server
instructs the module to create its own public and private keys and send (to the management
server) only its public key. The private key is created and stored on the module in either a
hardware storage device, or via software that emulates hardware storage. Security Management
Server then performs certificate enrollment. During a policy installation, the certificate is
downloaded to the module. The private key never leaves the module.

Local key storage is supported for all CA types.

DKM is supported for all enrollment methods. You can configure it as a default setting:

1. In SmartConsole, click Menu > Global properties > Advanced > Configure.

2. Click Certificates and PKI properties.

3. Select use_dkm_cert_by_default.

4. Click OK.

5. Install the Access Control Policy.

Note - Generating certificates for Edge devices does not support DKM and will be generated
locally on the management even if use_dkm_cert_by_default is enabled.

Configuration of PKI Operations

Trusting a CA - Step-By-Step
This section describes the procedures for obtaining a CA's own certificate, which is a prerequisite
for trusting certificates issued by a CA.

In order to trust a CA, a CA server object has to be defined. The following sections deal with the
various configuration steps required in different scenarios.

Trusting an ICA

A VPN module automatically trusts the ICA of the Security Management Server that manages it.
No further configuration is required.

Trusting an Externally Managed CA

An externally managed CA is the ICA of another Security Management Server. The CA certificate
has to be supplied and saved to disk in advance.

To establish trust:
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1. In Object Explorer, click New > Server > More > Trusted CA.

The Certificate Authority Properties window opens.

2. Enter a Name for the CA object.

3. Go to the OPSEC PKI tab.

4. Click Get.

5. Browse to where you saved the peer CA certificate and select it.

The certificate details are shown.

Make sure the certificate's details are correct.

Make sure the SHA-1 and MD5 fingerprints of the CA certificate are correct.

6. Click OK.

Trusting an OPSEC Certified CA

The CA certificate has to be supplied and saved to the disk in advance.

Note - In case of SCEP automatic enrollment, you can skip this stage and fetch the CA certificate
automatically after configuring the SCEP parameters.

The CA's Certificate must be retrieved either by downloading it with the CA options in the
Certificate Authority object, or by obtaining the CA's certificate from the peer administrator in
advance.

Define the CA object according to the following steps

1. In Object Explorer, click New > Server > More > Trusted CA or Subordinate CA.

The Certificate Authority Properties window opens.

2. Enter a Name for the CA object.

3. On the OPSEC PKI tab:

n For automatic enrollment, select Automatically enroll certificate.

n From the Connect to CA with protocol, select the protocol used to connect with the
certificate authority, either SCEP, CMPV1 or CMPV2.

Note - For entrust 5.0 and later, use CMPV1.

4. Click Properties:

n If you chose SCEP as the protocol, in the Properties for SCEP protocol window, enter
the CA identifier (such as example.com) and the Certification Authority/Registration
Authority URL.
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n If you chose CMPV1 as the protocol, in the Properties for CMP protocol - V1 window,
enter the applicable IP address and port number. (The default port is 829).

n If you chose CMPV2 as the protocol, in the Properties for CMP protocol -V2 window,
decide whether to use direct TCP or HTTP as the transport layer.

Note - If Automatic enrollment is not selected, then enrollment will have to be
performed manually.

5. Choose a method for retrieving CRLs from this CA.

If the CA publishes CRLs on HTTP server choose HTTP Server(s).

Certificates issued by the CA must contain the CRL location in an URL in the CRL
Distribution Point extension.

If the CA publishes CRL on LDAP server, choose LDAP Server(s).

In this case, you must define an LDAP Account Unit as well. See the R80.40 Security
Management Administration Guide for more details about defining an LDAP object.

In the LDAP Account Unit Properties window, on the General tab, make sure to check the
CRL retrieval.

Certificates issued by the CA must contain the LDAP DN on which the CRL resides in the CRL
distribution point extension.

6. Click Get.

7. If SCEP is configured, it will try to connect to the CA and retrieve the certificate. If not,
browse to where you saved the peer CA certificate and select it.

The certificate is fetched. Verify the certificate's details. Display and validate the SHA-1 and
MD5 fingerprints of the CA certificate.

8. Click OK.

Certificate Revocation (All CA Types)
A certificate issued by the Internal Certificate Authority it is revoked when the certificate object is
removed. Otherwise, the CA administrator controls certificate revocation with the options on the
Advanced tab of the CA object. In addition, the certificate must be removed from the Security
Gateway.

A certificate cannot be removed if the Security Management Server infers from other settings that
the certificate is in use, for example, that the Security Gateway belongs to one or more VPN
communities and this is the only certificate of the Security Gateway.

To remove the certificate

1. Open the IPsec VPN tab of the applicable Security Gateway.

2. In the Repository of Certificates Available to the Gateway, select the applicable

https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_SecurityManagement_AdminGuide/Default.htm
https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_SecurityManagement_AdminGuide/Default.htm
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certificate and click Remove.

Certificate Recovery and Renewal
When a certificate is revoked or becomes expired, it is necessary to create another one or to
refresh the existing one.

Recovery and Renewal with Internal CA

Removal of a compromised or expired certificate automatically triggers creation of a new
certificate, with no intervention required by the administrator. To manually renew a certificate
use the Renew button on the VPN page of the Security Gateway object.

Note - A Security Gateway can have only one certificate signed by one CA. When the new
certificate is issued, you will be asked to replace the existing certificate signed by the same CA.

CA Certificate Rollover
CA Certificate Rollover is a VPN feature that enables rolling over the CA certificates used to sign
client and Security Gateway certificates for VPN traffic, without risk of losing functionality at
transition.

To achieve a gradual CA certificate rollover, CA Certificate Rollover enables VPN support for
multiple CA certificates generated by third-party OPSEC-compliant CAs, such as Microsoft
Windows CA. With multiple CA certificates, you can gradually rollover client and Security Gateway
certificates during a transitional period when client and Security Gateway certificates signed by
both CA certificates are recognized.

When a certificate is added to a CA that already has a certificate, the new certificate is defined as
Additional and receives an index number higher by one than the highest existing certificate index
number. The original certificate is defined as Main.

Only additional certificates can be removed. CA Certificate Rollover provides tools for adding and
removing certificates, and for changing the status of a certificate from additional to main and
from main to additional.

CA Certificate Rollover is for rolling over CA certificates with different keys. To add a CA certificate
with the same key as the existing CA certificate (for example, to extend its expiration date), just
Get the certificate from the OPSEC PKI tab of the CA properties, and do not use CA Certificate
Rollover.

Managing a CA Certificate Rollover

With multiple CA certificates, you can gradually rollover client and Security Gateway certificates
during a transitional period when client and Security Gateway certificates signed by both CA
certificates are recognized.
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This section describes a recommended workflow for the most common scenario. For full details of
the CLI commands, see the "CA Certificate Rollover CLI" section.

Before you begin:

In SmartConsole, define a third-party OPSEC-compliant CA, such as Microsoft Windows CA, that is
capable of generating multiple CA certificates. Generate the main CA certificate and define it in
SmartConsole.

To roll over with a new CA certificate

1. Generate from the third-party CA a second CA certificate in DER format (PEM is not
supported), with different keys than the previous CA certificate. Copy the certificate to
the Security Management Server.

2. Connect to the command line on the Security Management Server.

3. Log in to the Expert mode.

4. Add the new CA certificate to the Security Management Server database's definitions for
the third-party CA:

mcc add <CA Name> <Certificate File>

See "mcc add" on page 232:

n <CA Name> is the name of the CA as defined in the Security Management Server
database.

n <Certificate File> is the certificate filename or path.

5. The new CA certificate should now be defined as additional #1.

Make sure with the "mcc lca" on page 235 or "mcc show" on page 237 command.

6. In SmartConsole, install the Access Control Policy on all Security Gateways.

Use the new additional CA certificate to sign client certificates.

For performance reasons, as long as most clients still use certificates signed by the old CA
certificate, you should leave the new CA certificate as the additional one and the old certificate
as the main one. As long as the new CA certificate is not the main CA certificate, do not use it to
sign any Security Gateway certificates.

CA Certificate Rollover CLI

To perform CA Certificate Rollover use the VPN Multi-Certificate CA commands - "mcc" on
page 230.
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Adding Matching Criteria to the Validation Process
While certificates of an externally managed VPN entity are not handled by the local Security
Management Server, you can still configure a peer to present a particular certificate when
creating a VPN tunnel

Configuration

1. Open the VPN page of the externally managed VPN entity.

2. Click Matching Criteria.

3. Choose the characteristics of the certificate the peer is expected to present, including:

n The CA that issued it

n The exact DN of the certificate

n The IP address that appears in the Subject Alternate Name extension of the
certificate. (This IP address is compared to the IP address of the VPN peer itself as
it appears to the VPN module during the IKE negotiation.)

n The e-mail address appearing in the Subject Alternate Name extension of the
certificate

CRL Cache Usage
To cancel or modify the behavior of the CRL Cache

1. Open the Advanced Tab of the Certificate Authority object.

2. To enable the CRL cache, check Cache CRL on the Security Gateway.

The cache should not be disabled for the ICA. In general, it is recommended that the
cache be enabled for all CA types. The cache should be disabled (for non-ICAs) only if
stringent security requirements mandate continual retrieval of the CRL.

Note - The ICA requires the use of a CRL cache, and should never be disabled.

3. If CRL Cache is enabled, choose whether a CRL is deleted from the cache when it expires
or after a fixed period of time (unless it expires first). The second option encourages
retrieval of a CRL more often as CRLs may be issued more frequently than the expiry
time. By default a CRL is deleted from the cache after 24 hours.

Modifying the CRL Pre-Fetch Cache
To modify the duration of the Pre-fetch cache

1. In SmartConsole, click Menu > Global Properties > Advanced > Configure.
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2. Click Certificates and PKI properties.

3. In the prefetch_crls_duration field, configure the duration.

4. Click OK.

5. Install the Access Control Policy.

Configuring CRL Grace Period
To configure the CRL Grace Period values

1. In SmartConsole, click Menu > Global properties > VPN > Advanced.

2. In the CRL Grace Period section, configure the applicable times.

3. Click OK.

4. Install the Access Control Policy.

The Grace Period can be defined for both the periods before and after the specified CRL
validity period.

Configuring OCSP
To use OCSP, you must configure the CA object to use the OCSP revocation information method
instead of the CRL method.

Use GuiDBedit Tool (see sk13009) to change the value of the field ocsp_validation to true. When
set to true, the CA uses OCSP to make sure that certificates are valid. This is configured on the
root CA and is inherited by the subordinate CAs.

To configure a CA to use OCSP, in GuiDBedit Tool:

See sk37803 for detailed instructions.

http://supportcontent.checkpoint.com/solutions?id=sk13009
http://supportcontent.checkpoint.com/solutions?id=sk37803
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Domain Based VPN
Overview of Domain-based VPN
Domain Based VPN controls how VPN traffic is routed between Security Gateways within a
community. To route traffic to a host behind a Security Gateway, you must first define the VPN
domain for that Security Gateway. Configuration for VPN routing is done with SmartConsole or in
the VPN routing configuration files on the Security Gateways.

In this figure, one of the host machines behind Security Gateway A tries to connect to a host
computer behind Security Gateway B. For technical or policy reasons, Security Gateway A cannot
establish a VPN tunnel with Security Gateway B. With VPN Routing, Security Gateways A and B can
establish VPN tunnels through Security Gateway C.

Item Description

A Security Gateway A

B Security Gateway B

C Security Gateway C
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VPN Routing and Access Control
VPN routing connections are subject to the same access control rules as any other connection. If
VPN routing is correctly configured but a Security Policy rule exists that does not allow the
connection, the connection is dropped. For example: a Security Gateway has a rule which forbids
all FTP traffic from inside the internal network to anywhere outside. When a peer Security
Gateway opens an FTP connection with this Security Gateway, the connection is dropped.

For VPN routing to succeed, a single rule in the Security Policy Rule Base must cover traffic in both
directions, inbound and outbound, and on the central Security Gateway. To configure this rule,
see "Domain Based VPN" on the previous page.

Configuring VPN Routing in Domain Based
VPN
Configure most common VPN routing scenarios through a VPN star community in SmartConsole.

You can also configure VPN routing between Security Gateways in the Security Management
Server configuration file $FWDIR/conf/vpn_route.conf.

You can only configure VPN routing between Security Gateways that belong to a VPN community.

Configuring VPN Routing for Security Gateways in
SmartConsole

To configure a VPN Routing in a star community in SmartConsole:

1. On the Star Community window, in the:

a. Center Gateways section, select the Security Gateway that functions as the "Hub".

b. Satellite Gateways section, select Security Gateways as the "spokes", or satellites.

2. On the VPN Routing page, Enable VPN routing for satellites section, select one of these
options:

n To center and to other Satellites through center - This allows connectivity
between the Security Gateways, for example if the spoke Security Gateways have
dynamically assigned IP addresses, and the Hub is a Security Gateway with a static IP
address.
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n To center, or through the center to other satellites, to internet and other VPN
targets - This allows connectivity between the Security Gateways as well as the ability
to inspect all communication passing through the Hub to the Internet.

3. Create an applicable Access Control Policy rule. Remember: one rule must cover traffic in
both directions.

4. NAT the satellite Security Gateways on the Hub if the Hub is used to route connections from
Satellites to the Internet.

Configuration in the VPN Configuration File
For more granular control over VPN routing, edit the $FWDIR/conf/vpn_route.conf file on the
Security Management Server.

The configuration file, $FWDIR/conf/vpn_route.conf, is a text file that contains the name of
network objects.

The format is: Destination, Next hop, Install on Security Gateway (with tabbed spaces
separating the elements).

Consider a simple VPN routing scenario consisting of Center gateway (hub) and two Satellite
gateways (spokes). All machines are controlled from the same Security Management Server, and
all the Security Gateways are members of the same VPN community. Only Telnet and FTP services
are to be encrypted between the Satellites and routed through the Center:

Although you can do this easily in a VPN Star community, you can achieve the same goal if you
edit the $FWDIR/conf/vpn_route.conf file:

Destination Next hop router interface Install on

Spoke_B_VPN_Dom Hub_C Spoke_A

Spoke_A_VPN_Dom Hub_C Spoke_B

In this instance, Spoke_B_VPN_Dom is the name of the network object group that contains spoke
B's VPN domain. Hub C is the name of the Security Gateway enabled for VPN routing. Spoke_A_
VPN_Dom is the name of the network object that represents Spoke A's encryption domain.

Example of the file contents:

Spoke_B_VPN_DOM Hub_C Spoke_A
Spoke_A_VPN_DOM Hub_C Spoke_B

Configuring the 'Accept VPN Traffic Rule'
In SmartConsole:
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1. Double click on a Star or Meshed Community.

2. On the Encrypted Traffic page, select Accept all encrypted traffic.

3. In a Star community, choose between accepting encrypted traffic on Both center and
satellite gateways or Satellite gateways only.

4. Click OK.

Configuring Multiple Hubs
Consider two Hubs, A and B. Hub A has two spokes, spoke_A1, and spoke_A2. Hub B has a single
spoke, spoke_B. In addition, Hub A is managed from Security Management Server A, while Hub B
is managed via Security Management Server B:

For the two VPN star communities, based around Hubs A and B:

n Spokes A1 and A2 need to route all traffic going outside of the VPN community through Hub
A

n Spokes A1 and A2 also need to route all traffic to one another through Hub A, the center of
their star community

n Spoke B needs to route all traffic outside of its star community through Hub B

A_community is the VPN community of A plus the spokes belonging to A. B_community is the VPN
community. Hubs_community is the VPN community of Hub_A and Hub_B.

Configuring VPN Routing and Access Control on Security
Management Server A

The $FWDIR/conf/vpn_route.conf file on Security Management Server 1 looks like this:

Destination Next hop router interface Install on

Spoke_B_VPN_Dom Hub_A A_Spokes

Spoke_A1_VPN_Dom Hub_A Spoke_A2
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Destination Next hop router interface Install on

Spoke_A2_VPN_Dom Hub_A Spoke _A1

Spoke_B_VPN_Dom Hub_B Hub_A

Spokes A1 and A2 are combined into the network group object "A_spokes".

The applicable rule in the Security Policy Rule Base looks like this:

Source Destination VPN Service Action

*Any *Any A_Community
B_Community
Hubs_Community

*Any Accept

Configuring VPN Routing and Access Control on Security
Management Server B

The $FWDIR/conf/vpn_route.conf file on Security Management Server 2 looks like this:

Destination Next hop router interface Install On

Spoke_A1_VPN_Dom Hub_B Spoke_B

Spoke_A2_VPN_Dom Hub_B Spoke_B

Spoke_A1_VPN_Dom Hub_A Hub_B

Spoke_A2_VPN_Dom Hub_A Hub_B

The applicable rule in the Security Policy Rule Base looks like this:

Source Destination VPN Service Action

*Any *Any B_Community
A_Community
Hubs_Community

*Any Accept

For both $FWDIR/conf/vpn_route.conf files:

n "A_Community" is a star VPN community comprised of Hub_A, Spoke_A1, and Spoke_A2

n "B_Community" is a star VPN community comprised of Hub_B and Spoke_B
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n "Hubs-Community" is a meshed VPN community comprised of Hub_A and Hub_B (it could
also be a star community with the central Security Gateways meshed).

VPN with One or More LSM Profiles
You can configure a VPN star community between two SmartLSM Profiles. The procedures below
show a SmartLSM Gateway Profile and SmartLSM Cluster Profile. You can also configure the
community with two SmartLSM Cluster Profiles or two SmartLSM Gateway Profiles. All included
SmartLSM Gateways and Cluster Profiles must have the IPsec VPN blade enabled.

The procedure requires configuration in:

n SmartConsole

n Security Management Server CLI

n SmartProvisioning SmartConsole

n Center Gateway CLI
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Route Based VPN
Overview of Route-based VPN
The use of VPN Tunnel Interfaces (VTI) is based on the idea that setting up a VTI between peer
Security Gateways is similar to connecting them directly.

A VTI is an operating system level virtual interface that can be used as a Security Gateway to the
VPN domain of the peer Security Gateway. Each VTI is associated with a single tunnel to a Security
Gateway. The tunnel itself with all of its properties is defined, as before, by a VPN Community
linking the two Security Gateways. Configure the peer Security Gateway with a corresponding VTI.
The native IP routing mechanism on each Security Gateway can then direct traffic into the tunnel
as it would for other interfaces.

All traffic destined to the VPN domain of a peer Security Gateway is routed through the
"associated" VTI. This infrastructure allows dynamic routing protocols to use VTIs. A dynamic
routing protocol daemon running on the Security Gateway can exchange routing information with
a neighboring routing daemon running on the other end of an IPsec tunnel, which appears to be
a single hop away.

Route Based VPN can only be implemented between two Security Gateways within the same
community.

To deploy Route Based VPN, Directional Rules have to be configured in the Rule Base of the
Security Management Server. See "Directional Enforcement within a Community" on page 153

VPN Tunnel Interface (VTI)
A VPN Tunnel Interface is a virtual interface on a Security Gateway that is related to a VPN tunnel
and connects to a remote peer. You create a VTI on each Security Gateway that connects to the VTI
on a remote peer. Traffic routed from the local Security Gateway via the VTI is transferred
encrypted to the associated peer Security Gateway.
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In this scenario:

n There is a VTI connecting Cluster GWA and GWb

n There is a VTI connecting Cluster GWA and GWc

n There is a VTI connecting GWb and GWc

A virtual interface behaves like a point-to-point interface directly connected to the remote peer.
Traffic between network hosts is routed into the VPN tunnel with the IP routing mechanism of the
Operating System. Security Gateway objects are still required, as well as VPN communities (and
access control policies) to define which tunnels are available. However, VPN encryption domains
for each peer Security Gateway are no longer necessary. The decision whether or not to encrypt
depends on whether the traffic is routed through a virtual interface. The routing changes
dynamically if a dynamic routing protocol (OSPF/BGP) is available on the network.

When a connection that originates on GWb is routed through a VTI to GWc (or servers behind
GWc) and is accepted by the implied rules, the connection leaves GWb in the clear with the local
IP address of the VTI as the source IP address. If this IP address is not routable, return packets will
be lost.

The solution for this issue is:

n Configure a static route on GWb that redirects packets destined to GWc from being routed
through the VTI

n Not including it in any published route

n Adding route maps that filter out GWc's IP addresses

Having excluded those IP addresses from route-based VPN, it is still possible to have other
connections encrypted to those addresses (i.e. when not passing on implied rules) by using
domain based VPN definitions.

The VTI can be configured in two ways:
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n Numbered

n Unnumbered

Numbered VTI
You configure a local and remote IP address for each numbered VPN Tunnel Interface (VTI). For
each Security Gateway, you configure a local IP address, a remote address, and the local IP
address source for outbound connections to the tunnel. The remote IP address must be the local
IP address on the remote peer Security Gateway. More than one VTI can use the same IP Address,
but they cannot use an existing physical interface IP address.

Unnumbered VTI
For unnumbered VTIs, you define a proxy interface for each Security Gateway. Each Security
Gateway uses the proxy interface IP address as the source for outbound traffic. Unnumbered
interfaces let you assign and manage one IP address for each interface. Proxy interfaces can be
physical or loopback interfaces.

Using Dynamic Routing Protocols
VTIs allow the ability to use Dynamic Routing Protocols to exchange routing information between
Security Gateways. The Dynamic Routing Protocols supported on Gaia are:

n BGP4

n OSPFv2

n RIPv1

n RIPv2

Configuring Numbered VTIs
Route Based VPN can only be implemented between two Security Gateways within the same
community.

Enabling Route Based VPN
If you configure a Security Gateway for Domain Based VPN and Route Based VPN, Domain Based
VPN takes precedence by default. To force Route Based VPN to take priority, you must create a
dummy (empty) group and assign it to the VPN domain.
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To force Route-Based VPN to take priority:

1. In SmartConsole, from the left navigation panel, click Gateways & Servers.

2. Open the Security Gateway / Cluster object.

3. From the left tree, click Network Management > VPN Domain.

4. Select Manually define.

5. Click the [...] button.

6. Click New > Group > Simple Group.

7. Enter a Name.

8. Click OK (leave this Group object empty).

Configuring Numbered VTIs
With the new VPN Command Line Interface (VPN Shell), the administrator creates a VPN Tunnel
Interface on the enforcement module for each peer Security Gateway, and "associates" the
interface with a peer Security Gateway. The VPN Tunnel Interface may be numbered or
unnumbered. For more information on the VPN Shell, see VPN Shell.

Every numbered VTI is assigned a local IP Address and a remote IP Address. Prior to configuration,
a range of IP Addresses must be configured to assign to the VTIs.

The gateways in this scenario are:

Device Type Specific Computers

ClusterXL Cluster GWA:

n member_
GWA1

n member_
GWA2
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Device Type Specific Computers

VPN peers n GWb
n GWc

VTIs connect these gateways:

n Cluster GWA members and GWb

n Cluster GWA members and GWc

n GWb and GWc

IP Configurations:

Device Type of IP Address and Interface IP Address / Netmask

Cluster GWA - External Unique IP address of eth0 170.170.1.1/24

member_GWA1 External VIP address of eth0 170.170.1.10/24

IP address of Sync interface eth1 5.5.5.1/24

IP address of VTI vt-GWb Local: 10.0.1.11, Remote: 10.0.0.2

VIP address of VTI vt-GWb 10.0.1.10

IP address of VTI vt-GWc Local: 10.0.1.21, Remote: 10.0.0.3

VIP address of VTI vt-GWc 10.0.1.20

Cluster GWA - External Unique IP address of eth0 170.170.1.2/24

member_GWA2 External VIP address of eth0 170.170.1.10/24

IP address of Sync interface eth1 5.5.5.2/24

IP address of VTI vt-GWb Local: 10.0.1.12, Remote: 10.0.0.2

VIP address of VTI vt-GWb 10.0.1.10

IP address of VTI vt-GWc Local: 10.0.1.22, Remote: 10.0.0.3

VIP address of VTI vt-GWc 10.0.1.20

GWb External Unique IP address of eth0 180.180.1.1/24

IP address of VTI vt-ClusterGWa Local: 10.0.0.2, Remote: 10.0.1.10
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Device Type of IP Address and Interface IP Address / Netmask

IP address of VTI vt-GWc Local: 10.0.0.2, Remote: 10.0.0.3

GWc External Unique IP address of eth0 190.190.1.1/24

IP address of VTI vt-ClusterGWa Local: 10.0.0.3, Remote: 10.0.1.20

IP address of VTI vt-GWb Local: 10.0.0.3, Remote: 10.0.0.2

VTIs in a Clustered Environment
When configuring numbered VTIs in a clustered environment, a number of issues need to be
considered:

n Each member must have a unique source IP address.

n Every interface on each member requires a unique IP address.

n All VTIs going to the same remote peer must have the same name.

n Cluster IP addresses are required.

Configuring VTIs in a Clustered
Environment
The following sample configurations use the same Security Gateway names and IP addresses
used in Numbered VTIs.

When configuring a VTI in a clustered environment and an interface name is not specified, a
name is provided. The default name for a VTI is "vt-[Name of peer Security Gateway]".
For example, if the peer Security Gateway's name is "GW_2", the default name of the VTI is "vt-
GW_2". For peer Security Gateways that have names that are longer than 12 characters, the
default interface name is the last five characters plus a 7 byte hash of the peer name calculated
to the give the interface a unique name.

1. Configuring member_GWA1

a. Access the VPN shell Command Line Interface:

[Expert@member_GWa1]# vpn shell
? - This help
.. - Go up one level
quit - Quit
[interface ] - Manipulate tunnel interfaces
[show ] - Show internal data
[tunnels ] - Manipulate tunnel data
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b. Add vt-GWb:

VPN shell:[/] > /interface/add/numbered 10.0.1.12 10.0.0.2 GWb
Interface 'vt-GWb' was added successfully to the system

c. Add vt-GWc:

VPN shell:[/] > /interface/add/numbered 10.0.1.22 10.0.0.3 GWc
Interface 'vt-GWc' was added successfully to the system

d. Verify configuration in the VPN shell:

VPN shell:[/] > /show/interface/detailed all
vt-GWb Type:numbered MTU:1500

inet addr:10.0.1.12 P-t-P:10.0.0.2 Mask:255.255.255.255
Peer:GWb Peer ID:180.180.1.1 Status:attached

vt-GWc Type:numbered MTU:1500
inet addr:10.0.1.22 P-t-P:10.0.0.3 Mask:255.255.255.255
Peer:GWc Peer ID:190.190.1.1 Status:attached

e. Exit the VPN shell Command Line Interface:

VPN shell:[/] > /quit

f. Verify configuration in Gaia OS:

[Expert@member_GWa1]# ifconfig vt-GWb
vt-GWb Link encap:IPIP Tunnel HWaddr

inet addr:10.0.1.12 P-t-P:10.0.0.2 Mask:255.255.255.255
UP POINTOPOINT RUNNING NOARP MULTICAST MTU:1500 Metric:1
RX packets:0 errors:0 dropped:0 overruns:0 frame:0
TX packets:1 errors:0 dropped:0 overruns:0 carrier:0
collisions:0 txqueuelen:0
RX bytes:0 (0.0 b) TX bytes:36 (36.0 b)

[Expert@member_GWa1]#
[Expert@member_GWa1]# ifconfig vt-GWc
vt-GWc Link encap:IPIP Tunnel HWaddr

inet addr:10.0.1.22 P-t-P:10.0.0.3 Mask:255.255.255.255
UP POINTOPOINT RUNNING NOARP MULTICAST MTU:1500 Metric:1
RX packets:0 errors:0 dropped:0 overruns:0 frame:0
TX packets:1 errors:0 dropped:0 overruns:0 carrier:0
collisions:0 txqueuelen:0
RX bytes:0 (0.0 b) TX bytes:36 (36.0 b)

[Expert@member_GWa1]#

2. Configuring member_GWA2

a. Access the VPN shell Command Line Interface:

[Expert@member_GWa2]# vpn shell
? - This help
.. - Go up one level
quit - Quit
[interface ] - Manipulate tunnel interfaces
[show ] - Show internal data
[tunnels ] - Manipulate tunnel data
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b. Add vt-GWb:

VPN shell:[/] > /interface/add/numbered 10.0.1.12 10.0.0.2 GWb
Interface 'vt-GWb' was added successfully to the system

c. Add vt-GWc:

VPN shell:[/] > /interface/add/numbered 10.0.1.22 10.0.0.3 GWc
Interface 'vt-GWc' was added successfully to the system

d. Verify configuration in the VPN shell:

VPN shell:[/] > /show/interface/detailed all
vt-GWb Type:numbered MTU:1500

inet addr:10.0.1.12 P-t-P:10.0.0.2 Mask:255.255.255.255
Peer:GWb Peer ID:180.180.1.1 Status:attached

vt-GWc Type:numbered MTU:1500
inet addr:10.0.1.22 P-t-P:10.0.0.3 Mask:255.255.255.255
Peer:GWc Peer ID:190.190.1.1 Status:attached

e. Exit the VPN shell Command Line Interface:

VPN shell:[/] > /quit

f. Verify configuration in Gaia OS:

[Expert@member_GWa2]# ifconfig vt-GWb
vt-GWb Link encap:IPIP Tunnel HWaddr

inet addr:10.0.1.12 P-t-P:10.0.0.2 Mask:255.255.255.255
UP POINTOPOINT RUNNING NOARP MULTICAST MTU:1500 Metric:1
RX packets:0 errors:0 dropped:0 overruns:0 frame:0
TX packets:1 errors:0 dropped:0 overruns:0 carrier:0
collisions:0 txqueuelen:0
RX bytes:0 (0.0 b) TX bytes:36 (36.0 b)

[Expert@member_GWa2]#
[Expert@member_GWa2]# ifconfig vt-GWc
vt-GWc Link encap:IPIP Tunnel HWaddr

inet addr:10.0.1.22 P-t-P:10.0.0.3 Mask:255.255.255.255
UP POINTOPOINT RUNNING NOARP MULTICAST MTU:1500 Metric:1
RX packets:0 errors:0 dropped:0 overruns:0 frame:0
TX packets:1 errors:0 dropped:0 overruns:0 carrier:0
collisions:0 txqueuelen:0
RX bytes:0 (0.0 b) TX bytes:36 (36.0 b)

[Expert@member_GWa2]#

3. Configuring in SmartConsole

After configuring the VTIs on the cluster members, you must configure in the
SmartConsole the VIP of these VTIs.
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a. In the Gateways & Servers view, edit the Check Point Cluster.

b. In Network Management window, click Get Interfaces.

The VTIs are shown in the Topology column as Point to point.

Interfaces are members of the same VTI if these criteria match:

n Remote peer name

n Remote IP address

n Interface name

c. Configure the VTI VIP. Select the interface and click Edit. Edit the interface in the
General page of the interface object.

d. Click OK.

e. Install the Access Control Policy.

4. Configuring GWb

a. Access the VPN shell Command Line Interface:

[Expert@GWb]# vpn shell
? - This help
.. - Go up one level
quit - Quit
[interface ] - Manipulate tunnel interfaces
[show ] - Show internal data
[tunnels ] - Manipulate tunnel data

b. Add vt-GWa:

VPN shell:[/] > /interface/add/numbered 10.0.1.2 10.0.1.10 GWa
Interface 'vt-GWa' was added successfully to the system

c. Add vt-GWc:

VPN shell:[/] > /interface/add/numbered 10.0.0.2 10.0.0.3 GWc
Interface 'vt-GWc' was added successfully to the system

d. Verify configuration in the VPN shell:

VPN shell:[/] > /show/interface/detailed all
vt-GWa Type:numbered MTU:1500

inet addr:10.0.0.2 P-t-P:10.0.1.10 Mask:255.255.255.255
Peer:GWb Peer ID:170.170.1.10 Status:attached

vt-GWc Type:numbered MTU:1500
inet addr:10.0.0.2 P-t-P:10.0.0.3 Mask:255.255.255.255
Peer:GWc Peer ID:190.190.1.1 Status:attached

e. Exit the VPN shell Command Line Interface:

VPN shell:[/] > /quit
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f. Verify configuration in Gaia OS:

[Expert@member_GWb]# ifconfig vt-GWa
vt-GWa Link encap:IPIP Tunnel HWaddr

inet addr:10.0.0.2 P-t-P:10.0.1.10 Mask:255.255.255.255
UP POINTOPOINT RUNNING NOARP MULTICAST MTU:1500 Metric:1
RX packets:0 errors:0 dropped:0 overruns:0 frame:0
TX packets:1 errors:0 dropped:0 overruns:0 carrier:0
collisions:0 txqueuelen:0
RX bytes:0 (0.0 b) TX bytes:36 (36.0 b)

[Expert@member_GWb]#
[Expert@member_GWb]# ifconfig vt-GWc
vt-GWc Link encap:IPIP Tunnel HWaddr

inet addr:10.0.0.2 P-t-P:10.0.0.3 Mask:255.255.255.255
UP POINTOPOINT RUNNING NOARP MULTICAST MTU:1500 Metric:1
RX packets:0 errors:0 dropped:0 overruns:0 frame:0
TX packets:1 errors:0 dropped:0 overruns:0 carrier:0
collisions:0 txqueuelen:0
RX bytes:0 (0.0 b) TX bytes:36 (36.0 b)

[Expert@member_GWb]#

5. Configuring GWC

a. Access the VPN shell Command Line Interface:

[Expert@GWc]# vpn shell
? - This help
.. - Go up one level
quit - Quit
[interface ] - Manipulate tunnel interfaces
[show ] - Show internal data
[tunnels ] - Manipulate tunnel data

b. Add vt-GWa:

VPN shell:[/] > /interface/add/numbered 10.0.0.3 10.0.1.20 GWa
Interface 'vt-GWa' was added successfully to the system

c. Add vt-GWb:

VPN shell:[/] > /interface/add/numbered 10.0.0.3 10.0.0.2 GWb
Interface 'vt-GWb' was added successfully to the system

d. Verify configuration in the VPN shell:

VPN shell:[/] > /show/interface/detailed all
vt-GWa Type:numbered MTU:1500

inet addr:10.0.0.3 P-t-P:10.0.1.20 Mask:255.255.255.255
Peer:GWb Peer ID:170.170.1.10 Status:attached

vt-GWb Type:numbered MTU:1500
inet addr:10.0.0.3 P-t-P:10.0.0.2 Mask:255.255.255.255
Peer:GWc Peer ID:180.180.1.1 Status:attached

e. Exit the VPN shell Command Line Interface:

VPN shell:[/] > /quit
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f. Verify configuration in Gaia OS:

[Expert@member_GWc]# ifconfig vt-GWa
vt-GWa Link encap:IPIP Tunnel HWaddr

inet addr:10.0.0.3 P-t-P:10.0.1.20 Mask:255.255.255.255
UP POINTOPOINT RUNNING NOARP MULTICAST MTU:1500 Metric:1
RX packets:0 errors:0 dropped:0 overruns:0 frame:0
TX packets:1 errors:0 dropped:0 overruns:0 carrier:0
collisions:0 txqueuelen:0
RX bytes:0 (0.0 b) TX bytes:36 (36.0 b)

[Expert@member_GWc]#
[Expert@member_GWc]# ifconfig vt-GWb
vt-GWb Link encap:IPIP Tunnel HWaddr

inet addr:10.0.0.3 P-t-P:10.0.0.2 Mask:255.255.255.255
UP POINTOPOINT RUNNING NOARP MULTICAST MTU:1500 Metric:1
RX packets:0 errors:0 dropped:0 overruns:0 frame:0
TX packets:1 errors:0 dropped:0 overruns:0 carrier:0
collisions:0 txqueuelen:0
RX bytes:0 (0.0 b) TX bytes:36 (36.0 b)

[Expert@member_GWc]#

Enabling Dynamic Routing Protocols on
VTIs
Example:

The following tables illustrate how the OSPF dynamic routing protocol is enabled on VTIs both for
single members and for cluster members. Note that the network commands for single members
and cluster members are not the same.

For more information on VTIs and advanced routing commands, see the:

n R80.40 Gaia Administration Guide.

n R80.40 Gaia Advanced Routing Administration Guide.

When peering with a Cisco GRE enabled device, a point to point GRE tunnel is required.

Use the following commands to configure the tunnel interface definition:

https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_Gaia_AdminGuide/Default.htm
https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_Gaia_Advanced_Routing_AdminGuide/Default.htm
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Dynamic Routing on member_GWA1

member_GWA1:0> set ospf area 0.0.0.0 on
member_GWA1:0> set router-id 170.170.1.10
member_GWA1:0> set ospf interface vt-GWb area 0.0.0.0 on
member_GWA1:0> set ospf interface vt-GWc area 0.0.0.0 on
member_GWA1:0> set route-redistribution to ospf2 from kernel all-ipv4-routes on
member_GWA1:0> save config
member_GWA1:0> show configuration ospf

Dynamic Routing on member_GWA2

member_GWA2:0> set ospf area 0.0.0.0 on
member_GWA2:0> set router-id 170.170.1.10
member_GWA2:0> set ospf interface vt-GWb area 0.0.0.0 on
member_GWA2:0> set ospf interface vt-GWc area 0.0.0.0 on
member_GWA2:0> set route-redistribution to ospf2 from kernel all-ipv4-routes on
member_GWA2:0> save config
member_GWA2:0> show configuration ospf

Dynamic Routing on GWb

GWb:0> set ospf area 0.0.0.0 on
GWb:0> set router-id 180.180.1.1
GWb:0> set ospf interface vt-ClusterGWa area 0.0.0.0 on
GWb:0> set ospf interface vt-GWc area 0.0.0.0 on
GWb:0> set route-redistribution to ospf2 from kernel all-ipv4-routes on
GWb:0> save config
GWb:0> show configuration ospf

Dynamic Routing on GWc

GWc:0> set ospf area 0.0.0.0 on
GWc:0> set router-id 190.190.1.1
GWc:0> set ospf interface vt-ClusterGWa area 0.0.0.0 on
GWc:0> set ospf interface vt-GWb area 0.0.0.0 on
GWc:0> set route-redistribution to ospf2 from kernel all-ipv4-routes on
GWc:0> save config
GWc:0> show configuration ospf

Configuring VTIs
To learn how to configure VTIs, see Configuring VPN Tunnel Interfaces in the R80.40 Gaia
Administration Guide.

Note - For VTIs between Gaia gateways and Cisco GRE gateways, yu must manually configure the
Hello/Dead packet intervals at 10/40 on the Gaia gateway, or at 30/120 on the peer gateway. If not,
OSPF is not able to get into FULL state.

Configuring Anti-Spoofing on VTIs
In SmartConsole:

1. In the Gateways & Servers view, edit a Check Point Security Gateway.

2. Go to the Network Management page.

https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_Gaia_AdminGuide/Default.htm
https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_Gaia_AdminGuide/Default.htm
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3. Click Get Interfaces to read the interface information on the Security Gateway computer.

4. Select an interface, and click Edit.

5. In the Topology section of the General page, click Modify.

6. In the IP Addresses behind peer Security Gateway that are within reach of this
interface section, select:

n Not Defined to accept all traffic.

n Specific to choose a particular network. The IP addresses in this network will be the
only addresses accepted by this interface.

7. In the Perform Anti-Spoofing based on interface topology section, select Don't check
packets from to ensure Anti-Spoofing checks do not take place for addresses from certain
internal networks coming into the external interface. Define a network object that
represents those internal networks with valid addresses, and from the drop-down list,
select that network object.

Objects selected in the Don't check packets from drop-down menu are disregarded by
the Anti-Spoofing enforcement mechanism.

8. Under Spoof Tracking select Log.

9. Click OK.

Configuring Unnumbered VTIs
Working with unnumbered interfaces eliminates the need to assign two IP addresses per
interface (the local IP, and the remote IP Address), and the need to synchronize this information
among the peers.

If the VPN Tunnel Interface is unnumbered, local and remote IP addresses are not configured.
This interface is associated with a proxy interface from which the virtual interface inherits an IP
address. Traffic initiated by the Security Gateway and routed through the virtual interface will
have the physical interface's IP Address as the source IP.

To learn how to configure VTIs, see Configuring VPN Tunnel Interfaces in the R80.40 Gaia
Administration Guide.

https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_Gaia_AdminGuide/Default.htm
https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_Gaia_AdminGuide/Default.htm
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Routing Multicast Packets Through VPN
Tunnels
Multicast is used to transmit a single message to a select group of recipients. IP Multicasting
applications send one copy of each datagram (IP packet) and address it to a group of computers
that want to receive it. This technique addresses datagrams to a group of receivers (at the
multicast address) rather than to a single receiver (at a unicast address). The network is
responsible for forwarding the datagrams to only those networks that need to receive them. PIM
is required for this feature.

For more about Multicasting, see "Multicast Access Control" in the R80.40 Security Management
Administration Guide.

Multicast traffic can be encrypted and forwarded across VPN tunnels that were configured with
VPN tunnel interfaces (virtual interfaces associated with the same physical interface). All
participant Security Gateways, both on the sending and receiving ends, must have a virtual
interface for each VPN tunnel and a multicast routing protocol must be enabled on all participant
Security Gateways.

For more about virtual interfaces, see Configuring a Virtual Interface Using the VPN Shell.

To enable multicast service on a Security Gateway functioning as a rendezvous point, add a rule
to the security policy of that Security Gateway to allow only the specific multicast service to be
accepted unencrypted, and to accept all other services only through the community.
Corresponding Access Control rules enabling multicast protocols and services should be created
on all participating Security Gateways.

For example:

Source Destination VPN
Services &
Applications

Action Track

Multicast Security
Gateways

Multicast Security
Gateways

Any igmp
pim

Accept Log

Sample Host Multicast Group
Address

Sample
Community

Multicast
Service Group

Accept Log

https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_SecurityManagement_AdminGuide/Default.htm
https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_SecurityManagement_AdminGuide/Default.htm
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Large Scale VPN
A VPN that connects branch offices, worldwide partners, remote clients, and other environments,
can reach hundreds or thousands of peers. A VPN on this scale brings new challenges.

Each time a new VPN peer is deployed in production configuration and policy installation is
required for all participating VPN Gateways.

Large Scale VPN (LSV) addresses these challenges and facilitates deployment without the need for
peer configuration and policy installation.

Configuring LSV
Workflow

n Set up the Certificate Authority.
n Configure the central VPN Security Gateway.
n Create the VPN community.
n Create the LSV profile.
n Install policy.

To configure LSV:

This configuration is applied on the central VPN Gateway

1. Configuring the Certificate Authority

The CA certificate has to be supplied and saved to the disk in advance.

Note - In case of SCEP automatic enrollment, you can skip this stage and fetch the CA
certificate automatically after configuring the SCEP parameters.

The CA's Certificate must be retrieved either by downloading it with the CA options in the
Certificate Authority object, or by obtaining the CA's certificate from the peer
administrator in advance.

Define the CA object according to the following steps

a. In Object Explorer, click New > Server > More > Trusted CA or Subordinate CA.

The Certificate Authority Properties window opens.

b. Enter a Name for the CA object.
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c. On the OPSEC PKI tab:

n For automatic enrollment, select Automatically enroll certificate.

n From the Connect to CA with protocol, select the protocol used to connect
with the certificate authority, either SCEP, CMPV1 or CMPV2.

Note - For entrust 5.0 and later, use CMPV1.

d. Click Properties:

n If you chose SCEP as the protocol, in the Properties for SCEP protocol
window, enter the CA identifier (such as example.com) and the Certification
Authority/Registration Authority URL.

n If you chose CMPV1 as the protocol, in the Properties for CMP protocol - V1
window, enter the applicable IP address and port number. (The default port
is 829).

n If you chose CMPV2 as the protocol, in the Properties for CMP protocol -V2
window, decide whether to use direct TCP or HTTP as the transport layer.

Note - If Automatic enrollment is not selected, then enrollment will have to
be performed manually.

e. Choose a method for retrieving CRLs from this CA.

If the CA publishes CRLs on HTTP server choose HTTP Server(s).

Certificates issued by the CA must contain the CRL location in an URL in the CRL
Distribution Point extension.

If the CA publishes CRL on LDAP server, choose LDAP Server(s).

In this case, you must define an LDAP Account Unit as well. See the R80.40 Security
Management Administration Guide for more details about defining an LDAP object.

In the LDAP Account Unit Properties window, on the General tab, make sure to
check the CRL retrieval.

Certificates issued by the CA must contain the LDAP DN on which the CRL resides
in the CRL distribution point extension.

f. Click Get.

g. If SCEP is configured, it will try to connect to the CA and retrieve the certificate. If
not, browse to where you saved the peer CA certificate and select it.

The certificate is fetched. Verify the certificate's details. Display and validate the
SHA-1 and MD5 fingerprints of the CA certificate.

h. Click OK.

2. Configure the certificate for the central VPN Security Gateway

https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_SecurityManagement_AdminGuide/Default.htm
https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_SecurityManagement_AdminGuide/Default.htm
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The devices participating in the LSV community must all share a signed certificate from
the same Certificate Authority signed for the Central VPN Gateway.

A certificate is automatically issued by the ICA for all internally managed entities that are
VPN capable. That is, after the administrator has checked selected IPsec VPN in the
Network Security tab of the General Properties page for network objects.

The process for obtaining a certificate from an OPSEC PKI or External Check Point CA is
identical.

Manual Enrollment with OPSEC Certified PKI

To create a PKCS#10 Certificate Request

a. If a CA object is not yet configured, create the CA object.

b. Open the IPsec VPN tab of the applicable Network Object.

c. In the Certificate List field click Add.

The Certificate Properties window opens.

d. Enter the Certificate Nickname.

The nickname is only an identifier and has no bearing on the content of the
certificate.

e. From the CA to enroll from drop-down box, select the direct OPSEC CA/External
Check Point CA that will issue the certificate.

Note - The list shows only those subordinate CAs that lead directly to a trusted
CA and the trusted CAs themselves. If the CA that issues the certificate is a
subordinate CA that does not lead directly to a trusted CA, the subordinate CA
will not appear in the list.

f. Choose the applicable method for Key Pair creation and storage.

g. Click Generate.

The Generate Certificate Properties window opens.
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h. Enter the applicable DN.

The final DN that appears in the certificate is decided by the CA administrator.

If a Subject Alternate Name extension is required in the certificate, select
Define Alternate Name.

Adding the object IP address as Alternate name extension can be configured as
a default setting:

i. In SmartConsole, click Menu > Global properties > Advanced >
Configure.

ii. Click Certificates and PKI properties.

iii. Select these two options:

add_ip_alt_name_for_ICA_certs

add_ip_alt_name_for_opsec_certs

iv. Click OK.

Note - The configuration in this step is also applicable for Internal CAs.

i. Click OK.

The public key and the DN are then used to DER-encode a PKCS#10 Certificate
Request.

j. After the Certificate Request is ready, click View .

The Certificate Request View window appears with the encoding.
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k. Copy the whole text in the window and deliver it to the CA.

The CA administrator must now complete the task of issuing the certificate.
Different CAs provide different ways of doing this, such as an advanced
enrollment form (as opposed to the regular form for users). The issued
certificate may be delivered in various ways, for example email. After the
certificate has arrived, it needs to be stored:

i. In Object Explorer (Ctrl+E), go to the Servers category and select the CA
object.

ii. Open the OPEC PKI tab.

iii. Click Get.

iv. Browse to the location, in which you saved the certificate file.

v. Select the applicable file.

vi. Make sure the certificate details are correct.

vii. Close the object.

viii. Save.

Automatic Enrollment with the Certificate Authority

Configuration

On the OPSEC PKI tab of the CA object, make sure Automatically enroll certificate is
selected and SCEP or CMP are chosen as the connecting protocol. Then:

a. In the applicable network object, open the VPN tab.

b. In the Certificates List section, click Add.

The Certificate Properties window opens.

c. Enter a Certificate Nickname (any string used as an identifier)

d. From the drop-down menu, select the CA that issues the certificate.

Note - The menu shows only trusted CAs and subordinate CAs that lead directly
to a trusted CA. If the CA that issues the certificate is a subordinate CA that does
not lead directly to a trusted CA, it is not in the menu.

e. Select a method for key pair generation and storage.
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f. Click Generate, and select Automatic enrollment.

The Generate Keys and Get Automatic Enrollment Certificate window
opens.

n Supply the Key Identifier and your secret authorization code.

n Click OK.

g. When the certificate appears in the Certificates List on the network objects VPN
page, click View and either Copy to Clipboard or Save to File the text in the
Certificate Request View window.

h. Send the request to CA administrator.

Different Certificate Authorities provide different means for doing this, for
example an advanced enrollment form on their website. The issued certificate
can be delivered in various ways, such as email. Once you have received the
certificate, save it to disk.

i. On the VPN tab of the network object, select the applicable certificate in the
Certificates List, and click Complete.

j. Browse to the folder where you stored the issued certificate, select the
certificate and verify the certificate details.

k. Close the network object and Save.

Enrolling through a Subordinate CA

When enrolling through a subordinate CA:

n Supply the password of the subordinate CA which issues the certificate, not the
CA at the top of the hierarchy

n The subordinate CA must lead directly to a trusted CA

3. Create the VPN community

To create a new VPN community

a. In SmartConsole > Security Policies tab, in the Access Tools area, click VPN
Communities.

b. Click the New icon and select Star Community.

A New Star Community window opens.

c. Enter a name for the VPN Community.

d. In the Center Gateways area, click the plus icon to add one or more gateways
to be in the center of the community.
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e. In the Satellite Gateways area, click the plus icon to add one or more gateways
to be around the center gateway.

f. Click OK.

The Community uses the default encryption and VPN Routing settings.

g. Optional: Edit more settings for the VPN Community in the community object.

4. Create the LSV profile

To create the LSV Profile:

a. From the New Start Community window in the Satellite Gateways section click
the + icon > New ( ) > Large Scale VPN.

The New Large Scale VPN Profile window opens

b. Select the desired CA object

c. Optional - Configure the VPN domain for the LSV profile

You can limit the number of IP addresses used in an encryption domain of each
satellite VPN Gateway and restrict the VPN access to specific group of networks.
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Important -
n If the Encryption Domain of the LSV gateways overlaps - the same

or partial Encryption Domain is configured for 2 or more peer
devices the default behavior is to use the VPN connection of the
peer the connected last.

n This behavior is configured using the lsv_prefer_new_peer

kernel parameter. The default value is 1
5. Install policy.

Monitoring LSV Peers and Tunnels
To monitor the LSV Peers

1. You can monitor LSV peers on a Security Gateway with the vpn lsv command.

2. From the Security Gateway command line, run: vpn lsv

Select an option.
********** Select Option **********
(1) List all LSV peers
(2) Show LSV peer's details
(3) Remove an LSV peer
(4) Remove all LSV peers
(Q) Quit
*******************************************

Limitations
The below is not supported with LSV

n IPv6

n Route based VPN (VTI). For more information, see "Route Based VPN" on page 108.

n 2 peers behind the same NAT device.

n Suite B - 128, 256 is not supported with IKEv1 only suite B with changing global
properties of phase 1 of Remote Access VPN.

n Multi hubs. For more information, see "Configuring Multiple Hubs" on page 105.

n RIM.

n IKE aggressive mode. For more information, see "Phase I modes" on page 51.

n Permanent tunnel. For more information, see "Permanent Tunnels" on page 131.

n MEP. For more information, see "Multiple Entry Point (MEP) VPNs" on page 158.

n DPD (Dead Peer Detection).
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n Global VPN Community (GVC).
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Tunnel Management
Overview of Tunnel Management
The VPN tunnel transports data securely. You can manage the types of tunnels and the number of
tunnels with these features:

n Permanent Tunnels - Keeps VPN tunnels active to allow real-time monitoring capabilities.

n VPN Tunnel Sharing - Provides greater interoperability and scalability between Security
Gateways. It also controls the number of VPN tunnels created between peer Security
Gateways.

See the status of all VPN tunnels in SmartView Monitor. For details see Monitoring Tunnels in the
R80.40 Logging and Monitoring Administration Guide.

Permanent Tunnels
As companies have become more dependent on VPNs for communication to other sites,
uninterrupted connectivity has become more crucial than ever before. Therefore it is essential to
make sure that the VPN tunnels are kept up and running. Permanent Tunnels are constantly kept
active and as a result, make it easier to recognize malfunctions and connectivity problems.
Administrators can monitor the two sides of a VPN tunnel and identify problems without delay.

Each VPN tunnel in the community may be set to be a Permanent Tunnel. Since Permanent
Tunnels are constantly monitored, if the VPN tunnel is down, then a log, alert, or user defined
action, can be issued. A VPN tunnel is monitored by periodically sending "tunnel test" packets. As
long as responses to the packets are received the VPN tunnel is considered "up." If no response is
received within a given time period, the VPN tunnel is considered "down." Permanent Tunnels can
only be established between Check Point Security Gateways. The configuration of Permanent
Tunnels takes place on the community level and:

n Can be specified for an entire community. This option sets every VPN tunnel in the
community as permanent.

n Can be specified for a specific Security Gateway. Use this option to configure specific
Security Gateways to have permanent tunnels.

n Can be specified for a single VPN tunnel. This feature allows configuring specific tunnels
between specific Security Gateways as permanent.

https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_LoggingAndMonitoring_AdminGuide/Default.htm
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Permanent Tunnels in a MEP Environment
In a Multiple Entry Point (MEP) environment, VPN tunnels that are active are rerouted from the
predefined primary Security Gateway to the backup Security Gateway if the primary Security
Gateway becomes unavailable. When a Permanent Tunnel is configured between Security
Gateways in a MEP environment where RIM is enabled, the satellite Security Gateways see the
center Security Gateways as "unified." As a result, the connection will not fail but will fail over to
another center Security Gateway on a newly created permanent tunnel. For more information on
MEP see "Multiple Entry Point (MEP) VPNs" on page 158.

Tunnel Testing for Permanent Tunnels
Check Point uses a proprietary protocol to test if VPN tunnels are active, and supports any site-to-
site VPN configuration. Tunnel testing requires two Security Gateways, and uses UDP port 18234.
Check Point tunnel testing protocol does not support 3rd party Security Gateways.

Terminating Permanent Tunnels
Once a Permanent Tunnel is no longer required, the tunnel can be shut down. Permanent
Tunnels are shut down by deselecting the configuration options to make them active and re-
installing the policy.

Dead Peer Detection
In addition to Tunnel Testing, Dead Peer Detection (DPD) is a different method to test if VPN
tunnels are active. Dead Peer Detection does support 3rd party Security Gateways and supports
permanent tunnels with interoperable devices based on IKEv1/IKEv2 DPD (IKEv1 DPD is based on
RFC 3706). It uses IPsec traffic patterns to minimize the number of messages required to confirm
the availability of a peer.

The tunnel testing mechanism is the recommended keepalive mechanism for Check Point to
Check Point VPN gateways because it is based on IPsec traffic and requires an IPsec established
tunnel. DPD is based on IKE encryption keys only.

DPD has two modes:

n DPD responder mode - Requires an R77.10 or higher gateway managed by an R77 or
higher management server.

n Permanent tunnel mode based on DPD -Requires an R77.10 or higher gateway managed
by an R77.10 or higher management.

DPD Responder Mode

In this mode the Check Point gateway sends the IKEv1 DPD Vendor ID to peers, from which the
DPD Vendor ID was received.
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To enable DPD Responder Mode:

1. On each Security Gateway, run this command:

ckp_regedit -a SOFTWARE/CheckPoint/VPN1 forceSendDPDPayload -n 1

2. To prevent a problem, where the Check Point Security Gateway deletes IKE SAs:

Note - The DPD mechanism is based on IKE SA keys. In some situations, the Check Point
Security Gateway deletes IKE SAs, and a VPN peer, usually a 3rd Party gateway, sends DPD
requests and does not receive a response. As a result, the VPN peer concludes that the
Check Point Security Gateway is down. The VPN peer can then delete the IKE and IPsec keys,
which causes encrypted traffic from the Check Point Security Gateway to be dropped by the
remote peer.

a. In SmartConsole, click Menu > Global properties > Advanced > Configure.

b. Click VPN Advanced Properties > VPN IKE properties.

c. Select keep_IKE_SAs.

d. Click OK.

e. Install the Access Control Policy.

To disable DPD Responder Mode:

On each Security Gateway, run this command:

ckp_regedit -d SOFTWARE/CheckPoint/VPN1 forceSendDPDPayload

Permanent Tunnel Mode Based on DPD

DPD can monitor remote peers with the permanent tunnel feature. All related behavior and
configurations of permanent tunnels are supported.

To configure DPD for a permanent tunnel, the permanent tunnel must be in the VPN community.
After you configure the permanent tunnel, configure Permanent Tunnel mode Based on DPD.
There are different possibilities for permanent tunnel mode:

n tunnel_test (default) - The permanent tunnel is monitored by tunnel test (as in earlier
versions). It works between Check Point gateways only. Keepalive packets are always sent.

n dpd - The active DPD mode. A peer receives DPD requests at regular intervals (10 seconds).
DPD requests are only sent when there is no traffic from the peer.

n passive - The passive DPD mode. Peers do not send DPD requests to this peer. Tunnels with
passive peers are monitored only if there is IPsec traffic and incoming DPD requests.

Note: To use this mode for only some gateways, enable the forceSendDPDPayload
registry key on Check Point remote peers.
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To enable DPD monitoring:

On each VPN gateway in the VPN community, configure the tunnel_keepalive_method property,
in GuiDBedit Tool (see sk13009) or dbedit (see skI3301). This includes 3rd Party gateways. (You
cannot configure different monitor mechanisms for the same gateway).

1. In GuiDBedit Tool, go to Network Objects > network_objects > <gateway> > VPN.

2. For the Value, select a permanent tunnel mode.

3. Save all the changes.

4. Close the GuiDBedit Tool.

5. In SmartConsole, install the Access Control Policy.

Optional Configuration

n IKE Initiation Prevention - By default, when a valid IKE SA is not available, a DPD request
message triggers a new IKE negotiation. To prevent this behavior, set the property dpd_
allowed_to_init_ike to false.

Edit the property in GuiDBedit Tool (see sk13009) > Network Objects > network_objects >
<gateway Name> > VPN.

n Delete IKE SAs for dead peer - Based on RFC 3706, a VPN gateway has to delete IKE SAs
from a dead peer. This functionality is enabled, by default.

To disable this feature, set the DPD_DONT_DEL_SA environment variable to 0:

l To do this temporarily, run:

cpstop

export DPD_DONT_DEL_SA=0

cpstart

l To do this permanently:

Add this line to the $CPDIR/tmp/.CPprofile.sh file and then reboot:

DPD_DONT_DEL_SA=0 ; export DPD_DONT_DEL_SA

To re-enable the feature:

l Temporarily:

cpstop

export DPD_DONT_DEL_SA=0

cpstart

http://supportcontent.checkpoint.com/solutions?id=sk13009
http://supportcontent.checkpoint.com/solutions?id=skI3301
http://supportcontent.checkpoint.com/solutions?id=sk13009
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l Permanently:

Remove the DPD_DONT_DEL_SA line from the $CPDIR/tmp/.CPprofile.sh file
and then reboot.

VPN Tunnel Sharing
For a VPN community, the VPN tunnel sharing configuration is set on the Tunnel Management
page of the Community Properties window.

For a specific Security Gateway, the configuration is set on the VPN Advanced page of the
Security Gateway properties window.

VPN Tunnel Sharing provides greater interoperability and scalability by controlling the number of
VPN tunnels created between peer Security Gateways. Configuration of VPN Tunnel Sharing can
be set on both the VPN community and Security Gateway object.

n One VPN Tunnel per each pair of hosts - A VPN tunnel is created for every session
initiated between every pair of hosts.

n One VPN Tunnel per subnet pair - Once a VPN tunnel has been opened between two
subnets, subsequent sessions between the same subnets will share the same VPN tunnel.
This is the default setting and is compliant with the IPsec industry standard.

n One VPN Tunnel per Security Gateway pair - One VPN tunnel is created between peer
Security Gateways and shared by all hosts behind each peer Security Gateway.

In case of a conflict between the tunnel properties of a VPN community and a Security Gateway
object that is a member of that same community, the "stricter" setting is followed. For example, a
Security Gateway that was set to One VPN Tunnel per each pair of hosts and a community that
was set to One VPN Tunnel per subnet pair, would follow One VPN Tunnel per each pair of
hosts.

Tunnel test is a proprietary Check Point protocol used to see if VPN tunnels are active. Tunnel
testing requires two Security Gateways and uses UDP port 18234. Third party gateways do not
support tunnel testing.

Configuring Tunnel Features

To configure Tunnel Management options:

1. In SmartConsole, click Object Explorer (Ctrl+E)

2. Click New > VPN Community and choose Star Community or Meshed community.

3. Click Tunnel Management. and configure the tunnel settings:
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n Permanent Tunnels

n Tracking Options

n VPN Tunnel Sharing

Permanent Tunnels
In the Star Community or Meshed community object, on the Tunnel Management page,
select Set Permanent Tunnels.

These are the options:

n On all tunnels in the community

n On all tunnels of specific Security Gateways

n On specific tunnels in the community

To configure all tunnels as permanent, select On all tunnels in the community. Clear this
option to terminate all Permanent Tunnels in the community.

To configure on all tunnels of specific Security Gateways:

1. Select On all tunnels of specific gateways and click Select Gateways.

The Select Gateway window opens.

To terminate Permanent Tunnels connected to a specific Security Gateway, select the
Security Gateway object and click Remove.

2. To configure the Tracking options for a specific Security Gateway, select a Security Gateway
object and click Gateway Tunnel Properties.

To configure on specific tunnels in the community:

1. Select On specific tunnels in the community and click Select Permanent Tunnels.

The Select Permanent Tunnels window opens.

2. Double click in the white cell that intersects the Security Gateways where a permanent
tunnel is required.

The Tunnel Properties window opens.

3. Click Set these tunnels to be permanent tunnels.

To terminate the Permanent Tunnel between these two Security Gateways, clear Set these
tunnels to be permanent tunnels.

4. Click OK.



Glossary

Site to Site VPN R80.40 Administration Guide      |      137

Advanced Permanent Tunnel Configuration

In SmartConsole:

1. Click Menu > Global properties.

2. Click Advanced > Configure.

3. Click VPN Advanced Properties > Tunnel Management to see the five attributes that
may be configured to customize the amount of tunnel tests sent and the intervals in which
they are sent:

n life_sign_timeout - Set the amount of time the tunnel test or DPD runs without a
response before the peer host is declared 'down.'

n life_sign_transmitter_interval - Set the time between tunnel tests or DPD.

n life_sign_retransmissions_count - When a tunnel test does not receive a reply,
another test is resent to confirm that the peer is 'down.' The Life Sign Retransmission
Count is set to how many times the tunnel test is resent without receiving a response.

n life_sign_retransmissions_interval - Set the time between the tunnel tests that are
resent after it does not receive a response from the peer.

n cluster_status_polling_interval - (applicable for High Availability Clusters only) - Set
the time between tunnel tests between a primary Security Gateway and a backup
Security Gateway. The tunnel test is sent by the backup Security Gateway. When there
is no reply, the backup Security Gateway will become active.

4. Click OK.

5. If you changed the existing setting, them install the Access Control Policy.

Tracking Options
You can configure alerts to stay updated on the status of permanent VPN tunnels.

To configure logs and alerts for VPN tunnel status:

1. In the properties of the VPN Community, open the Tunnel Management page.

2. In Tunnel down track , select the alert when a tunnel is down.

3. In Tunnel up track , select the alert when a tunnel is up.

The alerts are configured for the tunnels that are defined as permanent, based on the
settings on the page.

See status of all VPN tunnels in SmartView Monitor.
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To open SmartView Monitor:

1. In SmartConsole, click Logs & Monitor.

2. Click New Tab.

3. From the bottom of this page, click Tunnel & User Monitoring.

For more details, see Monitoring Tunnels in the R80.40 Logging and Monitoring Administration Guide.

https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_LoggingAndMonitoring_AdminGuide/Default.htm
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Route Injection Mechanism
Overview of Route Injection
Route Injection Mechanism (RIM) enables a Security Gateway to use dynamic routing protocols to
propagate the encryption domain of a VPN peer Security Gateway to the internal network and
then initiate back connections. When a VPN tunnel is created, RIM updates the local routing table
of the Security Gateway to include the encryption domain of the VPN peer.

Note - Route Injection is not currently supported for IPv6.

RIM can only be enabled when permanent tunnels are configured for the community. Permanent
tunnels are kept alive by tunnel test packets. When a Security Gateway fails to reply, the tunnel
will be considered 'down.' As a result, RIM will delete the route to the failed link from the local
routing table, which triggers neighboring dynamic routing enabled devices to update their
routing information accordingly. This will result in a redirection of all traffic destined to travel
across the VPN tunnel, to a pre-defined alternative path.

There are two possible methods to configure RIM:

n Automatic RIM - RIM automatically injects the route to the encryption domain of the peer
Security Gateways.

n Custom Script - Specify tasks for RIM to perform according to specific needs.

Route injection can be integrated with MEP functionality (which route return packets back
through the same MEP Security Gateway). For more information on MEP, see "Multiple Entry Point
(MEP) VPNs" on page 158.

Automatic RIM
Automatic RIM can be enabled in the Gaia Portal. Although you can use a custom script, no
custom-written scripts are required.

In this scenario:
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n Security Gateways 1 and 2 are both RIM and have a dynamic routing protocol enabled.

n R1 and R4 are enabled routers.

n When a VPN tunnel is created, RIM updates the local routing tables of Security Gateway 1
and Security Gateway 2 to include the encryption domain of the other Security Gateway.

n Should the VPN tunnel become unavailable, traffic is redirected to the leased line.

The routing tables for the Security Gateways and routers read as follows. Entries in bold
represent routes injected into the Security Gateways local routing tables by RIM:

For Security Gateway 1:

Destination Netmask Security Gateway Metric

0.0.0.0 0.0.0.0 172.16.10.2 1

192.168.21.0 255.255.255.0 172.16.10.2 1

192.168.11.0 255.255.255.0 192.168.10.1 1

Security Gateway 2:

Destination Netmask Security Gateway Metric

0.0.0.0 0.0.0.0 172.16.20.2 1

192.168.11.0 255.255.255.0 172.16.20.2 1

192.168.21.0 255.255.255.0 192.168.20.1 1

R1 (behind Security Gateway 1):

Destination Netmask Security Gateway Metric

0.0.0.0 0.0.0.0 192.168.10.2 1

192.168.21.0 255.255.255.0 192.168.10.2 1

192.168.21.0 255.255.255.0 10.10.10.2 2
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R4 (behind Security Gateway 2):

Destination Netmask Security Gateway Metric

0.0.0.0 0.0.0.0 192.168.20.2 1

192.168.11.0 255.255.255.0 192.168.20.2 1

192.168.11.0 255.255.255.0 10.10.10.1 2

Custom Scripts
Custom scripts can be run on any Security Gateway in the community. These scripts are executed
whenever a tunnel changes its state, i.e. goes "up" or "down." Such an event, for example, can be
the trigger that initiates a dial-up connection.

A script template custom_rim (with a .sh or .bat extension depending on the operating system) is
provided in the $FWDIR/Scripts directory.

Sample customized script:

#!/bin/sh

# This script is invoked each time a tunnel is configured with the RIM option
# and the tunnel changed state.
#
# You may add your custom commands to be invoked here.

# Parameters read from command line.
RIM_PEER_Security Gateway=$1
RIM_NEW_STATE=$2
RIM_HA_STATE=$3
RIM_FIRST_TIME=$4
RIM_PEER_ENC_NET=$5

case "${RIM_NEW_STATE}" in
up)

# Place your action for tunnels that came up
;;

down)
# Place your action for tunnel that went down
;;

esac

Where:

n RIM_PEER_Security Gateway: Peer Security Gateway

n RIM_NEW_STATE: Change in the state of the Security Gateway, i.e. up or down.

n RIM_HA_STATE: State of a single Security Gateway in a cluster (i.e., standby or active).

n RIM_FIRST_TIME: The script is executed separately for each network within the peer's
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encryption domain. Although the script might be executed multiple times on a peer, this
parameter will only be transferred to the script with the value of '1' the first time the script
runs on the peer. The value '1' indicates that this is the first time this script is being
executed. The next time the script is executed, it is transferred with the value of '0' and the
parameter is disregarded. For example, you may send an email alert to the system
administrator the moment a tunnel goes down.

n RIM_PEER_ENC_NET: VPN domain of the VPN peer.

Injecting Peer Security Gateway Interfaces
You can inject the IP addresses of the peer Security Gateway into the routing tables, in addition to
the networks behind the Security Gateway.

For example, after a VPN tunnel is created, RIM injects into the local routing tables of both
Security Gateways, the encryption domain of the peer Security Gateway. However, when RIM
enabled Security Gateways communicate with a Security Gateway that has Hide NAT enabled, the
peer's interfaces need to be injected as well.

In this scenario:

n Security Gateways A and B are both RIM enabled and Security Gateway C has Hide NAT
enabled on the external interface ("hiding" all the IP addresses behind it).

n Host 1, behind Security Gateway C, initiates a VPN tunnel with Host 2, through Security
Gateway A.

n Router 3 holds routes to all the hosts behind Security Gateway C. Router 3 however, does
not have the Hide NAT IP address of Security Gateway C and as a result, cannot properly
route packets back to host 1.

This solution for routing the packets back properly is two-fold:
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1. In SmartConsole:

a. Click Menu > Global properties.

b. Click VPN Advanced Properties > Tunnel Management.

c. Select RIM_inject_peer_interfaces. This injects router 3 with all of the IP addresses
of Security Gateway C including the Hide NAT address.

d. Click OK.

e. Install the Access Control Policy.

2. Configure the router not to propagate the information injected to other Security Gateways.
If the router is not configured properly, using the previous example, could result in Security
Gateway B routing traffic to Security Gateway C through Security Gateway A.

Configuring RIM

Configuring RIM in a Star Community
1. In SmartConsole, click Objects menu > Object Explorer (or press Ctrl E).

2. From the left tree, select VPN Communities.

3. Open the applicable Star Community object.

4. From the left tree, click Tunnel Management.

5. In the Permanent Tunnels section, select Set Permanent Tunnels.

The following "Permanent Tunnels" on page 131 modes are then made available:

n On all tunnels in the community

n On all tunnels of specific Security Gateways

n On specific tunnels in the community

Note - When choosing tunnels, keep in mind that RIM can only be enabled on tunnels that
have been configured to be permanent. You must select On all tunnels in the
community, if MEP is enabled on the community. See "Configuring Tunnel Features" on
page 135

6. Select Enable Route Injection Mechanism (RIM).

7. Click Settings.

The Star Community Settings window opens.

In the Community section:
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n Enable automatic Route Injection Mechanism - RIM runs automatically on the
central or satellite Security Gateways.

n Enable customer editable script execution - A customized script runs on central or
satellite Security Gateways whenever a tunnel changes its states (goes up or down).

In the Tracking section:

n Configure the applicable tracking options:

Log, Popup Alert, Mail Alert, SNMP Trap Alert, User Defined Alert

8. Click OK to close all configuration windows.

9. Close the Object Explorer.

10. Install the Access Control Policy.

11. If you selected Enable customer editable script execution, then you must edit the
$FWDIR/scripts/custom_rim.sh script on each of the Security Gateways.

Configuring RIM in a Meshed Community
1. In SmartConsole, click Objects menu > Object Explorer (or press Ctrl E).

2. From the left tree, select VPN Communities.

3. Open the applicable Meshed Community object.

4. From the left tree, click Tunnel Management.

5. In the Permanent Tunnels section, select Set Permanent Tunnels.

The following "Permanent Tunnels" on page 131 modes are then made available:

n On all tunnels in the community

n On all tunnels of specific Security Gateways

n On specific tunnels in the community

Note - When choosing tunnels, keep in mind that RIM can only be enabled on tunnels that
have been configured to be permanent. You must select On all tunnels in the
community, if MEP is enabled on the community. See "Configuring Tunnel Features" on
page 135.

6. Select Enable Route Injection Mechanism (RIM).

7. Click Settings.

The Meshed Community Settings window opens.

In the Community section:
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n Enable automatic Route Injection Mechanism - RIM runs automatically on the
central or satellite Security Gateways.

n Enable customer editable script execution - A customized script runs on central or
satellite Security Gateways whenever a tunnel changes its states (goes up or down).

In the Tracking section:

n Configure the applicable tracking options:

Log, Popup Alert, Mail Alert, SNMP Trap Alert, User Defined Alert

8. Click OK to close all configuration windows.

9. Close the Object Explorer.

10. Install the Access Control Policy.

11. If you selected Enable customer editable script execution, then you must edit the
$FWDIR/scripts/custom_rim.sh script on each of the Security Gateways.

Enabling the RIM_inject_peer_interfaces flag

To enable the RIM_inject_peer_interfaces flag:

1. In SmartConsole, click Menu > Global properties.

2. Click Advanced > Configure.

3. Click VPN Advanced Properties > Tunnel Management.

4. Select RIM_inject_peer_interfaces.

5. Click OK.

6. Install the Access Control Policy.

Configuring RIM on Gaia
In Gaia OS, the Route Injection Mechanism adds routes directly to the kernel. For the routes to
remain in the Kernel, you must configure this option.

To set kernel routes in Gaia Clish, run these commands:

1. set kernel-routes on

2. save config
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To set kernel routes in Gaia Portal:

1. In the tree view, click Advanced Routing > Routing Options.

2. In the Kernel Options area, select the Kernel Routes option.

3. Click Apply.

Gaia Gateways in a Star VPN Community

For RIM to work, the Gaia gateways in a star VPN community must publish the routes of the
satellite networks to the router.

For Gaia gateways to publish routes, run these CLI commands on all gateways at the center of the
community.

For more information, see the R80.40 Gaia Advanced Routing Administration Guide.

1. set routemap <Routemap Name> id <ID Number>

For example:

set routemap RIM id 5

2. set routemap <Routemap Name> id <ID Number> match protocol kernel

For example:

set routemap RIM id 5 match protocol kernel

3. set ospf export-routemap <Routemap Name> preference 1 on

For example:

set ospf export-routemap RIM preference 1 on

4. set routemap <Routemap Name> id <ID Number> allow

For example:

set routemap RIM id 5 allow

5. set routemap <Routemap Name> id <ID Number> on

For example:

set routemap RIM2 id 10 on

6. set routemap <Routemap Name> id <ID Number> match nexthop <IP
Address of OSPF Interface of the other RIM GW> on

For example:

set routemap RIM2 id 10 match nexthop <10.16.50.3> on

7. set routemap <Routemap Name> id <ID Number> restrict

For example:

https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_Gaia_Advanced_Routing_AdminGuide/Default.htm
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set routemap RIM2 id 10 restrict

8. set ospf import-routemap <Routemap Name> preference 1 on

For example:

set ospf import-routemap RIM2 preference 1 on

9. save config
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Wire Mode
Overview of Wire Mode
The Wire Mode improves connectivity by allowing existing connections to fail over successfully by
bypassing firewall enforcement. Traffic within a VPN community is, by definition, private and
secure. In many cases, the firewall and the rule on the firewall concerning VPN connections is
unnecessary. With the Wire Mode, the firewall can be bypassed for VPN connections by defining
internal interfaces and communities as "trusted".

When a packet reaches a Security Gateway, the Security Gateway asks itself two questions
regarding the packet(s):

Is this information coming from a "trusted" source?

Is this information going to a "trusted" destination?

If the answer to both questions is yes, and the VPN Community to which both Security Gateways
belong is designated as "Wire Mode enabled," stateful inspection is not enforced and the traffic
between the trusted interfaces bypasses the firewall. Since no stateful inspection takes place, no
packets can be discarded. The VPN connection is no different from any other connection along a
dedicated wire. This is the meaning of "Wire Mode." Since stateful inspection no longer takes
place, dynamic routing protocols (which do not survive state verification in non-wire mode
configuration) can now be deployed. Wire Mode thus facilitates "Route Based VPN" on page 108.

Wire Mode Scenarios
Wire mode can be used to improve connectivity and performance in different infrastructures.
This section describes scenarios that benefit from the implementation of wire mode.

Wire Mode in a MEP Configuration
In this scenario:
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n Security Gateway M1 and Security Gateway M2 are both wire mode enabled and have
trusted internal interfaces.

n The community where Security Gateway M1 and Security Gateway M2 reside, is wire mode
enabled.

n Host 1, residing behind Security Gateway S1 is communicating through a VPN tunnel with
Host 2 residing behind Security Gateway M1.

n "Multiple Entry Point (MEP) VPNs" on page 158 is configured for Security Gateway M1 and
Security Gateway M2 with Security Gateway M1 being the primary Security Gateway and
Security Gateway M2 as the backup.

In this case, if Security Gateway M1 goes down, the connection fails over to Security Gateway M2.
A packet leaving Host 2 will be redirected by the router behind Security Gateway M1 to Security
Gateway M2 since Security Gateway M2 is designated as the backup Security Gateway. Without
wire mode, stateful inspection is enforced at Security Gateway M2 and the connection is dropped.
Packets that come into a Security Gateway whose session was initiated through a different
Security Gateway, are considered "out-of-state" packets. Since Security Gateway M2's internal
interface is "trusted," and wire mode in enabled on the community, no stateful inspection is
performed and Security Gateway M2 will successfully continue the connection without losing any
information.

Wire Mode with Route Based VPN
In this scenario:
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n Wire mode is enabled on Center Security Gateway C (without an internal trusted interface
specified).

n The community is wire mode enabled.

n Host 1 residing behind Satellite Security Gateway A wishes to open a connection through a
VPN tunnel with Host 2 behind Satellite Security Gateway B.

In a satellite community, Center Security Gateways are used to route traffic between Satellite
Security Gateways within the community.

In this case, traffic from the Satellite Security Gateways is only rerouted by Security Gateway C
and cannot pass through Security Gateway C's firewall. Therefore, stateful inspection does not
need to take place at Security Gateway C. Since wire mode is enabled on the community and on
Security Gateway C, making them trusted, stateful inspection is bypassed. Stateful inspection,
however, does take place on Security Gateways A and B.

Wire Mode Between Two VPN Communities
In this scenario:
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n Security Gateway A belongs to Community 1.

n Security Gateway B belongs to Community 2.

n Security Gateway C belongs to Communities 1 and 2.

n Wire mode is enabled on Center Security Gateway C (without an internal trusted interface
specified).

n Wire mode is enabled on both communities.

n Host 1 residing behind Satellite Security Gateway A wishes to open a connection through a
VPN tunnel with Host 2 behind Satellite Security Gateway B.

Wire mode can also be enabled for routing VPN traffic between two Security Gateways which are
not members of the same community. Security Gateway C is a member of both communities and
therefore recognizes both communities as trusted. When host 1 behind Security Gateway A
initiates a connection to host 2 behind Security Gateway B, Security Gateway C is used to route
traffic between the two communities. Since the traffic is not actually entering Security Gateway C,
there is no need for stateful inspection to take place at that Security Gateway. Stateful inspection,
however, does take place on Security Gateways A and B.

Special Considerations for Wire Mode
Wire mode does not work with IPv6.

Configuring Wire Mode
Wire mode is configured in two places:
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n Community Properties (Meshed or Star)

n Security Gateway Properties

Enabling Wire Mode on a VPN Community
1. In SmartConsole, click the Objects menu > Object Explorer.

2. From the left tree, select the VPN Communities.

3. Open the VPN Community object.

4. From the left tree, click Wire Mode.

5. Select Allow uninspected encrypted traffic between Wire mode interfaces of the
Community members.

6. To enable Wire Mode Routing, select Wire Mode Routing - Allow members to route
uninspected encrypted traffic in VPN routing configurations.

7. Click OK.

8. Install the Access Control Policy.

Enabling Wire Mode on a Specific Security Gateway
1. In SmartConsole, from the left navigation panel, click Gateways & Servers.

2. Open the applicable Security Gateway object.

3. From the left tree, click IPsec VPN > VPN Advanced.

4. In the Wire mode section:

a. Select Support Wire Mode (and Wire mode routing - route uninspected
encrypted traffic in VPN routing configurations).

b. Click Add.

c. Select the interfaces to be trusted by the selected Security Gateway.

d. Click OK.

e. Select Log Wire mode traffic to log the Wire Mode activity.

5. Click OK.

6. Install the Access Control Policy.
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Directional VPN Enforcement
Overview of Directional VPN
When a VPN community is selected in the VPN column of the Security Policy Rule Base, the source
and destination IP addresses can belong to any of the Security Gateways in the community. In
other words, the traffic is bidirectional; any of the Security Gateways can be the source of a
connection, any of the Security Gateways can be the destination endpoint. But what if the
administrator (in line with the company's security policy) wished to enforce traffic in one direction
only? Or to allow encrypted traffic to or from Security Gateways not included in the VPN
community? To enable enforcement within VPN communities, VPN implements Directional VPN.

Directional VPN specifies where the source address must be, and where the destination address
must be. In this way, enforcement can take place:

n Within a single VPN community

n Between VPN communities

Directional Enforcement within a
Community
The example figure below shows a simple meshed VPN community called MyIntranet.

VPN traffic within the MyIntranet Mesh is bidirectional. Meaning, either of the Security Gateways
(or the hosts behind the Security Gateways in the VPN domains) can be the source or destination
address for a connection.
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Source Destination VPN Service Action Track

*Any *Any MyIntranet => MyIntranet
MyIntranet =>internal_clear
internal_clear => MyIntranet

telnet Accept Log

*Any *Any MyIntranet telnet Accept Log

The match conditions are represented by a series of compound objects. The match conditions
enforce traffic in the following directions:

n To and from the VPN Community via VPN routing (MyIntranet => MyIntranet)

n From the Community to the local VPN domains (MyIntranet =>internal_clear)

n From the local VPN domains to the VPN community (internal_clear => MyIntranet)

Configurable Objects in a Direction
The table below shows all the objects that can be configured in a direction, including three new
objects created for Directional VPN:

Name of Object Description

Remote Access Remote Access VPN community

Site to Site VPN Regular Star or Mesh VPN community

Any Traffic Any traffic
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Name of Object Description

All_GwToGw All Site to Site VPN communities

All_Communities All Site to Site and Remote Access VPN communities

External_clear For traffic outside the VPN community

Internal_clear For traffic between local domains within the VPN community

Note - Clear text connections originating from these objects are not subject to enforcement:

n Any Traffic

n External_clear

n Internal_clear

There is no limit to the number of VPN directions that you can configure in a single rule. In
general, if you have many directional enforcements, consider replacing them with a standard
bidirectional condition.

Directional Enforcement between
Communities
VPN Directional Enforcement can take place between two VPN communities. In this case, one
gateway must be configured as a member of both communities and the enforcement point
between them. Every other peer gateway in both communities must have a route entry to the
enforcement point gateway in its $FWDIR/conf/vpn_route.conf file.

To add a route entry to the enforcement point gateway:

On the management module of each gateway in the community (except for the enforcement point
gateway), add an entry in the $FWDIR/conf/vpn_route.conf file:

Destination Next hop router interface Install on

<destination_community_
obj>

<enforcement_point_
gw>

<managed_FW_
object>

These are the variables in the entry:

n destination_community_obj - a network object for the combined encryption domain of
the community

n enforcement_point_gw - the gateway that is a member of both communities and
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transfers the encrypted traffic between them

n managed_FW_object - all community members that are managed by the management
module

In the example below, Washington is a Mesh community, and London is a VPN Star.

The directional VPN rule below must be configured for the enforcement point gateway in the
Access Control Policy Rule Base:

Source Destination VPN Services & Applications Action

*Any *Any Washington => London *Any Accept

The rule is applied to all VPN traffic that passes through the enforcement point gateway between
the Washington and London communities. If a connection is opened from a source in the
Washington Mesh, and the destination is in the London Star, the connection is allowed.
Otherwise, the connection is denied.

Note - The Directional Enforcement applies only to the first packet of a connection. If the
connection is permitted, the following packets of this connection are also permitted, including the
packets in the opposite direction.

Configuring Directional VPN Within a
Community

To configure Directional VPN within a community:

1. In SmartConsole, click Menu > Global properties > VPN > Advanced.

2. Select Enable VPN Directional Match in VPN Column.

3. Click OK.
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4. In SmartConsole, from the left navigation panel, click Security Policies.

5. In the Access Control section, click in the applicable rule.

6. In the VPN column of this rule, select Directional Match Condition.

The New Directional Match Condition window opens.

7. In the Traffic reaching from drop-down box, select the object for Internal_clear (the
source).

8. In the Traffic leaving to drop-down box, select the applicable VPN community object (the
destination).

9. Add another directional match, in which the applicable VPN community object is both the
source and destination.

This allows traffic from the local domain to the community, and within the community.

10. Click OK.

11. Install the Access Control Policy.

Configuring Directional VPN Between
Communities

To configure Directional VPN between communities:

1. In SmartConsole, click Menu > Global properties > VPN > Advanced.

2. Select Enable VPN Directional Match in VPN Column.

3. Click OK.

4. In SmartConsole, from the left navigation panel, click Security Policies.

5. In the Access Control section, click in the applicable rule.

6. In the VPN column of this rule, select Directional Match Condition.

The New Directional Match Condition window opens.

7. In the Traffic reaching from drop-down box, select the source of the connection.

8. In the Traffic leaving to drop-down box, select the destination of the connection

9. Click OK.

10. Install the Access Control Policy.
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Multiple Entry Point (MEP) VPNs
Overview of MEP
Multiple Entry Point (MEP) is a feature that provides a High Availability and Load Sharing solution
for VPN connections. A Security Gateway on which the VPN module is installed provides a single
point of entry to the internal network. It is the Security Gateway that makes the internal network
"available" to remote machines. If a Security Gateway should become unavailable, the internal
network too, is no longer available. A MEP environment has two or more Security Gateways both
protecting and enabling access to the same VPN domain, providing peer Security Gateways with
uninterrupted access.

VPN High Availability Using MEP or Clustering
Both MEP and Clustering are ways of achieving High Availability and Load Sharing. However:

n Unlike the members of a ClusterXL Security Gateway Cluster, there is no physical restriction
on the location of MEP Security Gateways. MEP Security Gateways can be geographically
separated machines. In a cluster, the clustered Security Gateways need to be in the same
location, directly connected via a sync interface.

n MEP Security Gateways can be managed by different Security Management Server; cluster
members must be managed by the same Security Management Server.

n In a MEP configuration there is no "state synchronization" between the MEP Security
Gateways. In a cluster, all of the Security Gateways hold the "state" of all the connections to
the internal network. If one of the Security Gateways fails, the connection passes seamlessly
over (performs failover) to another Security Gateway, and the connection continues. In a
MEP configuration, if a Security Gateway fails, the current connection is lost and one of the
backup Security Gateways picks up the next connection.

n In a MEP environment, the decision which Security Gateway to use is taken on the remote
side; in a cluster, the decision is taken on the Security Gateway side.

Implementation
MEP is implemented using RDP for Check Point Security Gateways and DPD for 3rd party Gateways
/ Cloud vendors.

n RDP is a proprietary Probing Protocol (PP) that sends special UDP RDP packets to port 259 to
discover whether an IP is reachable. This protocol is proprietary to Check Point and does not
conform to RDP as specified in RFC 908/1151.
Note - These UDP RDP packets are not encrypted, and only test the availability of a peer.
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n DPD is a different method that discovers whether an IP is reachable. It supports 3rd party
Security Gateways / Cloud vendors based on IKEv1/IKEv2.

It is important to note that in MEP environments, no configuration is necessary. The gateway
determines which protocol (RDP/DPD) to use automatically.

The peer continuously probes or polls all MEP Security Gateways in order to discover which of the
Security Gateways are "up", and chooses a Security Gateway according to the configured selection
mechanism. Since RDP/DPD packets are constantly being sent, the status of all Security Gateways
is known and updated when changes occur. As a result, all Security Gateways that are "up" are
known.

There are two available methods to implement MEP:

MEP
Method

Description

Explicit
MEP

Only Star communities with more than one central Security Gateway can enable
explicit MEP.
This MEP method provides multiple entry points to the network behind the Security
Gateways.
When available, Explicit MEP is the recommended method.

Implicit
MEP

This MEP method is supported in all scenarios, where fully or partially overlapping
encryption domains exist, or where Primary-Backup Security Gateways are
configured.

Explicit MEP
In a Site To Site Star VPN community, explicit MEP is configured in the VPN community object.
When MEP is enabled, the satellites consider the "unified" VPN domain of all the Security
Gateways as the VPN domain for each Security Gateway. This unified VPN domain is considered
the VPN domain of each Security Gateway:
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In the figure, a Star VPN community has two central Security Gateways, M1 and M2 (for which
MEP has been enabled) and three satellite Security Gateways - S1, S2, and S3. When S2 opens a
connection with Host-1 (which is behind M1 and M2), the session will be initiated through either
M1 or M2. Priority amongst the MEP Security Gateways is determined by the MEP entry point
selection mechanism.

If M2 is the selected entry point and becomes unavailable, the connection to Host-1 fails over to
M1. Returning packets will be rerouted with RIM or IP Pool NAT. For more information about
returning packets, see the section "Routing Return Packets".

There are four methods used to choose which of the Security Gateways will be used as the entry
point for any given connection:

Method Description

Select the closest Security Gateway to source First to respond

Select the closest Security Gateway to destination By VPN domain

Random selection For Load distribution

Manually set priority list MEP rules

If you select either By VPN domain , or Manually set priority list, then Advanced options
provide additional granularity.
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MEP Selection Methods

MEP
Selection
Method

Description

First to
Respond

The first Security Gateway to reply to the peer Security Gateway is chosen.
An organization would choose this option if, for example, the organization has two
Security Gateways in a MEP configuration - one in London, the other in New York.
It makes sense for VPN peers located in England to try the London Security
Gateway first and the NY Security Gateway second.
Being geographically closer to the peers in England, the London Security Gateway
will be the first to respond, and becomes the entry point to the internal network.
See the section "First to Respond".

VPN
Domain

If the destination IP address belongs to a particular VPN domain, the Security
Gateway of that domain becomes the chosen entry point.
This Security Gateway becomes the Primary Security Gateway, while other Security
Gateways in the MEP configuration become its Backup Security Gateways.
See the section "By VPN Domain".

Random
Selection

The remote peer randomly selects a Security Gateway, with which to open a VPN
connection.
For each source/destination IP address pair, a new Security Gateway is randomly
selected.
An organization might have a number of Security Gateways with equal
performance abilities. In this case, it makes sense to enable load distribution to
use these Security Gateways in a random and equal way.
See the section "Random Selection".

Manually
set
priority
list

Priorities of Security Gateways can be set manually for the entire VPN community,
or for individual satellite Security Gateways.
See the section "Manually Set Priority List".

First to Respond

When there is no primary Security Gateway, all Security Gateways share "equal priority".

When all Security Gateways share equal priority:
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1. Remote peers send RDP/DPD packets to all the Security Gateways in the MEP configuration.

2. The first Security Gateway to respond to the probing RDP/DPD packets gets chosen as the
entry point to network.

The idea behind first to respond is proximity. The Security Gateway, which is "closer" to the
remote peer, responds first.

3. A VPN tunnel is opened with the first to respond. All subsequent connections pass through
the chosen Security Gateway.

4. If the Security Gateway ceases to respond, a new Security Gateway is chosen.

By VPN Domain

Before you enable MEP, each IP address belongs to a specific VPN domain. With By VPN Domain,
the Security Gateway of that domain becomes the chosen entry point.

In the example figure below, the VPN Star community has two central MEP Security Gateways (M1
and M2, each of which have their own VPN domains), and remote satellite S1.
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Host-2 (in the VPN domain of satellite S1 initiates a connection with Host-1. The connection can
be directed through either M1 or M2. However, Host-1 is within M2's original VPN domain. For
this reason, M2 is considered the Security Gateway "closest" to the destination IP address. M2 is
therefore considered the primary Security Gateway and M1 the backup Security Gateway for
Host-1. If there were additional Security Gateways in the center, these Security Gateways would
also be considered as backup Security Gateways for M2.

If the VPN domains have fully or partially overlapping encryption domains, then more than one
Security Gateway will be chosen as the "closest" entry point to the network. As a result, more than
one Security Gateway will be considered as "primary." When there are more than one primary or
backup Security Gateways available, the Security Gateway is selected with an additional selection
mechanism. This advanced selection mechanism can be either (see the section "Advanced
Settings"):

n First to Respond

n Random Selection (for load distribution)

For return packets you can use RIM on the center Security Gateways. If RIM is also enabled, set a
metric with a lower priority value for the leased line than the VPN tunnel. The satellite S1 might
simultaneously have more than one VPN tunnel open with the MEP Security Gateways, for
example M2 as the chosen entry point for Host-1 and M1 as the chosen entry point for Host-3.
While both M1 and M2 will publish routes to Host-1 and Host-3, the lower priority metric will
ensure the leased line is used only when one of the Security Gateways goes down.

Random Selection

With this method, a different Security Gateway is randomly selected as an entry point for
incoming traffic. Evenly distributing the incoming traffic through all the available Security
Gateways can help prevent one Security Gateway from becoming overwhelmed with too much
incoming traffic.

The Security Gateways are probed with RDP/DPD packets, as in all other MEP configurations, to
create a list of responding Security Gateways. A Security Gateway is randomly chosen from the list
of responding Security Gateways. If a Security Gateway stops responding, another Security
Gateway is (randomly) chosen.

A new Security Gateway is randomly selected for every source/destination IP addresses pair.
While the source and destination IP addresses remain the same, the connection continues
through the chosen Security Gateway.

In such a configuration, RIM is not supported. IP Pool NAT must be enabled to ensure return packets
are correctly routed through the chosen Security Gateway.
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Manually Set Priority List

The Security Gateway that will be chosen (from the central Security Gateways in the Star VPN
community) as the entry point to the core network can be controlled by manually setting a priority
per source Security Gateway.

Each priority constitutes a MEP Rule.

In the figure below, three MEP members (M1, M2, M3) provide entry points to the network for
three satellite Security Gateways (S1, S2, S3). Satellite S1 can be configured to try the Security
Gateways in the following order: M1, M2, M3, giving the highest priority to M1, and the lowest
priority to M3. Satellite S2 can be configured to try the Security Gateways in the following order:
M2, M3 (but not to try M1).

Each of these priorities constitutes a MEP rule in the MEP manual priority list window:

Item Description

1 Default MEP Rule

2 First MEP Rule

3 Second MEP Rule

The MEP manual priority list window is divided into the default rule, and rules which provide
exceptions to the default rule. The default MEP rule takes effect when:

n No MEP rules are defined

n When the source of the connection cannot be found in the Exception priority rules



Glossary

Site to Site VPN R80.40 Administration Guide      |      165

The Exception priority rules section contains three priority levels: primary, secondary, and tertiary.
While there are only three priority levels,

n The same priority can be assigned to several central Security Gateways

n The same rule can be assigned to several satellite Security Gateways

n A priority level can be left blank

In the second MEP rule below:

Central Security Gateways M3 and M1 have equal priority. The same rule is being applied to
satellites S2 and S3.

When more than one Security Gateway is assigned the same priority level, which Security Gateway
will be chosen is resolved according to the Advanced settings (see the section "Advanced
Settings").

Advanced Settings

In some instances, more than one Security Gateway is available in the center with no obvious
priority between them. For example - as shown in the second example of the second MEP rule,
above - more than one Security Gateway is assigned "second" priority. In this scenario, Advanced
options are used to decide which Security Gateway is chosen: First to Respond, or Random
Selection. (Choose Random Selection to enable load balancing between the Security Gateways.)

When "manually set priority list" is the MEP selection mechanism, RIM is supported. RIM can be
configured with "manually set priority list" because the "random selection" mechanism available
on the Advanced button is different from the random selection mechanism used for MEP.

For the "random selection" mechanism employed for MEP, a different Security Gateway is selected
for each source/destination IP addresses pair. For the random selection mechanism available
from the Advanced button, a single MEP entry point is randomly selected and then used for all
connections, and does not change according to source/destination pair. Load distribution is
therefore achieved since every satellite Security Gateway is randomly assigned a Security Gateway
as its entry point. This makes it possible to enable RIM at the same time.

Tracking

If the Tracking option is enabled for MEP, this information is logged by each satellite Security
Gateway:

n The resolved peer Security Gateway (a Security Gateway in the MEP)

n The priority of the resolved Security Gateway (primary, secondary, tertiary)

n Whether the resolved Security Gateway is responding

For example, in the scenario shown in the section "Manually Set Priority List", satellite S1 opens
a connection to the VPN domain that includes Security Gateways M1, M2, and M3. M1 is the
resolved peer. If tracking is enabled, the log reads:
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Resolved peer for tunnel from S1 to the MEP that contains M1, M2, and
M3, is: M1 (Primary Security Gateway, responding).

Implicit MEP
There are three methods to implement implicit MEP:

Method Description

First to
Respond

The first Security Gateway to reply to the peer Security Gateway is chosen.
An organization would choose this option if, for example, the organization has
two Security Gateways in a MEP configuration - one in London, the other in New
York.
It makes sense for VPN peers located in England to try the London Security
Gateway first and the NY Security Gateway second.
Being geographically closer to the peers in England, the London Security
Gateway will be the first to respond, and becomes the entry point to the
internal network.
See the section "First to Respond".

Primary-
Backup

One or multiple backup Security Gateways provide "high availability" for a
primary Security Gateway.
The remote peer is configured to work with the primary Security Gateway, but
switches to the backup Security Gateway if the primary goes down.
An organization might decide to use this configuration if it has two Security
Gateways in a MEP environment, one of which is stronger than the other.
It makes sense to configure the stronger Security Gateway as the primary. Or
perhaps both Security Gateways are the same in terms of strength of
performance, but one has a cheaper or faster connection to the Internet. In this
case, the Security Gateway with the better Internet connection should be
configured as the primary.
See the section "Primary-Backup Security Gateways".

Load
Distribution

The remote peer randomly selects a Security Gateway, with which to open a
VPN connection.
For each source/destination IP address pair, a new Security Gateway is
randomly selected.
An organization might have a number of Security Gateways with equal
performance abilities. In this case, it makes sense to enable load distribution to
use these Security Gateways in a random and equal way.
See the section "Random Selection".
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Implicit MEP is supported, if the Security Gateways with overlapping encryption domains are in
the same community. If they are located in different communities, only one of the Security
Gateways will be used for this encryption domain.

First to Respond
When there is no primary Security Gateway, all Security Gateways share "equal priority".

When all Security Gateways share "equal priority":

n Remote VPN peers send RDP/DPD packets to all the Security Gateways in the MEP
configuration.

n The first Security Gateway to respond to the probing RDP/DPD packets gets chosen as the
entry point to network.

The idea behind first to respond is "proximity". The Security Gateway which is "closer" to the
remote VPN peer responds first.

n A VPN tunnel is opened with the first to respond. All subsequent connections pass through
the chosen Security Gateway.

n If the Security Gateway ceases to respond, a new Security Gateway is chosen.

In a star VPN community, RDP/DPD packets are sent to the Security Gateways and the first to
respond is used for routing only when:

1. There is more than one center Security Gateway

2. One of the following VPN routing options was selected:

n To center and to other satellites through center

n To center, or through the center to other satellites, to internet and other VPN
targets

This setting is found on the Community Properties > VPN Advanced > VPN
Routing page.

In this example scenario:
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n MEP is not enabled on the VPN community

n First to respond method is used

n Security Gateway X accesses VPN domain A through Security Gateway A

n Security Gateway X accesses VPN domain B through Security Gateway B

n Security Gateway X accesses VPN domain C through Security Gateway A or B

Primary-Backup Security Gateways
Backup Security Gateways provide redundancy for primary Security Gateways.

The first Security Gateway is configured as the "primary," and the second Security Gateway as the
"backup." If the primary Security Gateway fails, for whatever reason, the remote VPN peer detects
that the link has gone down and works through the backup Security Gateway. The backup Security
Gateway inherits the complete VPN domain of the primary Security Gateway. Failover within an
existing connection is not supported; the current connection is lost.

When the primary Security Gateway is restored, new connections go through the primary Security
Gateway, while connections that already exist will continue to work through the backup Security
Gateway.

Important - When you use the Primary-Backup Security Gateways method, the encryption
domains should not overlap.
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Load Distribution
To prevent any one Security Gateway from being flooded with connections, the connections can
be evenly shared amongst all the Security Gateways to distribute the load. When all Security
Gateways share equal priority (no primary) and are MEP to the same VPN domain, it is possible to
enable load distribution between the Security Gateways. The Security Gateways are probed with
RDP/DPD packets, as in all other MEP configurations, to create a list of responding Security
Gateways. A Security Gateway is randomly chosen from the list of responding Security Gateways.
If a Security Gateways stops responding, a new Security Gateway is (randomly) chosen.

A new Security Gateway is randomly selected for every source/destination IP addresses pair.
While the source and destination IP addresses remain the same, the connection continues
through the chosen Security Gateway.

Routing Return Packets
To make sure return packets are routed correctly, the MEP Security Gateway can make use of
either of these:

n IP Pool NAT (Static NAT)

n Route Injection Mechanism (RIM)

IP Pool NAT
IP Pool NAT is a type of NAT, in which source IP addresses from remote VPN domains are mapped
to an IP address drawing from a pool of registered IP addresses. In order to maintain symmetric
sessions with MEP Security Gateways, the MEP Security Gateway performs NAT with a range of IP
addresses dedicated to that specific Security Gateway and should be routed within the internal
network to the originating Security Gateway. When the returning packets reach the Security
Gateway, the Security Gateway restores the original source IP address and forwards the packets to
the source.

Route Injection Mechanism
Route Injection Mechanism (RIM) enables a Security Gateway to use a dynamic routing protocol to
propagate the encryption domain of a VPN peer Security Gateway to the internal network. When a
VPN tunnel is created, RIM updates the local routing table of the Security Gateway to include the
encryption domain of the VPN peer.

When a tunnel to a MEP Security Gateway goes down, the Security Gateway removes the
applicable "return route" from its own local routing table. This change is then distributed
backwards to the routers behind the Security Gateway.
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RIM is based both on the ability of the Security Gateway to update its local routing table, and the
presence of the a dynamic routing protocol to distribute the change to the network behind the
Security Gateway. There is little sense in enabling RIM on the Security Gateway if a dynamic
routing protocol is not available to distribute changes.

When MEP is enabled, RIM can be enabled only if permanent tunnels are enabled for the whole
community. In a MEP configuration RIM is available when you use the First to Respond, Manual
set priority list, and VPN Domain mechanisms. In the first two options, satellite Security
Gateways "see" the center Security Gateways as unified as if one tunnel is connecting them. As a
result, only the chosen MEP Security Gateway will inject the routes. In VPN Domain MEP, it could
be that all MEP Security Gateways will inject the routes, which requires configuring the routers
behind the MEP Security Gateways to return packets to the correct Security Gateway.

RIM is not available when Random Selection is the selected entry point mechanism.

For more information, see "Route Injection Mechanism" on page 139.

Special Considerations
1. If one of the central Security Gateways is an externally managed Security Gateway:

n The VPN domain of the central Security Gateways will not be automatically inherited
by an externally managed Security Gateway

n The RIM configuration will not be automatically downloaded

2. UTM-1 Edge devices cannot be configured as a MEP Security Gateway, but can connect to
MEP Security Gateways.

3. DAIP Security Gateways require DNS resolving in order to be configured as MEP Security
Gateways.

Configuring MEP

To configure MEP, decide on:

1. The MEP method:

n Explicit MEP.

n Implicit MEP.

2. If required, method for returning reply packets:

n IP Pool NAT

n Route Injection Mechanism (see "Route Injection Mechanism" on page 139).
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Configuring Explicit MEP
Explicit MEP is only available in Site-to-Site Star VPN communities where multiple central Security
Gateways are defined.

To configure MEP:

1. In SmartConsole, click Objects menu > Object Explorer.

2. From the left tree, select VPN Communities.

3. Open the Star VPN Community object.

4. From the left tree, click MEP.

5. Select Enable center gateways as MEP.

6. Select the applicable entry point mechanism:

n First to respond

n By VPN domain

n Random selection

n Manual priority list

Notes:

n If you select By VPN domain or Manually set priority list, then in the Advanced
section choose First to respond or Random selection to resolve how more than one
Security Gateway with equal priority should be selected.

n If you select Manually set priority list, then click Set to create a series of MEP rules.

7. Select a Tracking option, if required.

8. Click OK.

9. Install the Access Control Policy.

Configuring Implicit MEP

Configuring Implicit First to Respond

When more than one Security Gateway leads to the same (overlapping) VPN domain, they are in a
MEP configuration. The first Security Gateway to respond is chosen. To configure first to respond,
define that part of the network that is shared by all the Security Gateways into a single group and
assign that group as the VPN domain.
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Before you start, make sure that Load Distribution for MEPs configurations is disabled:

1. In SmartConsole, click Menu > Global properties > VPN > Advanced.

2. Clear the Enable load distribution for Multiple Entry Points configurations (Site to Site
connections).

3. Click OK.

To configure First to Respond MEP:

1. On each Security Gateway in the VPN domain, run the "vpn overlap_encdom" on page 203
command.

2. In SmartConsole, create a Network Group object and assign all these Security Gateways to
it.

3. In each Security Gateway object:

4. Click Network Management > VPN Domain.

5. Select Manually defined.

6. Click the [...] button.

7. Select the Network Group object of MEP gateways that you defined in Step 2.

8. Click OK.

9. Install the Access Control Policy on all these Security Gateways.

Configuring Implicit Primary-Backup

Configure the VPN Domain that includes the Primary Security Gateway and another VPN Domain
that includes only the Backup Security Gateways.

Configure each Security Gateway as either the Primary Security Gateway, or a Backup Security
Gateway.

Procedure:

Step Description

1 Enable the Backup Gateway options in Global properties:

1. Click Menu > Global properties > VPN > Advanced.
2. Select Enable Backup Gateway.
3. Click OK to close the Global properties window.
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Step Description

2 Configure a Network Group object:

1. Click Objects menu > Object Explorer.
2. At the top, click New > Network Group.
3. Configure this Network Group object to contain only Backup Security Gateways.
4. Click OK to close the Network Group object window.

3 Configure the Primary Security Gateway object:

1. Click Objects menu > Object Explorer.
2. From the left tree, select Network Objects > Gateways & Servers.
3. Open the Primary Security Gateway object.
4. Click IPsec VPN.
5. Select Use Backup Gateways.
6. In the drop-down menu, select the Network Group object that contains the

Backup Security Gateways.
7. Click OK to close the Primary Security Gateway object.

This Security Gateway is now the Primary Security Gateway for this VPN domain.

4 Define the VPN for the Backup Security Gateways.
Backup Security Gateways do not always have a VPN Domain of their own. They simply
back up the Primary Security Gateway.

If the Backup Security Gateway does not have a VPN Domain of its own, the VPN Domain
should include only the Backup Security Gateway itself:

1. Click Objects menu > Object Explorer.
2. From the left tree, select Network Objects > Gateways & Servers.
3. Open the Backup Security Gateway object.
4. Click Network Management > VPN Domain.
5. Select Manually defined.
6. Click the [...] button.
7. Select the Network Group object that contains only the Backup Security

Gateways.
8. Click OK to close the Backup Security Gateway object.
9. Install the Access Control Policy on the Backup Security Gateways.
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Step Description

If the Backup Security Gateway has a VPN Domain of its own:

1. Click Objects menu > Object Explorer.
2. From the left tree, select Network Objects > Gateways & Servers.
3. Open the Backup Security Gateway object.
4. Click Network Management > VPN Domain.
5. Make sure that the IP address of the Backup Security Gateway is not included in

the VPN Domain of the Primary Security Gateway.
6. For each Backup Security Gateway, define a VPN Domain that does not overlap

with the VPN Domain of other Backup Security Gateways.
7. Click OK to close the Backup Security Gateway object.
8. Install the Access Control Policy on the Backup Security Gateways.

Important - There must be no overlap between the VPN Domain of the Primary
Security Gateway and the VPN Domain of the Backup Security Gateways - no IP address
can belong to both VPN Domains.

Configuring Implicit Load Distribution

To configure implicit MEP for random gateway selection in SmartConsole:

Step Description

1 Enable load distribution for MEP configurations:

1. Click Menu > Global properties.
2. From the left tree, click VPN > Advanced.
3. Select Enable load distribution for Multiple Entry Point configurations (Site

to Site connections).
4. Click OK to close the Global properties window.

Configure a Network Group object:

1. Click Objects menu > Object Explorer.
2. At the top, click New > Network Group.
3. Configure this Network Group object to contain all the Security Gateways.
4. Click OK to close the Network Group object window.
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Step Description

2 Define the same VPN Domain for all the Security Gateways:

1. Click Objects menu > Object Explorer.
2. From the left tree, select Network Objects > Gateways & Servers.
3. Open each Security Gateway object.
4. Click Network Management > VPN Domain.
5. Select Manually defined.
6. Click the [...] button.
7. Select the Network Group object that contains all the Security Gateways.
8. Click OK to close the Security Gateway object.

3 Install the Access Control Policy on all the Security Gateways.

Configuring IP Pool NAT

To configure IP Pool NAT for Site to Site VPN in SmartConsole:

Step Description

1 Enable IP Pool NAT in the Global Properties:

1. Click Menu > Global properties.
2. Click NAT - Network Address Translation.
3. Select Enable IP Pool NAT.
4. Select the applicable options (None, Log, or Alert) for:

n Address exhaustion track
n Address allocation and release track

5. Click OK to close the Global properties window.

2 For each Security Gateway, configure an object that represents the IP Pool NAT
addresses for that Security Gateway:

1. Click Objects menu > Object Explorer.
2. The object that represents the IP Pool NAT addresses can be one of these objects:

n Network - At the top, click New > Network
n Network Group - At the top, click New > Network Group
n Address Range - At the top, click New > Network Object > Address

Range > Address Range.
3. Configure this object to contain the applicable IP addresses.
4. Click OK to close the object with IP Pool NAT addresses.
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Step Description

3 In each Security Gateway, configure IP Pool NAT settings:

1. Click Objects menu > Object Explorer.
2. From the left tree, select Network Objects > Gateways & Servers.
3. Open each Security Gateway object.
4. Click NAT > IP Pool NAT.
5. Select one of these two options:

n Allocate IP Addresses from.
If you choose this option, then select the object that represents the IP Pool NAT
addresses for that Security Gateway.

n Define IP Pool addresses on Gateway interfaces.
If you choose this option, then you must configure the IP Pool NAT on each
required interface:
(i) From the left tree, click Network Management.
(ii) Edit each required interface.
(iii) From the left tree, click General.
(iv) In the Topology section, click Modify.
(v) In the IP Pool NAT section, select the object that represents the IP Pool NAT
addresses.
(vi) Click OK.

1. Select the applicable options:
n Use IP Pool NAT for VPN clients connections
n Use IP Pool NAT for gateway to gateway connections
n Prefer IP Pool NAT over Hide NAT

2. Click Advanced to configure the advanced IP Pool NAT settings. Click OK.
3. Click OK to close the Security Gateway object.

4 Install the Access Control Policy on all Security Gateways.

5 Edit the routing table for each internal router, so that packets with an IP address
assigned from the IP Pool NAT are routed to the applicable Security Gateway.
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Resolving Connectivity Issues
IPsec NAT-Traversal
NAT-T (NAT traversal or UDP encapsulation) makes sure that IPsec VPN connections stay open
when traffic goes through gateways or devices that use NAT.

When an IP packet passes through a network address translator device, it is changed in a way that
is not compatible with IPsec. To protect the original IPsec encoded packet, NAT traversal
encapsulates it with an additional layer of UDP and IP headers.

For IPsec to work with NAT traversal, these protocols must be allowed through the NAT interface
(s):

n IKE - UDP port 500

n IPsec NAT-T - UDP port 4500

n Encapsulating Security Payload (ESP) - IP protocol number 50

n Authentication Header (AH) - IP protocol number 51

Configuring NAT-Traversal

To configure NAT-T for Site to Site VPN:

1. In SmartConsole, from the left navigation panel, click Gateways & Servers.

2. Open the applicable Security Gateway object with enabled IPsec VPN Software Blade.

3. From the left tree, click IPsec VPN > VPN Advanced.

4. Make sure to select Support NAT traversal (applies to Remote Access and Site to Site
connections).

NAT-Traversal is enabled by default when a NAT device is detected.

5. Click OK.

6. Install the Access Control Policy.

Advanced NAT-T Configuration
These variables are defined for each Security Gateway and control NAT-T for Site to Site VPN:
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Item Description
Default
Value

offer_nat_t_initator Initiator sends NAT-T traffic false

offer_nat_t_responder_for_
known_gw

Responder accepts NAT-T traffic from
known gateways

true

force_nat_t Force NAT-T, even if there is no NAT-T
device

false

The variables can be viewed and changed in GuiDBedit Tool (see sk13009):

1. In the top left pane, click TABLE > Network Objects > network_objects.

2. In the top right pane, select the applicable Security Gateway object.

3. In the bottom pane, see the VPN section.

4. Save the changes: click File menu > Save All.

5. In SmartConsole, install the Access Control Policy on this Security Gateway object.

http://supportcontent.checkpoint.com/solutions?id=sk13009
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Command Line Reference
VPN commands generate status information regarding VPN processes, or are used to stop and
start specific VPN services.

All VPN commands are executed on the Security Gateway and Cluster Members.

For more information, see the:

n R80.40 CLI Reference Guide.

n R80.40 Remote Access VPN Administration Guide.

Below is a limited list of applicable commands.

https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_CLI_ReferenceGuide/Default.htm
https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_RemoteAccessVPN_AdminGuide/Default.htm


Syntax Legend

Site to Site VPN R80.40 Administration Guide      |      180

Syntax Legend
Whenever possible, this guide lists commands, parameters and options in the alphabetical order.

This guide uses this convention in the Command Line Interface (CLI) syntax:

Character Description

TAB Shows the available nested subcommands:

main command
→ nested subcommand 1
→ → nested subsubcommand 1-1
→ → nested subsubcommand 1-2
→ nested subcommand 2

Example:

cpwd_admin
    config
        -a <options>
        -d <options>
        -p
        -r
    del <options>

Meaning, you can run only one of these commands:

n This command:

cpwd_admin config -a <options>

n Or this command:

cpwd_admin config -d <options>

n Or this command:

cpwd_admin config -p

n Or this command:

cpwd_admin config -r

n Or this command:

cpwd_admin del <options>

Curly brackets or
braces
{ }

Enclose a list of available commands or parameters, separated by the
vertical bar |.
User can enter only one of the available commands or parameters.

Angle brackets
< >

Enclose a variable.
User must explicitly specify a supported value.
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Character Description

Square brackets or
brackets
[ ]

Enclose an optional command or parameter, which user can also
enter.
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vpn

Description

Configures VPN settings.

Shows VPN information.

Syntax

vpn
      check_ttm
      compreset
      compstat
      crl_zap
      crlview
      debug
      dll
      drv
      dump_psk
      ipafile_check
      ipafile_users_capacity
      macutil
      mep_refresh
      neo_proto
      nssm_topology
      overlap_encdom
      rim_cleanup
      rll
      set_slim_server
      set_snx_encdom_groups
      set_trac
      shell
      show_tcpt
      sw_topology

{tunnelutil | tu}
      ver

Parameters

Parameter Description

check_ttm Makes sure the specified TTM file is valid.
See "vpn check_ttm" on page 185.
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Parameter Description

compreset Resets compression and decompression statistics counters.
See "vpn compreset" on page 186.

compstat Shows compression and decompression statistics counters.
See "vpn compstat" on page 187.

crl_zap Erases all Certificate Revocation Lists (CRLs) from the cache.
See "vpn crl_zap" on page 188.

crlview Retrieves the Certificate Revocation List (CRL) from various distribution
points and shows it for the user.
See "vpn crlview" on page 189.

debug Controls the debug of vpnd daemon and IKE.
See "vpn debug" on page 191.

dll Works with DNS Lookup Layer.
See "vpn dll" on page 194.

drv Controls the VPN kernel module.
See "vpn drv" on page 195.

dump_psk Shows hash (SHA256) of peers' pre-shared-keys.
See "vpn dump_psk" on page 196.

ipafile_check Verifies a candidate for the $FWDIR/conf/ipassignment.conf file.
See "vpn ipafile_check" on page 197.

ipafile_users_
capacity

Shows and configures the capacity in the
$FWDIR/conf/ipassignment.conf file.
See "vpn ipafile_users_capacity" on page 198.

macutil Shows a generated MAC address for each user name when you use
Remote Access VPN with Office Mode.
See "vpn macutil" on page 199.

mep_refresh Initiates MEP re-decision.
See "vpn mep_refresh" on page 200.

neo_proto Controls the NEO client protocol.
See "vpn neo_proto" on page 201.

nssm_topology Generates and uploads a topology in NSSM format to an NSSM server.
See "vpn nssm_toplogy" on page 202.
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Parameter Description

overlap_encdom Shows all overlapping VPN domains.
See "vpn overlap_encdom" on page 203.

rim_cleanup Cleans RIM routes.
See "vpn rim_cleanup" on page 205.

rll Works with Route Lookup Layer.
See "vpn rll" on page 206.

set_slim_
server

Deprecated.
See "vpn set_slim_server" on page 207.

set_snx_
encdom_groups

Controls the encryption domain per usergroup feature for SSL Network
Extender.
See "vpn set_snx_encdom_groups" on page 208.

set_trac Controls the TRAC server.
See "vpn set_trac" on page 209.

shell VPN Command Line Interface.
See "vpn shell" on page 210.

show_tcpt Shows Visitor Mode users.
See "vpn show_tcpt" on page 217.

sw_topology Downloads the topology for a UTM-1 Edge or Safe@Office device.

Note - R80.40 does not support UTM-1 Edge and Safe@Office
devices. The information about this command is provided only
to describe the existing syntax option until it is removed
completely.

See "vpn sw_topology" on page 218.

tunnelutil |
tu

Launches the TunnelUtil tool, which is used to control VPN tunnels.
See "vpn tu" on page 219.

ver Shows the major version number and build number of the VPN kernel
module.
See "vpn ver" on page 229.
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vpn check_ttm

Description

Makes sure the specified TTM file contains valid syntax.

Syntax

vpn check_ttm <Path to TTM file>

Parameters

Parameter Description

<Path to TTM file> Specifies the full path and name of the TTM file.

Example

[Expert@MyGW:0]# find / -name \*.ttm -type f
find: /proc/64899: No such file or directory
/var/opt/CPsuite-R80.40/fw1/conf/fw_client_1.ttm
/var/opt/CPsuite-R80.40/fw1/conf/nemo_client_1.ttm
/var/opt/CPsuite-R80.40/fw1/conf/neo_client_1.ttm
/var/opt/CPsuite-R80.40/fw1/conf/iphone_client_1.ttm
/var/opt/CPsuite-R80.40/fw1/conf/topology_trans_tmpl.ttm
/var/opt/CPsuite-R80.40/fw1/conf/vpn_client_1.ttm
/var/opt/CPsuite-R80.40/fw1/conf/trac_client_1.ttm
... ... ...
[Expert@MyGW:0]#
[Expert@MyGW:0]# vpn check_ttm /var/opt/CPsuite-R80.40/fw1/conf/trac_client_1.ttm

Summary for the file: trac_client_1.ttm
result: the file passed the check without any problems

[Expert@MyGW:0]#
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vpn compreset

Description

Resets compression and decompression statistics counters.

Syntax

vpn compreset

Example

[Expert@MyGW:0]# vpn compreset
Compression statistics were reset.
[Expert@MyGW:0]#
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vpn compstat

Description

Shows compression and decompression statistics counters.

Syntax

vpn compstat

Example

[Expert@MyGW:0]# vpn compstat

Compression: sum of all instances :

Compression:
============
Bytes before compression : 0
Bytes after compression : 0
Compression overhead (bytes) : 0
Bytes that were not compressed : 0
Compressed packets : 0
Packets that were not compressed : 0
Compression errors : 0

Pure compression ratio : 0.000000
Effective compression ratio : 0.000000

Decompression:
==============
Bytes before decompression : 0
Bytes after decompression : 0
Decompression overhead (bytes) : 0
Decompressed packets : 0
Decompression errors : 0
Pure decompression ratio : 0.000000
[Expert@MyGW:0]#
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vpn crl_zap

Description

Erases all Certificate Revocation Lists (CRLs) from the cache.

Syntax

vpn crl_zap

Return Values

n 0 (zero) for success

n any other value for failure
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vpn crlview

Description

Retrieves the Certificate Revocation List (CRL) from various distribution points and shows it for the
user.

Syntax

vpn crlview [-d]
      -obj <Network Object Name> -cert <Certificate Object Name>
      -f <Certificate File>
      -view

Parameters

Parameter Description

-d Runs the command in debug mode.
Use only if you troubleshoot the command itself.

Best Practice - If you use this parameter,
then redirect the output to a file, or use
the script command to save the entire
CLI session.

-obj <Network Object Name> Specifies the name of the CA network object.

-cert <Certificate Object
Name>

Specifies the name of the certificate object.

-f <Certificate File> Specifies the path and the name of the certificate
file.

-view Shows the CRL.

Return Values

n 0 (zero) for success

n any other value for failure

https://linux.die.net/man/1/script
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Example 1

vpn crlview -obj <MyCA> -cert <MyCert>

1. The VPN daemon contacts the Certificate Authority called MyCA and locates the certificate
called MyCert.

2. The VPN daemon extracts the certificate distribution point from the certificate.

3. The VPN daemon goes to the distribution point and retrieves the CRL. The distribution point
can be an LDAP or HTTP server.

4. The VPN daemon shows it to the standard output.

Example 2

vpn crlview -f /var/log/MyCert

1. The VPN daemon extracts the certificate distribution point from the certificate file called
MyCert.

2. The VPN daemon goes to the distribution point and retrieves the CRL. The distribution point
can be an LDAP or HTTP server.

3. The VPN daemon shows the CRL to the standard output.

Example 3

vpn crlview -view <Lastest CRL>

If the CRL was retrieved in the past, this command instructs the VPN daemon to show the
contents to the standard output.
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vpn debug

Description

Instructs the VPN daemon vpnd to write debug messages to the $FWDIR/log/vpnd.elg* and
$FWDIR/log/ike.elg* log files.

Debugging of the VPN daemon takes place according to Debug Topics and Debug Levels:

n A Debug Topic is a specific area, on which to perform debugging. For example, if the Debug
Topic is LDAP, all traffic between the VPN daemon and the LDAP server is written to the log
file.

We recommend to debug all available topics - use TDERROR_ALL_ALL.

Check Point Support provides the specific Debug Topics when needed.

n Debug Levels range from 1 (least informative) to 5 (most informative - write all debug
messages).

For more information, see sk89940: How to debug VPND daemon.

Syntax

vpn debug
      on [<Debug_Topic>=<Debug_Level>]
      off
      ikeon [-s <Size_in_MB>]
      ikeoff
      trunc [<Debug_Topic>=<Debug_Level>]
      truncon [<Debug_Topic>=<Debug_Level>]
      truncoff
      timeon [<Seconds>]
      timeoff
      ikefail [-s <Size_in_MB>]
      mon
      moff
      say ["String"]
      tunnel [<Level>]

Parameters

Parameter Description

No Parameters Shows the built-in usage.

on Turns on high level VPN debug.
Information is written in the $FWDIR/log/vpnd.elg* files.

http://supportcontent.checkpoint.com/solutions?id=sk89940
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Parameter Description

<Debug_
Topic
>=<Debug_
Level>

Specifies the Debug Topic and the Debug Level.
Check Point Support provides these.

Best Practice - Run this command to start the debug:

vpn debug trunc ALL=5

off Turns off all VPN debug.

Best Practice - Run one of these commands to stop the VPND
debug:

vpn debug off

vpn debug truncoff

ikeon [-s
<Size_in_
MB>]

Turns on the IKE debug.
Information is written in the $FWDIR/log/ike.elg* files.
You can specify the size of the $FWDIR/log/ike.elg file, when to
perform the log rotation (close the current active file, rename it, open a new
active file).

ikeoff Turns off IKE debug.
Run this command to stop the IKE debug:

vpn debug ikeoff

trunc

or
truncon

This command:

1. Rotates the $FWDIR/log/vpnd.elg file
2. Truncates the $FWDIR/log/ike.elg file
3. Starts the VPND daemon debug
4. Starts the IKE debug

Run this command to start the debug:

vpn debug trunc ALL=5

truncoff Stops the VPND daemon debug.
Run one of these commands to stop the VPND debug:

vpn debug truncoff

vpn debug off

timeon
[<Seconds>]

Enables the timestamp in the log files.
Prints one timestamp after the specified number of seconds.
By default, prints the timestamp every 10 seconds.

https://www.checkpoint.com/support-services/contact-support/
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Parameter Description

timeoff Disables the timestamp in the log files every number of seconds.

ikefail [-s
<Size_in_
MB>]

Logs failed IKE negotiations.
You can specify the size of the $FWDIR/log/ike.elg file, when to
perform the log rotation (close the current active file, rename it, open a new
active file).

mon Enables the IKE Monitor.
Saves the IKE packets in the $FWDIR/log/ikemonitor.snoop file.

Warning - The output file may contain user X-Auth passwords.
Make sure the file is protected.

moff Disables the IKE Monitor.

say "String" Saves the specified text string in the $FWDIR/log/vpnd.elg file.
For example, run: vpn debug say "BEGIN TEST"

Notes:

n Run this command after you start the VPN debug (with one
of these commands: "vpn debug on", "vpn debug

trunc", or "vpn debug truncon").
n The length of the string is limited to 255 characters.

tunnel
[<Debug_
Level>]

This command:

1. Rotates the $FWDIR/log/vpnd.elg file
2. Truncates the $FWDIR/log/ike.elg file
3. Starts the VPND daemon debug with these two Debug Topics:

tunnel
ikev2

If the <Debug_Level> is 2,3,4 or 5, then also enables this Debug
Topic:
CRLCache

4. Starts the IKE debug

Return Values

n 0 (zero) for success

n any other value for failure (typically, -1 or 1)
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vpn dll

Description

Works with VPN DNS Lookup Layer:

n Save the DNS Lookup Layer information to the specified file.

n Resolve the specified hostname.

Syntax

vpn dll
      dump <File>
      resolve <HostName>

Parameters

Parameter Description

dump <File> Saves the DNS Lookup Layer information (DNS Names and IP Addresses)
to the specified file.

resolve
<HostName>

Resolves the specified hostname.
The command saves the last specified hostname in this file:
$FWDIR/tmp/vpnd_cmd.tmp
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vpn drv

Description

Controls the VPN kernel module.

Syntax

vpn drv {off | on | stat}

Parameters

Parameter Description

off Stops the VPN kernel module

on Starts the VPN kernel module

stat Shows the current status of the VPN kernel module

Example

[Expert@MyGW:0]# vpn drv stat
VPN-1 module active
[Expert@MyGW:0]#
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vpn dump_psk

Description

Shows hash (SHA256) of peers' pre-shared-keys.

Syntax

vpn dump_psk
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vpn ipafile_check

Description

Verifies a candidate for the $FWDIR/conf/ipassignment.conf file.

Syntax

vpn ipafile_check <File> [{err | warn | detail}] [verify_group_names]

Parameters

Parameter Description

<File> Specifies the full path and name of the candidate file.

{err | warn |
detail}

Specifies the how much information to show about the candidate
file:

n err - Only errors
n warn - Only warnings
n detail - All details

verify_group_names Examines the group names.
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vpn ipafile_users_capacity

Description

n Shows the current capacity in the $FWDIR/conf/ipassignment.conf file.

n Configures the new capacity in the $FWDIR/conf/ipassignment.conf file.

Syntax

vpn ipafile_users_capacity get

vpn ipafile_users_capacity set <128-32768>

Parameters

Parameter Description

get Shows the current capacity.

set <128-32768> Configures the new capacity to the specified number of users.

Notes:

n The default is 1024 entries.
n This command configures the amount of

memory reserved to store usernames.

Example

[Expert@MyGW:0]# vpn ipafile_users_capacity get
The gateway can currently read 1024 users from the ipassignment.conf file
[Expert@MyGW:0]#
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vpn macutil

Description

Shows a generated MAC address for each user name when you use Remote Access VPN with
Office Mode.

This command is applicable only when allocating IP addresses through DHCP.

Remote Access VPN users in Office Mode receive an IP address, which is mapped to a hardware or
MAC address.

Syntax

vpn macutil <username>

Example

# vpn macutil John
20-0C-EB-26-80-7D, "John"
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vpn mep_refresh

Description

Initiates MEP re-decision.

Used in "backup stickiness" configuration to initiate MEP re-decision (fail back to primary Security
Gateway, if possible).

Syntax

vpn mep_refresh
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vpn neo_proto

Description

Controls the NEO client protocol.

Important - This command is for Check Point use only.

Syntax

vpn neo_proto {off | on}

Parameters

Parameter Description

off Disables the NEO client protocol.

on Enables the NEO client protocol.



vpn nssm_toplogy

Site to Site VPN R80.40 Administration Guide      |      202

vpn nssm_toplogy

Description

Generates and uploads a topology in NSSM format to an NSSM server.

Syntax

vpn nssm_topology -url <"url"> -dn <"dn"> -name <"name"> -pass
<"password"> [-action {bypass | drop}] [-print_xml]

Parameters

Parameter Description

-url <"url"> URL of the NSSM server.

-dn <"dn"> Distinguished Name of the NSSM server (needed to establish an SSL
connection).

-name
<"name">

Valid login name for the NSSM server.

-pass
<"password">

Valid password for the NSSM server.

-action
{bypass |
drop}

Specifies the action that the Symbian client should take, if the packet is
not destined for an IP address in the VPN domain.
Bypass is the default.

-print_xml Writes the topology to a file in XML format.
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vpn overlap_encdom

Description

Shows all overlapping VPN domains.

Some IP addresses might belong to two or more VPN domains.

The command alerts for overlapping encryption domains if one or both of the following conditions
exist:

n The same VPN domain is defined for both Security Gateways.

n If the Security Gateway has multiple interfaces, and one or more of the interfaces has the
same IP address and netmask.

Syntax

vpn overlap_encdom [communities | traditional]

Parameters

Parameter Description

communities Shows all pairs of objects with overlapping VPN domains, only if the objects
(that represent VPN sites) are included in the same VPN community.
This parameter is also used, if the same destination IP can be reached
through more than one VPN community.

traditional Default parameter.
Shows all pairs of objects with overlapping VPN domains.
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Example

# vpn overlap_encdom communities
The objects Paris and London have overlapping encryption domains.
The overlapping domain is:
10.8.8.1 - 10.8.8.1
10.10.8.0 - 10.10.9.255
- This overlapping encryption domain generates a multiple entry points configuration in MyIntranet and
RemoteAccess communities.
- Same destination address can be reached in more than one community (Meshed, Star). This configuration is
not supported.

The objects Paris and Chicago have overlapping encryption domains. The overlapping domain is:
10.8.8.1 - 10.8.8.1
- Same destination address can be reached in more than one community (MyIntranet, NewStar). This
configuration is not supported.

The objects Washington and Tokyo have overlapping encryption domains.
The overlapping domain is:
10.12.10.68 - 10.12.10.68
10.12.12.0 - 10.12.12.127
10.12.14.0 - 10.12.14.255
- This overlapping encryption domain generates a multiple entry points configuration in Meshed, Star and
NewStar communities.
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vpn rim_cleanup

Description

Cleans RIM routes.

Syntax

vpn rim_cleanup
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vpn rll

Description

Controls the VPN Route Lookup Layer:

n Saves the Route Lookup Layer information to the specified file.

n Synchronizes the routing table.

Syntax

vpn rll
      dump <File>
      sync

Parameters

Parameter Description

dump <File> Saves the Route Lookup Layer information to the specified file:

n ISP Redundancy Default Routes (Next Hop, Interface,
Metric)

n Route Shadow (Interface and Metric, IP/Mask, Next Hop)
n Monitored IP Addresses (Data, IP/Mask)

sync Synchronizes the routing table.
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vpn set_slim_server

Description

This command is deprecated.

Delete the $FWDIR/conf/slim.conf file and use the Management Server to configure SSL
Network Extender.

As long as the $FWDIR/conf/slim.conf file exists, it overrides the settings you configure on
the Management Server.
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vpn set_snx_encdom_groups

Description

Controls the encryption domain per usergroup feature for SSL Network Extender.

Syntax

vpn set_snx_encdom_groups
      off
      on

Parameters

Parameter Description

off Disables the encryption domain per usergroup feature.

on Enables the encryption domain per usergroup feature.
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vpn set_trac

Description

Controls the TRAC server.

Syntax

vpn set_trac
      disable
      enable

Parameters

Parameter Description

disable Disables the TRAC server.

enable Enables the TRAC server.

Example

[Expert@MyGW:0]# vpn set_trac enable
Trac client enabled, Install Policy for this change to take effect
[Expert@MyGW:0]#

[Expert@MyGW:0]# vpn set_trac disable
Trac client disabled, Install Policy for this change to take effect
[Expert@MyGW:0]#
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vpn shell

Description

VPN Command Line Interface.

Syntax for IPv4

vpn shell

Syntax for IPv6

vpn6 shell

Menu Options

[Expert@MyGW:0]# vpn shell
? - This help
.. - Go up one level
quit - Quit

[interface ] - Manipulate tunnel interfaces
[show ] - Show internal data
[tunnels ] - Manipulate tunnel data
[license ] - Display SCM licenses
VPN shell:[/] >
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Menu Sub-Options

interface
add
modify
delete
show

show
interface
tunnels

IKE
all
peer <Internal Peer IP>

IPsec
all
peer <Internal Peer IP>

tunnels
show

IKE
all
peer <Internal Peer IP>

IPsec
all
peer <Internal Peer IP>

delete
IKE

peer <Security Gateway>
user <Username>
all

IPsec
peer <Security Gateway>
user <Username>
all

all
IKE
IPsec

license
scm

status
list
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Description of Options and Sub-Options

Option Description

? Shows the available advanced commands in the current menu level.

.. Goes up one level in the menu.

quit Quits the VPN shell (available only in the main level).

interfac
e

These commands are deprecated on Gaia OS.
Use the applicable options in Gaia Portal or the applicable commands in Gaia
Clish.
See the R80.40 Gaia Administration Guide.

show Shows internal data.
The available options are:

n Show and configure tunnel interfaces:

show > interface

These commands are deprecated on Gaia OS.
Use the applicable options in Gaia Portal or the applicable commands in
Gaia Clish.
See the R80.40 Gaia Administration Guide.

https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_Gaia_AdminGuide/Default.htm
https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_Gaia_AdminGuide/Default.htm
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Option Description

n Show Security Associations (SAs):

show > tunnels

The available sub-options are:
l Show all IKE SAs

show > tunnels > IKE > all

Note - This sub-option is the same as:
o In the main "vpn tu" on page 219 menu, the option (3)

List all IKE SAs for a given peer (GW).
o The "vpn tu [-w] list ike" command (see "vpn

tu list" on page 224).
l Show all IKE SAs for a specified VPN peer:

show > tunnels > IKE > peer <Internal Peer IP>

Note - This sub-option is the same as:
o In the main "vpn tu" on page 219 menu, the option (1)

List all IKE SAs.
o The "vpn tu [-w] list peer_ike <IP

Address>" command (see "vpn tu list" on page 224).
l Show all IPsec SAs

show > tunnels > IPsec > all

Note - This sub-option is the same as:
o In the main "vpn tu" on page 219 menu, the option (2)

List all IPsec SAs.
o The "vpn tu [-w] list ipsec" command (see

"vpn tu list" on page 224).
l Show all IPsec SAs for a specified VPN peer:

show > tunnels > IPsec > peer <Internal Peer IP>

Note - This sub-option is the same as:
o In the main "vpn tu" on page 219 menu, the option (4)

List all IPsec SAs for a given peer (GW).
o The "vpn tu [-w] list peer_ipsec <IP

Address>" command (see "vpn tu list" on page 224).
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Option Description

tunnels Shows and deletes Security Associations (SAs).
The available options are:

n Show Security Associations (SAs):

tunnels > show

The available sub-options are:
l Show all IKE SAs:

tunnels > show > IKE > all

Note - This sub-option is the same as:
o In the main "vpn tu" on page 219 menu, the option (1)

List all IKE SAs.
o The "vpn tu [-w] list ike" command (see "vpn

tu list" on page 224).
l Show all IKE SAs for a specified VPN peer:

tunnels > show > IKE > peer <Internal Peer IP>

Note - This sub-option is the same as:
o In the main "vpn tu" on page 219 menu, the option (3)

List all IKE SAs for a given peer (GW).
o The "vpn tu [-w] list peer_ike <IP

Address>" command (see "vpn tu list" on page 224).
l Show all IPsec SAs:

tunnels > show > IPsec > all

Note - This sub-option is the same as:
o In the main "vpn tu" on page 219 menu, the option (2)

List all IPsec SAs.
o The "vpn tu [-w] list ipsec" command (see

"vpn tu list" on page 224).
l Show all IPsec SAs for a specified VPN peer:

tunnels > show > IPsec > peer <Internal Peer IP>

Note - This sub-option is the same as:
o In the main "vpn tu" on page 219 menu, the option (4)

List all IPsec SAs for a given peer (GW).
o The "vpn tu [-w] list peer_ipsec <IP

Address>" command (see "vpn tu list" on page 224).
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Option Description

n Delete Security Associations (SAs):

tunnels > delete

The available sub-options are:
l Delete all IKE for a specified VPN peer:

tunnels > delete > IKE > peer <Internal Peer IP>

l Delete all IKE for a specified user:

tunnels > delete > IKE > user <Username>

l Delete all IKE SAs for all VPN peers and users:

tunnels > delete > IKE > all

tunnels > delete > all > IKE

l Delete all IPsec SAs for a specified VPN peer:

tunnels > delete > IPsec > peer <Internal Peer
IP>

Note - This sub-option is the same as:
o In the main "vpn tu" on page 219 menu, the option (5)

Delete all IPsec SAs for a given peer (GW).
o The "vpn tu [-w] del ipsec <IP Address>"

command (see "vpn tu del" on page 221).
l Delete all IPsec SAs for a specified user:

tunnels > delete > IPsec > user <Username>

Note - This sub-option is the same as:
o In the main "vpn tu" on page 219 menu, the option (6)

Delete all IPsec SAs for a given User (Client).
o The "vpn tu [-w] del ipsec <IP Address>

<Username>" command (see "vpn tu del" on
page 221).

l Delete all IPsec SAs for all VPN peers and users:

tunnels > delete > IPsec > all

tunnels > delete > all > IPsec

Note - This sub-option is the same as:
o In the main "vpn tu" on page 219 menu, the option (9)

Delete all IPsec SAs for ALL peers and users.
o The "vpn tu [-w] del ipsec all" command

(see "vpn tu del" on page 221).
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Option Description

license Shows the SecureClient Mobile (SCM) licenses.
The available sub-options are:

n Show the current status of SCM licenses:

license > scm > status

n Show the list of SCM licensed devices:

license > scm > list
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vpn show_tcpt

Description

Shows users connected in Visitor Mode.

Syntax

vpn show_tcpt
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vpn sw_topology
Note - R80.40 does not support UTM-1 Edge and Safe@Office devices. The
information about this command is provided only to describe the existing
syntax option until it is removed completely.

Description

Downloads the topology for a UTM-1 Edge or Safe@Office device.

Syntax

vpn [-d] sw_toplogy -dir <directory> -name <name> -profile <profile>
[-filename <filename>]

Parameters

Parameter Description

-d Runs the command in debug mode.
Use only if you troubleshoot the command itself.

Best Practice - If you use this parameter, then redirect the
output to a file, or use the script command to save the
entire CLI session.

-dir <directory> Output directory for file.

-name <name> Nickname of site, which appears in remote client.

-profile
<profile>

Name of the UTM-1 Edge or Safe@Office profile, for which the
topology is created.

-filename
<filename>

Name of the output file.

https://linux.die.net/man/1/script
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vpn tu

Description

Launches the TunnelUtil tool, which is used to control VPN tunnels.

General Syntax

vpn tu

vpn tunnelutil

Menu Options

[Expert@MyGW:0]# vpn tu

********** Select Option **********

(1) List all IKE SAs
(2) * List all IPsec SAs
(3) List all IKE SAs for a given peer (GW)
(4) * List all IPsec SAs for a given peer (GW)
(5) Delete all IPsec SAs for a given peer (GW)
(6) Delete all IPsec SAs for a given User (Client)
(7) Delete all IPsec+IKE SAs for a given peer (GW)
(8) Delete all IPsec+IKE SAs for a given User (Client)
(9) Delete all IPsec SAs for ALL peers
(0) Delete all IPsec+IKE SAs for ALL peers

* To list data for a specific CoreXL instance, append "-i <instance
number>" to your selection.

(Q) Quit

*******************************************

Note - When you view Security Associations for a specific VPN peer, you must
specify the IP address in dotted decimal notation.

Advanced Syntax

vpn tu
      help
      del <options>
      list <options>
      mstats
      tlist <options>
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Parameters

Parameter Description

help Shows the available advanced commands.

del <options> Deletes IPsec and IKE SAs.
See "vpn tu del" on page 221.

list <options> Shows IPsec and IKE SAs.
See "vpn tu list" on page 224.

mstats Shows distribution of VPN tunnels (SPIs) between CoreXL Firewall
instances.
See "vpn tu mstats" on page 226.

tlist
<options>

Shows information about VPN tunnels.
See "vpn tu tlist" on page 227.
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vpn tu del

Description

Deletes IPsec Security Associations (SAs) and IKE Security Associations (SAs).

Syntax for IPv4

vpn tu [-w] del
      all
      ipsec
            all
            <IPv4 Address>
            <IPv4 Address> <Username>
      <IPv4 Address>
      <IPv4 Address> <Username>

Syntax for IPv6

vpn tu [-w] del
      all
      ipsec
            all
            <IPv6 Address>
      <IPv6 Address>
      <IPv6 Address> <Username>

Parameters

Parameter Description

-w Shows various warnings on the screen.

all Deletes all IPsec SAs and IKE SAs for all VPN peers and users.

Note - This command is the same as:

n In the main "vpn tu" on page 219 menu, the option
(0) Delete all IPsec+IKE SAs for ALL peers and
users.

n In the "vpn shell" on page 210 menu, the option
tunnels > delete > all > IKE and the option tunnels
> delete > all > IPsec..
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Parameter Description

ipsec <options> Deletes the specified IPsec SAs.
The available <options> are:

n Delete all IPsec SAs for all peers and users:

vpn tu [-w] del ipsec all

Note - This command is the same as:
l In the main "vpn tu" on page 219 menu, the

option (9) Delete all IPsec SAs for ALL peers
and users.

l In the "vpn shell" on page 210 menu, the option
tunnels > delete > all > IPsec.

n Delete all IPsec SAs for the specified VPN peer:

vpn tu [-w] del ipsec <IP Address>

Note - This command is the same as:
l In the main "vpn tu" on page 219 menu, the

option (5) Delete all IPsec SAs for a given
peer (GW).

l In the "vpn shell" on page 210 menu, the option
tunnels > delete > IPsec > peer <Internal
Peer IP>.

n Delete all IPsec SAs for the specified VPN peer and the
specified user:

vpn tu [-w] del ipsec <IPv4 Address>
<Username>

Notes:
l This command is the same as:

o In the main "vpn tu" on page 219 menu,
the option (6) Delete all IPsec SAs for a
given User (Client).

o In the "vpn shell" on page 210 menu, the
option tunnels > delete > IPsec > user
<Username>.

l This command does not support IPv6
addresses.
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Parameter Description

<IP Address> Deletes all IPsec SAs and IKE SAs for the specified VPN peer.

Note - This command is the same as the option (7)
Delete all IPsec+IKE SAs for a given peer (GW) in the
main "vpn tu" on page 219 menu.

<IP Address>
<Username>

Deletes all IPsec SAs and IKE SAs for the specified VPN peer and the
specified user.

Note - This command is the same as the option (8)
Delete all IPsec+IKE SAs for a given User (Client) in the
main "vpn tu" on page 219 menu.
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vpn tu list

Description

Shows IPsec SAs and IKE SAs.

Syntax for IPv4 and IPv6

vpn tu [-w] list
      ike
      ipsec
      peer_ike <IP Address>
      peer_ipsec <IP Address>
      tunnels

Parameters

Parameter Description

-w Shows various warnings on the screen.

ike Shows all IKE SAs.

Note - This command is the same as:

n In the main "vpn tu" on page 219 menu,
the option (1) List all IKE SAs.

n In the "vpn shell" on page 210 menu, the
option show > tunnels > IKE > all or
the option tunnels > show > IKE > all.

ipsec Shows all IPsec SAs.

Note - This command is the same as:

n In the main "vpn tu" on page 219 menu,
the option (2) List all IPsec SAs.

n In the "vpn shell" on page 210 menu, the
option show > tunnels > IPsec > all or
the option tunnels > show > IPsec >
all.



vpn tu list

Site to Site VPN R80.40 Administration Guide      |      225

Parameter Description

peer_ike <IP Address> Shows all IKE SAs for the specified VPN peer.

Note - This command is the same as:

n In the main "vpn tu" on page 219 menu,
the option (3) List all IKE SAs for a
given peer (GW).

n In the "vpn shell" on page 210 menu, the
option show > tunnels > IKE > peer
<Internal Peer IP> or the option
tunnels > show > IKE > peer
<Internal Peer IP>.

peer_ipsec <IP Address> Shows all IPsec SAs for the specified VPN peer.

Note - This command is the same as:

n In the main "vpn tu" on page 219 menu,
the option (4) List all IPsec SAs for a
given peer (GW).

n In the "vpn shell" on page 210 menu, the
option show > tunnels > IPsec > peer
<Internal Peer IP> or the option
tunnels > show > IPsec > peer
<Internal Peer IP>.

tunnels Shows information about VPN tunnels.
In addition, see the "vpn tu tlist" on page 227 command.
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vpn tu mstats

Description

Shows the distribution of VPN traffic between CoreXL Firewall instances.

For more information, see sk118097 - MultiCore Support for IPsec VPN in R80.10 and above.

Syntax for IPv4

vpn tu [-w] mstats

Syntax for IPv6

vpn6 tu [-w] mstats

Parameters

Item Description

-w Shows various warnings on the screen.

Example for IPv4

[Expert@MyGW:0]# vpn tu mstats

Instance# # of inSPIs # of outSPIs
0 182 170
1 184 176
2 191 174
3 215 197
4 237 227
5 191 176
6 180 170
7 190 166
8 171 160
9 199 187

-----------------------------------------
Summary: 1940 1803

[Expert@MyGW:0]#

Example for IPv6

[Expert@MyGW:0]# vpn6 tu mstats

Instance# # of inSPIs # of outSPIs
0 238 228
1 224 214

-----------------------------------------
Summary: 462 442

[Expert@MyGW:0]#

http://supportcontent.checkpoint.com/solutions?id=sk118097
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vpn tu tlist

Description

Shows information about VPN tunnels.

Syntax for IPv4

vpn tu [-w] tlist
{-h | -help}
[clear]
[start]
[state]
[stop]
[<Sort Options>]

Syntax for IPv6

vpn6 tu [-w] tlist
{-h | -help}
[clear]
[start]
[state]
[stop]
[<Sort Options>]

Parameters

Parameter Description

-w Shows various warnings on the screen.

-h | -
help

Shows the built-in usage.

clear Clears the Tunnel List volume statistics.

start Turns on the Tunnel List volume statistics.

state Shows the current Tunnel List volume statistics state.

stop Turns off the Tunnel List volume statistics.
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Parameter Description

<Sort
Options>

The available sort options are:

n -b - Sorts by total (encrypted + decrypted) bytes.
n -d - Sorts by inbound (decrypted) bytes.
n -e - Sorts by outbound (encrypted) bytes.
n -i - Combines list rows for each CoreXL Firewall instance with

accumulated traffic. Default order is descending by total bytes.
n -m - Sorts by MSPI.
n -n - Sorts by VPN peer name.
n -p <IP Address> - Shows tunnels only for a VPN peer with the specified

IP address.
n -r - Sorts in reverse order.
n -s - Sorts by SPI.
n -t - Combines list rows for each VPN peer with accumulated traffic.

Default order is descending by total bytes.
n -v - Verbose mode, prints a header message for each option.

If you specify more than one sort option, you can:

n Separate the options with spaces:

... -<option1> -<option2> -<option3>

For example: -v -t -b -r

n Write the options together:

... -<option1><option2><option3>

For example: -vtbr

Example for IPv4

[Expert@MyGW:0]# vpn tu tlist
+-----------------------------------------+-----------------------+---------------------+
| Peer: 172.29.7.134 (b61cef72a222a909) | MSA: ffffc20020e34530 | i: 2 ref: 11 |
| Methods: ESP Tunnel AES-128 SHA1 | | i: 5 ref: 2 |
| My TS: 0.0.0.0/0 | | |
| Peer TS: 172.29.7.134 | | |
| User: user3 | | |
| MSPI: b7 (i: 5) | Out SPI: c95d172c | |
+-----------------------------------------+-----------------------+---------------------+
[Expert@MyGW:0]#
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vpn ver

Description

Shows the major version number and build number of the VPN kernel module.

Syntax

vpn ver [-k] [-f <filename>]

Parameters

Parameter Description

-k Shows the version name and build number and the kernel build number.

-f Saves the information to the specified text file.

Example

[Expert@MyGW:0]# vpn ver -k
This is Check Point VPN-1(TM) R80.40 - Build 123
kernel: R80.40 - Build 456
[Expert@MyGW:0]#
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mcc

Description

The VPN Multi-Certificate CA (MCC) commands let you manage certificates and Certificate
Authorities on a Security Management Server or Domain Management Server:

n Shows Certificate Authorities

n Shows certificates

n Adds certificates

n Deletes certificates

Important:

n Before you run this command, you must close all SmartConsole clients,
GuiDBedit Tool clients (see sk13009), and "dbedit" clients (see skI3301)
to prevent a lock of the management database. The only exceptions are
the "mcc lca" and "mcc show" commands.

n The mcc commands require the cpca process to be up and running. Run
this command:

ps auxw | egrep "cpca|COMMAND"

n On a Multi-Domain Server, you must run this command in the context of
the applicable Domain Management Server:

mdsenv <IP Address or Name of Domain Management
Server>

Syntax

mcc
      -h
      add <options>
      add2main <options>
      del <options>
      lca
      main2add <options>
      show <options>

Parameters

Parameter Description

-h Shows the built-in usage.

http://supportcontent.checkpoint.com/solutions?id=sk13009
http://supportcontent.checkpoint.com/solutions?id=skI3301
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Parameter Description

add <options> Adds certificates.
See "mcc add" on page 232.

add2main <options> Promotes an additional certificate to be the main certificate.
See "mcc add2main" on page 233.

del <options> Deletes certificates.
See "mcc del" on page 234.

lca Shows Certificate Authorities.
See "mcc lca" on page 235.

main2add <options> Adds main certificate to additional certificates.
See "mcc main2add" on page 236.

show <options> Shows certificates.
See "mcc show" on page 237.
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mcc add

Description

Adds a certificate stored in DER format in a specified file, as an additional certificate to the
specified CA. The new certificate receives an index number higher by one than the highest
existing certificate index number.

The new certificate receives an index number higher by one than the highest existing certificate
index number.

Syntax

mcc add <CA Name> <Certificate File>

Note
On a Multi-Domain Server, you must run this command in the context of the
applicable Domain Management Server:

mdsenv <IP Address or Name of Domain Management Server>

Important - Before you run this command, you must close all SmartConsole
clients, GuiDBedit Tool clients (see sk13009), and "dbedit" clients (see skI3301)
to prevent a lock of the management database.

Parameters

Parameter Description

<CA Name> Specifies the name of the CA, as defined in the Management Server
database.

<Certificate
File>

Specifies the path and the name of the certificate file.
To show the main certificate of a CA, omit this parameter.

Example - Add the certificate stored in the /var/log/Mycert.cer file to the CA called "MyCA"

mcc add MyCA /var/log/Mycert.cer

http://supportcontent.checkpoint.com/solutions?id=sk13009
http://supportcontent.checkpoint.com/solutions?id=skI3301
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mcc add2main

Description

Copies the additional certificate of the specified index number of the specified CA to the main
position and overwrites the previous main certificate.

Syntax

mcc add2main <CA Name> <Certificate Index Number>

Note
On a Multi-Domain Server, you must run this command in the context of the
applicable Domain Management Server:

mdsenv <IP Address or Name of Domain Management Server>

Important - Before you run this command, you must close all SmartConsole
clients, GuiDBedit Tool clients (see sk13009), and "dbedit" clients (see skI3301)
to prevent a lock of the management database.

Parameters

Parameter Description

<CA Name> Specifies the name of the CA, as defined in the Management
Server database.

<Certificate Index
Number>

Specifies the certificate index number.

Example - Copy certificate #1 of a CA called "MyCA" to the main position

mcc add2main MyCA 1

http://supportcontent.checkpoint.com/solutions?id=sk13009
http://supportcontent.checkpoint.com/solutions?id=skI3301
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mcc del

Description

Removes the additional certificate of the specified index number from the specified CA.

Greater index numbers (of other additional certificates) are reduced by one.

Syntax

mcc del <CA Name> <Certificate Index Number>

Note
On a Multi-Domain Server, you must run this command in the context of the
applicable Domain Management Server:

mdsenv <IP Address or Name of Domain Management Server>

Important - Before you run this command, you must close all SmartConsole
clients, GuiDBedit Tool clients (see sk13009), and "dbedit" clients (see skI3301)
to prevent a lock of the management database.

Parameters

Parameter Description

<CA Name> Specifies the name of the CA, as defined in the Management
Server database.

<Certificate Index
Number>

Specifies the certificate index number.

Example - Remove certificate #1 of a CA called "MyCA"

mcc del MyCA 1

http://supportcontent.checkpoint.com/solutions?id=sk13009
http://supportcontent.checkpoint.com/solutions?id=skI3301
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mcc lca

Description

Shows all Certificate Authorities (CAs) defined in the Management Server database, with the
number of additional CA certificates for each CA.

Syntax

mcc lca

Note
On a Multi-Domain Server, you must run this command in the context of the
applicable Domain Management Server:

mdsenv <IP Address or Name of Domain Management Server>

Example

[Expert@MGMT:0]# mcc lca
MCC: Here is a list of the CAs, with the number of additional CA certificates

1. internal_ca (0)
[Expert@MGMT:0]#
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mcc main2add

Description

Copies the main certificate of the specified CA to an additional position.

The copied certificate receives an index number higher by one than the highest existing
certificate index number.

Syntax

mcc main2add <CA Name>

Note
On a Multi-Domain Server, you must run this command in the context of the
applicable Domain Management Server:

mdsenv <IP Address or Name of Domain Management Server>

Important - Before you run this command, you must close all SmartConsole
clients, GuiDBedit Tool clients (see sk13009), and "dbedit" clients (see skI3301)
to prevent a lock of the management database.

Parameters

Parameter Description

<CA Name> Specifies the name of the CA, as defined in the Management Server database.

Example

The CA called "MyCA" has a main certificate and one additional certificate.

If you run this command, then the CA will have two additional certificates, and additional
certificate #2 will be identical to the main certificate:

mcc main2add MyCA

http://supportcontent.checkpoint.com/solutions?id=sk13009
http://supportcontent.checkpoint.com/solutions?id=skI3301
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mcc show

Description

Shows details for a specified certificate of a specified CA.

Syntax

mcc show <CA Name> [<Certificate Index Number>]

Note
On a Multi-Domain Server, you must run this command in the context of the
applicable Domain Management Server:

mdsenv <IP Address or Name of Domain Management Server>

Parameters

Parameter Description

<CA Name> Specifies the name of the CA, as defined in the Management
Server database.

<Certificate Index
Number>

Optional.
Specifies the certificate index number.
To show the main certificate of a CA, omit this parameter.

Example 1 - Show certificate #1 of a CA called MyCA

mcc show MyCA 1
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Example 2 - Show certificate of a CA called "internal_ca"

[Expert@MGMT:0]# mcc lca
MCC: Here is a list of the CAs, with the number of additional CA certificates

1. internal_ca (0)
[Expert@MGMT:0]#

[Expert@MGMT:0]# mcc show internal_ca
PubKey:
Modulus:
ae b3 75 36 64 e4 1a 40 fe c2 ad 2f 9b 83 0b 45 f1 00 04 bc
3f 77 77 76 d1 de 8a cf 9f 32 78 8b d4 b1 b4 be db 75 cc c8
... ... ...
a3 9d 8b 0a de 05 fb 5c 44 2e 29 e3 3e f4 dd 50 01 0f 86 9d
55 16 a3 4d f8 90 2d 13 c6 c1 28 57 f8 3e 7c 59
Exponent: 65537 (0x10001)

X509 Certificate Version 3
refCount: 1
Serial Number: 1
Issuer: O=MyServer.checkpoint.com.s6t98x
Subject: O=MyServer.checkpoint.com.s6t98x
Not valid before: Sun Apr 8 13:41:00 2018 Local Time
Not valid after: Fri Jan 1 05:14:07 2038 Local Time
Signature Algorithm: RSA with SHA-256 Public key: RSA (2048 bits)
Extensions:

Key Usage:
digitalSignature
keyCertSign
cRLSign

Basic Constraint (Critical):
is CA

[Expert@MGMT:0]#
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Working with Kernel Parameters
on Security Gateway
See the R80.40 Next Generation Security Gateway Guide.

https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_NextGenSecurityGateway_Guide/Default.htm
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Kernel Debug on Security Gateway
See the R80.40 Next Generation Security Gateway Guide.

https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_NextGenSecurityGateway_Guide/Default.htm
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